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Chapter 1 | Introduction 

Channel Management Application Stack 

Entomo's SmartHub all-in-one platform that transforms the way your 
company manages its distribution channels. Entomo's fully integrated 
solution stack, shown below, enables unmatched channel visibility, 
compliance, and partner collaboration. Benefits include revenue growth, 
reduced incentive over-payments, reduced inventory and compliance 
costs, and faster financial close cycles. 

 

Entomo's channel management software and solutions are broadly 
organized according to the following business functions: 

 Channel Data Management – Data aggregation, normalization, and 
enrichment of your transactional sales data from disparate external 
sources 

 Channel Revenue Management – Transaction valuation, channel 
incentives (MDFs, rebates, etc.), inventory reconciliation, and 
revenue-recognition activities 

 Sales Performance Management – Sales credit assignments, 
commission split calculations, and commissionable dollar calculations 
for internal and external sales channels 
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 Partner Relationship Management – Partner portal, channel 
scorecards, and deal/design registration 

 Channel Business Intelligence – Real-time reporting, dashboards, 
and analytics with an interactive business-intelligence platform for 
strategic planning and channel performance management 

Channel Processing Pipeline 

Entomo SmartHub collects channel data consisting of POS, inventory, 
claims, RMAs, forecasts, etc. from channel partners. The data can be 
formatted as Excel spreadsheets, comma-delimited (.csv) files, EDI files, 
XML files, or other data formats. SmartHub also loads master data from a 
customer's ERP/CRM systems, including their customer master, product 
master, invoices, forecasts, commission plans, incentive programs, 
shipment notices, etc. That channel data is then cleansed, normalized, 
transformed, enriched, and validated against the master data for further 
analysis by the various application modules in SmartHub.  

The following diagram shows how data flows between various 
participants in a channel management solution.  

 

The next diagram shows the main data types in SmartHub and its various 
processing elements—channel data collection, master data loads, 
processing engines for transaction valuation, inventory reconciliation, 
incentives management, sales commission calculations, revenue 
recognition, partner score card, and analytics.  
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The key processing elements and steps: 

1. Channel data is collected from channel partners. 

2. Master data is loaded from customer’s ERP/CRM system. 

3. Master transaction data is also loaded from the customer’s ERP 
system. 

4. Channel data is cleansed, normalized, validated, and enriched using 
the master data. 

5. Channel data is valued using the valuation engine. 

6. The Sales-In Sales-Out module reconciles channel data and the 
master data for channel inventory reconciliation and calculations. 

7. Channel incentives module performs analysis of the incentive 
programs by analyzing channel data against incentive program 
definitions 

8. The Sales Commission module performs sales credit assignments 
and commission calculations. 

9. The Revenue Recognition module performs journal entry generation 
based on the results from upstream modules. 

10. Analytics allows data discovery and visualization of the analysis 
results from upstream modules using the Business Intelligence 
engine. 
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11. The Partner Scorecard module generates key performance metrics on 
channel partners based on the channel data and analysis results from 
various SmartHub modules. 

Chapter 2 | Getting Started 

At its core, SmartHub is a powerful report generator that gives you a 
home page (or "home base") for all your reporting activities. Depending 
on the permissions set by your company, the home page can give you 
access to your reports, charts, and workflow tasks. The following topics 
will help get you started. 

Solution Overview 

Indirect sales channels are a powerful and proven way to extend market 
reach, serve diverse segments, and strengthen customer relationships 
through value-added partners. Companies that distribute their products 
through VARs, resellers, retailers, distributors, or licensees are able to 
multiply their selling capabilities far beyond what they could accomplish 
with in-house resources alone. 

Channel-based distribution also entails a higher level of complexity. 
Having multiple players in the value chain and multi-tier distribution 
raises the risks of stockouts, revenue leaks, sales commission inaccuracies, 
compliance problems, and slow responsiveness to sales trends or 
customer issues. 

Piecemeal and stand-alone technology approaches, such as offline 
spreadsheets, homegrown applications, and data silos, are not capable of 
keeping up with the dynamic nature and complexity of today's channel. 
These limited-scope solutions often add to management problems by 
creating separate islands of data that have to be synchronized and 
manipulated by hand. This patchwork approach hampers timeliness and 
accuracy and adds cost. 

To get optimal and sustainable results, companies need comprehensive 
channel management software and tools that can span all of these 
challenges. Entomo SmartHub provides these capabilities and attributes: 

 Channel Data Management – Collection, normalization and channel 
data enrichment 

 Collaboration – Workflows within enterprise and with external 
channel partners 

 Gross margin and full channel revenue management 

o Automatic transaction valuation, claims validation, calculations of 
exposures and accruals 

o Adjustments, journal entries and audit trails 

 Business discovery/channel business intelligence 
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 Integration with legacy ERP/CRM and other enterprise systems 

 SSAE-16 compliance 

Access to SmartHub 

To access SmartHub, your company will be provided with a dedicated, 
secure URL created specifically for your company. When you go to that 
website, you will see the SmartHub Registered User Login screen. To log 
in, enter the Company ID, User ID, and Password provided by Entomo 
via a securely encrypted email.  

 

The first time you log in, you'll see a notice about blocked pop-ups. For 
SmartHub to work properly, you need to allow pop-ups. For more 
information, see Configuring Your Browser. 

As you work in SmartHub, be sure to properly log out of SmartHub at the 
end of each session; otherwise, you will be automatically logged out of 
SmartHub after one hour of inactivity. 

Supported Browsers 

For all browsers, you must enable JavaScript, cookies, and TLS 1.0.  

The following browsers are supported for Entomo SmartHub 11.0: 

 Microsoft Internet Explorer (IE) versions 9.x, 10.x, and 11.x – If you 
use IE, we recommend you use the latest version that SmartHub 
supports. Apply all Microsoft software updates, and observe the 
following restrictions: 

o SmartHub is not supported on touch screen devices.  

o IE's HTML solution editor is not supported.  

o The Compatibility View in IE is not supported.  

o The Metro version of IE 10 is not supported.  

See Configuring Internet Explorer. 

 Mozilla Firefox - Use the most recent stable version. We make every 
effort to test and support the most recent version of Firefox. See 
Configuring Firefox.  

 Google Chrome - Use the most recent stable version. We make every 
effort to test and support the most recent version of Chrome. Ensure 
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that the system setting Show scroll bars is set to Always. See 
Configuring Chrome.  

 Apple Safari on Mac OSX is not supported.  

 Android, Blackberry, and iOS are not supported.  

Configuring Your Browser 

When you log in to our secure entomo.com site for the first time, you 
might see a message about the site being protected from entry until you 
allow that web page. The message: 

We have detected that your browser is blocking pop-up windows 
from our site. SmartHub makes use of pop-up windows and will not 
work correctly unless your browser is reconfigured. 

You will need to reconfigure your browser to allow pop-ups from 
https://<company_name>.entomo.com. When you are finished with 
your reconfiguration, you can return to the log-in page. 

Configuring Firefox 

To ensure that SmartHub works optimally with Firefox, configure your 
browser as follows. 

Allowing Cookies 

SmartHub requires the acceptance of cookies: 

1. In your Firefox browser, click Tools > Options. 

2. In the left pane, click Privacy. 

3. Under History, for the Firefox will option, select Use custom settings 
for history. 

4. Select the option to Accept cookies from sites. 

5. For the Keep until option, select they expire. 

6. Select the option to Clear history when Firefox closes, then click 
Settings.  

7. In the Settings for Clearing History, ensure that the Cache option is 
selected, then click OK.  

8. Click OK to close the Options page, if available; otherwise, simply 
close the browser tab.  

Clearing the Cache Manually 

The settings in the procedure, above, should set Firefox to clear the cache 
automatically when Firefox closes, however, you can also clear the cache 
manually. Use one of the following methods: 

1. In the Firefox browser, click Tools > Options. 

2. In the left panel, click Advanced. 
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3. With the Network tab selected, click Clear Now in the Cached Web 

Content section. 

 

4. Click OK, if available; otherwise, simply close the browser tab. 

5. Restart your Firefox browser.  

OR 

1. In the Firefox browser, click . 

2. Click History > Clear Recent History. 

3. In the Time range to clear drop-down, select Everything. 

4. In the option section, select only Cookies, Cache, and Active Logins.  

5. Click Clear Now.  

6. Restart Firefox.  

Configuring Internet Explorer 

To maximize the performance of Internet Explorer, configure your 
browser as follows. 

Allowing Cookies 

SmartHub requires the acceptance of cookies: 

1. In Explorer, click Tools > Internet Options. 

2. In the General tab, do the following: 

3. Click Settings under Browsing History. 

4. For the Check for newer versions of stored pages option, select 
Automatically. 

5. For the Disk space to use option, enter at least 50 MB. 

6. Click the Security tab, and do the following: 

a. Click Custom Level and scroll to the Scripting options. 
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b. Make sure the Active Scripting option is enabled. JavaScript 
depends on this setting being enabled. 

7. Click the Privacy tab, and do the following: 

a. Click Advanced.  

b. Select the Override automatic cookie handling option.  

c. Select the Always allow session cookies option. 

8. Click the Advanced tab, and do the following: 

a. Scroll to the Security section.   

b. Clear the Do not save encrypted pages to disk option. 

c. Clear Use SSL 2.0. 

d. Clear Use SSL 3.0. 

e. Select Use TLS 1.0. 

f. Select Use TLS 1.1. 

g. Select Use TLS 1.2.  

9. Restart Internet Explorer. 

Tip: The option called Empty Temporary Internet Files folder when 

browser is closed causes the cache to clear when Internet Explorer is shut 
down. This increases privacy, but it might decrease performance. 

Clear the Cache Manually 

1. In Explorer, click Tools > Delete Browsing History. 

2. Select the following options: 

o Temporary Internet files and website files 

o Cookies and website data 

3. Click Delete. 

4. Click OK. 

5. Restart Internet Explorer. 

Configuring Chrome 

From time to time, you'll need to clear the browsing data in Chrome. 

1. Open Chrome, then click  on the browser toolbar. 

2. Click Tools. 

3. Select the option to Clear browsing data. 

4. In the dialog that opens, select the check boxes for the types of 
information that you want to remove. 

5. Use the menu at the top to select the amount of data that you want to 
delete. Select Beginning of time to delete everything. 

6. Click Clear browsing data. 

7. Restart your Chrome browser.  
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Chapter 3 | Navigation Basics 

Entomo SmartHub is made up of pages that allow you to navigate 
through and interact with your business data. Typically, your Entomo 
Professional Services (PS) team works with your system administrator to 
set up SmartHub pages for your organization, but your interaction with 
SmartHub will be easier if you understand the types of pages that you'll 
be using 

Home Page Navigation 

The home page is the page that opens first when you log in to SmartHub. 
The home page is divided into two sections. The left section is the favorite 
reports pane that lists the reports that are available to you. The right 
section is the dashboard. The home page has the following components.  

 

1. Main Bar – In the main navigation bar, click the  icon to 
open/close the left favorites pane, which lists your saved reports.  

o Click the  icon to return to your dashboard from any page in 
SmartHub.  

o As you navigate through SmartHub, a breadcrumb trail (shown 
below) will appear to the right of the home icon to help you keep 
track of your location within SmartHub.  
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o Click the top  icon to reset your page to the previously saved 
report and settings.  

2. Favorites – The left pane is your list of favorite reports. Favorite 
reports are built from default SmartHub pages or other reports that 
you customize to suit your interaction with SmartHub. Hover over a 
report to see the owner and last modified date.  

o Search – To quickly find a saved report, enter the title into the 
Search field. These searches find report names only, not report 
content.  

o Star icon – In your list of reports you can select the star to the left 
of a report name to flag it as a frequently used report. To see only 

your personal list of frequently used reports, click the star icon  
next to the Search field. To clear a frequently used report, deselect 
the yellow star to the left of the report name in the full list of 
reports. 

o Delete icon – Click the delete icon  next to the Search field to 
clear a search. 

o Refresh – Click the refresh icon  to refresh the list of reports in 
the favorites pane. 

o View Details – Click the details icon  to see the complete list of 
reports available in the system. Clicking on the name of a report 
opens the report. Users will only be able to open the reports they 
have permission to open. 

3. Menus – The bottom of the favorites pane displays the following 
menus: 

o Site Map allows you to access the default pages of various 
SmartHub modules. The Entomo Professional Services team will 
configure these default pages to create favorite reports with user-
specific configuration to match your business requirements. 

o Proxy allows users with proxy privileges to log in as someone 
else. All actions as a proxy are recorded as being executed by the 
proxy. For example, if a program approver goes on vacation, an 
administrator can give proxy privileges to someone else who can 
approve the program in the absence of the original approver. A 
user with administrator privileges can manage access rights in a 
way that authorizes a user or an entire group of users to be 
proxies. 

4. To Do List – The To Do List is below the dashboard. It shows you all 
of the items in the workflow that require your approval or other 
action, and is visible to you only if you're a participant in a SmartHub 
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workflow, such as an approval process for channel incentives, 
commission splits, or opportunities. 

5. Dashboard – The dashboard is to the right of the favorites pane, and 
displays a set of charts and graphs, should your company choose this 
option. Each chart and graph is based on an analytic page. Click the 
chart or graph to open the report used to generate it. 

List (Non-Analytic) Page Navigation 

List pages allow you to create and modify non-analytic reports (without 
aggregation or subtotaling) by entering values/limits (a database query) 
into the Filters section, then clicking Retrieve. The results can then be 
viewed below the Filters section in a results table where you can search 
and sort the retrieved records. List pages have the following components. 

 

1. Filters – The Filters section allows you to create queries to retrieve 
specific records from the SmartHub database.  

o Click the eraser icon  to clear all values in the Filters section 
with a single click. 

o Click the  icon (if available) to add, remove, and move the 

fields in Filters. (Note that the  icon above the Filters section 
resets the page to the previously saved report.) Column 
configuration changes will persist after the report is saved. 

o Pressing Enter in most filter fields is the same as clicking Retrieve. 
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o Press Tab to move to the next filter in the column.  

2. Action Bar – The action bar allows you to manipulate retrieved data. 
The buttons in the action bar will change depending on where you are 
in the system. A button appears to the far right whenever the page 
width is resized to the point that it is too narrow to show the buttons. 

3. Info Bar – The information bar displays summary info about your 
retrieved data. A temporarily yellow box at the top of the page might 
also display the status or number of the records retrieved. In the 
following image, both the yellow notice and the Number of records 

indicator lets the user know the number of records they’re allowed to 
see (usually 500) versus the total in the database. 

 

The user is limited to seeing 20,000 records versus the 22,806 total 
records in the database. Your company sets the number of records 
you can see. If your queries need to return more than that limit, 
consider asking your system administrator to revise the limit upward. 

4. Results Table – Below the information bar is the table that displays 
your retrieved records. The column labels are specific to the report 
you are generating. Use the following actions and icons to work with 
the records.  

o Details – Click any linked item in the table to see additional 
information about the item. Some drill down pages are editable, 
depending on your permissions, while others are view-only. 

o Sort – Click a column label to make the sort arrow appear so you 
can sort the contents of the entire table in ascending/descending 
order. To add multiple columns to the sort, perform the sort first, 
then press Ctrl while clicking additional columns. The added 
columns will be numbered in the order you click them. To remove 
the multi-column sort, release the Ctrl key and click any column.  

o Long/Short Labels – Click  to toggle between the short and 
long column labels. 

o Highlighting – Click any row to highlight it. To highlight 
multiple rows, press and hold the Ctrl key while clicking at the 
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beginning of the rows you want to highlight. Highlighting persists 
until you click elsewhere in the table. 

o Row Selection – Select a checkbox on the left to select a row 
before clicking an action button. Your selection will persist until 
you deselect the checkbox or click Retrieve. 

o Search – Click the  icon to reveal a search bar where you can 
search the results of your most recent data retrieval. In the left 
field, select a column to search, then enter the value you’re 
looking for in the right field. Depending on whether you're search 
is textual or numeric, enter letters for textual searches, and enter 
numerals and decimal points for numeric searches. Searches are 
often more successful if you use wildcards (*) before and/or after 
a search term. Table searches are limited to the data loaded in the 
table, without retrieving data again from the database. Click the 

 icon to clear the search. Click the  icon again to hide the 
search bar. Both clicks return you to the full list of retrieved 
records.  

o Hidden Buttons – The  button appears when the screen 
narrows enough to hide any of the buttons in the action bar. Click 
the button to see links to the hidden buttons.  

o Configure Columns – Click the  icon (if available) to open the 
Select and Order Visible Columns dialog box, where you can 
change column labels, specify which columns you see/hide, and 
reorder columns. The dialog box also allows access to the 
Configure Page dialog box. For more information, see Change the 
Visibility and Order of Columns. 

o View All Fields – Tables are usually configured to display a 

limited number of fields. To see all available fields, click the  
icon to the far right of the table. The extended line format (ELF) 
view lets you step through records one-by-one by clicking the 
Previous and Next buttons in the ELF dialog. 

Analytic Page Navigation 

Analytic pages allow you to aggregate (or group) records using one or 
more dimensions (for example, by partner, item, or customer, or any 
combination) and see subtotals for those dimensions. For example, in the 
POS Analytics page, you might aggregate sales revenue by partner and 
item so you can view sales revenue for different items for a given partner. 
The Filters section, action bar, and info bar in analytic pages function the 
same as in non-analytic (list) pages. The following components are on 
analytic pages. 
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1. Results Table – Below the info bar in an analytic page is a results 
table that displays data that is aggregated, subtotaled, and reported 
according to the reporting period selected in Filters. For more 
information, see Filters.  

2. Aggregating and Subtotaling – You can see analyzed data separated 
into subtotals per product family and type, and per distributor. The 
grand total for the analysis is at the end of the table. The table 
supports aggregate dimensions, display dimensions, and measures 
(numeric data). Use aggregate dimensions to subtotal the measures. 
Use display dimensions to display values without subtotaling.  

The rows for a group (defined by the first dimension column) are 
always kept together. If a dimension column is used as a sort column, 
the groups are first sorted by the values in the dimension column. If 
only measure columns are selected, the groups are ordered based on 
the totals for the measure columns. 

For more information, see Configuring an Analytic Page. 

3. Displaying Data by Period – Analytic pages also allow you to view 
numeric data for every period selected in Filters. For example, in the 
POS Analytics page, if the periods selected are January and February, 
you will be able to view the sales revenue for January and February 
for the primary dimensions selected, such as partner, item, and 
customer. You can use the Show Period Details option in Filters to 
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toggle between viewing the results by each period or totals across all 
the selected periods. 

4. Icons – The following icons are on analytic pages: 

o Charts – Click the Configure Chart icon  to set up a chart 
based on the retrieved data. To display the chart, go to the 
Display field in Filters, select Chart or Table and Chart, then click 
the Draw button in the action bar. The chart will be displayed 
below the results table.  

o Configure – Click the  icon to open the Select and Order 

Aggregate Columns dialog, where you can configure the columns 
of the analytic page. Column configuration changes will persist 
after the report is saved. 

5. Limiting Results – Use the Limit Results filter on an analytic page to 
configure the number of records in the table. Enter a comma-
separated list of integers (for example, "10,10,5") as limits for each 
aggregation level. Use a positive integer to show only the first n 
records. Use a negative integer to show everything except the first n 
records. Press Enter to apply the limits. Leave the filter blank if no 
limits are needed.  

Note that limits are based on the current sort order. For example, 
suppose that a POS Analytics report aggregates results by distributor 
and bill-to state. If you sort the Disti Name column in ascending 
order, then enter “10” in the Limit Results field, only the first 10 
distributors groups will be displayed, ordered alphabetically. To get 
the top 10 distributors by revenue, sort the Revenue column in 
descending order, then ether “10” in the Limit Results filter. 

For more information and instructions, see Configuring an Analytic 
Page. 

About Detail Pages 

Detail pages allow you to view the complete details of one record, such as 
an item, a customer, or a POS transaction. Some detail pages are editable, 
depending on your permissions, while others are read-only. Still others 
allow you to see additional details about a specific item, then let you step 
through the details for every item in a report, item-by-item.  
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One type of detail page is a read-only dialog box that shows you more 
information about a specific item in a results table. To open a detail page, 
click the unique ID for any record in the results table. For example, the 
Company Detail dialog, below, shows all attributes about a specific 
company from the Customer Master.  

  

Another type of detail page is an actionable dialog box that allows you to 
add/edit information to multiple rows in a table. For example, you can 
use the POS Details dialog, below, to change transaction information in a 
specific record, then click Next go through the records one at a time 
without leaving the dialog. Note that clicking Apply lets you save and 
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remain in the dialog box, but if you exit the dialog box without also 
clicking Save, your changes will be lost.  

Other detail pages, like the CIM Programs page, are full, actionable 
pages. For example, the CIM Programs page allows you to see program 
details to clone the program, create a claim, and manage the details of the 
program. Note that detail pages like this contain two movable panes. You 
can resize the panes by hovering over the central horizontal line to get the 
double-arrow pointer that allows you to drag the line up and down. 

 

The layout and labels of the fields that you see in detail pages are 
controlled by the SmartHub Model Spec, where the data types and 
models are defined. The Entomo Professional Services team uses the 
Model Spec to set up SmartHub for your company by defining a variety 
of attributes and behaviors for each detail page, such as: 

 Field labels 

 Display order of the fields, built row by row, rather than in top-to-
bottom columns 

 Whether the field is required to create a record 

 Visibility of the field 

 Whether the field is required when importing 

 Whether the field is editable in the detail page 

Following is an example Model Spec that defines the Company Details 

page, with a snapshot of the resulting page. 
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Chapter 4 | Passwords 

After the initial log-in, your users will be able to set their own passwords, 
which must conform to the following strength requirements. These 
requirements are Entomo defaults, but they can be reconfigured if 
necessary to meet your company's security standards for password 
strength: 

 Minimum password length – 8 alpha-numeric characters  

 Minimum numeric characters – 1 

 Minimum alpha characters – 2 

 Maximum password age – 365 days 

 Number of security questions required – 2 

Reset a Password 

You may reset your password as often as you want.  
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To reset a password: 

1. Go to Site Map > Administration > User Preferences. 

2. In the User Preferences page, click Reset Password.  

3. In the Change Password dialog, enter a new password in both fields. 

4. Click OK. 

Forgotten Password 

To reset a forgotten password, go to the log in page, and click Forgot 

Your Password? Instructions for resetting your password will be emailed 
to you.  

Password Security 

Answers to security questions can only be seen by the user who owns 
them. No one else can see the answers, including Entomo personnel and 
your company’s system administrator. 

If your company requires security questions, a set of security questions 
will be available to each user the first time they log in to SmartHub. To 
ensure security, each user must select questions and provide answers as 
soon as possible after logging in. 

To set up or change security questions: 

1. After logging in to SmartHub, click your name in the top right corner 
of the home page to open the User Settings page. 

2. In the Security Question 1 field, select the question that you want to 
answer. 

3. Type your answer into the Security Answer 1 field, then again into 
the Confirm field. Your answers must match exactly, including case. 

4. Repeat for the Security Question 2 and Answer 2 fields. 

5. When you are finished, click Save. 

Your changes become effective as soon as you log out of SmartHub. 

Chapter 5 | Page Configuration 

Much of the overall layout of SmartHub pages and field definitions are 
automatically handled by the system. But with the proper permissions 



SmartHub 11.0 User Guide   

Entomo Confidential and Proprietary Information  28 

you can customize the filters and tables so you can retrieve the data you 
need and format it in a way that is meaningful for your company. 

 See Filters for information about adding, deleting, and configuring 
the filter fields at the top of reports. 

 See Tables for information about changing column labels, 
reorganizing columns, changing the visibility, and sorting. 

 See Analytics for information about configuring and sorting analytic 
pages.  

Filters 

Entomo SmartHub provides powerful filtering capabilities that allow you 
to create customized reports by selecting and parsing specific data from 
your full data set.  

A section called Filters can be found at the top of most pages. Use the 
fields in this section to define the contents of the reports that you retrieve 
from the SmartHub database. You can set filters to retrieve data based on 
date ranges, part numbers, partners (distributors, resellers, end 
customers), and much more. All filter fields are case-insensitive.  

The results in a report are retrieved based on the combination of all non-
blank fields that are set when you click Retrieve. In other words, a record 
will be retrieved if the conditions set in all filters are true (a logical AND). 
For example, if you select “January 2010” as the accounting period, and 
set “Acme Customer” as the reported end customer, the results will be 
limited to the transactions in January 2010 for Acme Customer. 

Using Filter Expressions 

By default, the report generator in SmartHub uses AND logic, meaning 
that if you enter values in more than one filter field, your retrieved report 
will only contain records that match all the values in the filters. However, 
you can build even more powerful and flexible filters by enabling the 
Query Expression field, where you can use expressions that include OR, 
AND, and parentheses. 

Note that the Query Expression field is currently only available on POS 
and POS Analytics pages, and only if you have permission to make 
changes. 

To use the Query Expression field: 

1. Open the report that you want to build the query for. 

2. In upper right corner, click the Configure Filter icon  (below the 

Reset Page icon ) to open the Filter Bar Configurations dialog. 

3. At the top of the Filter Bar Configuration dialog, select either the Top 
or Bottom option to add the Query Expression field to the main page: 
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o Top – Places the Query Expression field at the top of the Filters 
section. 

o Bottom – Places the Query Expression field at the bottom of the 
Filters section. 

o Disable – Hides the field. 

 

4. (Optional) In the Query Expression field, enter a new label in the 
blank field to the right. This new label will appear on the main page 
after you save. 

5. Click Save to return to the main page, where you can now see the 
Query Expression (or your customized name) field. The fields in the 
Filters section are now numbered so you can refer to them in queries. 

 

6. In the Query Expression field, enter an expression using the 
following guidelines: 

o Use “( )” (without quotation marks) as the grouping operator; use 
logical operators, such as AND/OR. 

o Refer to filter fields by their numbers. 
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o Filters that are defined, but not used in the query expression will 
be ignored. 

o The system will let you know if your query is invalid. 

Following is an example query, followed by its translation. The general 
idea of the query is to find records that contain a customer name (as 
reported by the distributor) that hasn’t been resolved (the resolved field is 
blank, while the reported field is not blank). 

1 AND 2 AND 5 AND ((20 AND 21) OR (22 AND 23) OR (27 AND 28)) 

 

Translation: 

 Return records for the open to current accounting periods AND 

  Include all forecast records AND 

 Find all POS records with any of the following conditions: 

o Rptd SoldTo Name is not blank AND SoldTo Name is blank, OR 

o Rptd ShipTo Name is not blank AND ShipTo Name is blank, OR 

o Rptd OEM is not blank and OEM is blank 

Notice that field 24 in the image contains a value, but that field isn’t 
included in the query expression. As a result, that filter is excluded from 
the data retrieval. 

You’ll see an error message if a query expression is invalid. Following are 
examples of invalid query expressions: 

 Unmatched parenthesis: (1 AND 2) OR 3 AND 4) 

 Unspecified field value: (1 AND 2) AND (6 OR 8) 

 Unsupported operator: (1 AND 2) AND NOT (5 OR 6) 

 Unsupported expression construct: ((1 OR 3) AND 4) OR (5 AND 6) 

For more information, see Popular Expressions for Filters. 

For advanced users, filters can also be configured using JSON scripts. For 
more information, see JSON Scripts. 
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Popular Expressions for Filters 

This topic contains some of the more popular search expressions that you 
can use in filter fields to narrow the data that is retrieved from the 
database. For more information, see Filters. 

Text Fields 

You can enter the following expressions in the text fields in SmartHub.  

 Wildcard (*) 

o Use a wildcard before and/or after a term as a substitute for one 
or more characters so you can do a partial match. 

o For example: Enter *52* in the Item# field to retrieve all items that 
begin with, end with, or contain "52", including BCM56152 and 
BCM52833. 

o Use a single wildcard to mean IS NOT EMPTY or IS NOT NULL. 

o For example: Enter * in the Item# field to retrieve all records that 
contain any value at all in that field (in other words, all records 
where that field isn’t empty). 

o EXCLUDE - Use EXCLUDE as the first word in a filter to retrieve 
everything except the values you specify in the filter. Wildcards 
can be used with EXCLUDE. 

o For example: Enter "EXCLUDE Disti123*" (without quotation 
marks) in the Partner ID field to retrieve all partners except those 
that begin with “Disti123”. 

 Double Quotation Marks (" ") 

o Use double quotation marks to search for a value that contains a 
comma. 

For example: Enter "Disti1, Inc." (with quotation marks) to find 
records for that partner. 

o Use “” (two double quotation marks, without a space) alone in a 
filter to mean IS EMPTY or IS NULL. 

For example: Enter “” in the Item# field to retrieve only the 
records that have nothing in the Item# field. 

 Comma-Separated Values – Use commas as a logical OR expression to 
retrieve any record that matches any of the multiple comma-
separated values in the field. 

For example: Enter "ABC123, XYZ456" (without the quotation marks) 
in the Item# field to retrieve records that contain ABC123 or XYZ456.  

You can also use wildcards with comma-separated values 

Date Fields 

You can use numeric shortcuts in date fields when you know exactly how 
far back you want to retrieve data. Simply enter a minus sign (-), followed 
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by a number, followed by one of the following terms. (If you leave out the 
minus sign or use a plus sign [+], it means to go forward instead of back.)  

 days 

 weeks 

 months 

 years 

 periods 

 end period 

 begin period 

Note that the qualifiers "begin" and "end" can be combined with any of 
the terms, not just with "period". 

Examples: 

Enter Results 

-30 days Returns values from the last 30 days 

-1 period Returns values from the previous period 

0 periods Returns values from the current period 

-1 end period Returns values from the end of the previous period 

-1 begin period Returns values from the beginning of the previous period 

 

Configuring Filter Fields 

The following actions can be done in the Filter Bar Configurations 
dialog. 

Add a Filter 

This topic provides instructions for adding a new filter cell to the Filter 

Bar Configurations dialog, where you can configure the filters that 
appear in a report.  

To add a new cell in the middle of an existing column or row: 

1. Open the report that contains the field you want to change. 

2. Click the Configure Filter icon  (below the Reset Page icon ) to 
open the Filter Bar Configurations dialog. 

3. Right-click the cell where you want to insert the new field, then click 
Insert > Shift Cells Right. 

The Insert menu also allows you to make room for the new cell by 
shifting down the column of cells below your selected cell, but for the 
purposes of this procedure it is assumed that you want to shift the 
row to the right. 

4. Do one of the following: 
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o Drag and drop a new object from the left pane to the empty cell 
you created. 

o To find an object in the left pane, use the Search field at the top of 
the pane. 

o Drag and drop an existing cell into the empty cell. (Select the field 
title, then drag.) 

o Drag and drop an existing cell into another (non-empty) cell to 
override it. 

5. When you are finished, click Save. 

When you are finished creating and moving fields, click Save to return to 
the main page and run a report based on the new logic. The layout will 
persist after the report is saved. 

The following actions can also be done in the Filter Bar Configurations 
dialog. 

Add or Delete Filter Rows and Columns 

With the proper permission, you can use the Filter Bar Configurations 
dialog to add and delete rows and columns in the Filters section of a 
report page:  

Adding 

To add a row or column: 

1. Open the report that contains the field you want to change. 

2. Click the Configure Filter icon  (below the Reset Page icon ) to 
open the Filter Bar Configurations dialog. 

3. Do one of the following: 

o Right-click any cell above the row where you want to insert a new 
row, then click Insert > Entire Row. A new row is added beneath 
the row where you clicked. 

o Right-click any cell to the right of where you would like to insert a 
new column, then click Insert > Entire Column. A new column is 
added to the left of the column where you clicked. 

4. Next, do one of the following: 

o Drag and drop new objects from the left pane to the empty cells 
you created. 

o Drag and drop existing cells (select the field title, then drag) to 
reorganize the grid. 

5. Click Save. 

Deleting 

To delete a row or column: 

1. Open the report that contains the field you want to change. 
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2. Click the Configure Filter icon  (below the Reset Page icon ) to 
open the Filter Bar Configurations dialog. 

3. Right-click any cell in the row or column you want to delete, then do 
one of the following: 

o Click Delete > Entire Row. Any rows below the deletion will be 
automatically shifted up. 

o Click Delete > Entire Column. Any columns to the right of the 
deletion will be automatically shifted to the left. 

4. Click Save.  

Configuring the Filter Grid 

Filter fields are organized in a default grid of rows and columns. With the 
proper permissions you can reconfigure the fields two ways in the Filter 

Bar Configuration dialog: 

 Use the drag-and-drop interface, which allows you to define the fields 
and layout. 

 Use a JavaScript Object Notation (JSON) script that defines the fields, 
behavior, and layout of the filters on a specific page. 

Drag-and-Drop Interface for Filters 

On any page that displays the Configure Filter  icon in the Filters 
section, you can click the icon to open the Filter Bar Configurations 
dialog. 

 

The Filter Bar Configurations dialog shows all available fields in the left 
pane, grouped as related objects, with different icons for each data type 
(text, date, numeric). The main part of the page consists of cells that 
represent the row and column configuration of the fields that are visible 
to users, in the order they appear in Filters. The following image shows 
some of the actions that can be done in the Filter Bar Configurations 
dialog. 
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When you are finished reconfiguring the filters, you can then save the 
new configuration for the page going forward. If you remove a field, it 
will no longer appear in the grid but it will be available again in the left 
pane. Empty rows and cells in the grid will appear as empty spaces in the 
Filters section. 

Filter Names 

By default, the name of the cell is the name shown in the left pane, but 
you can change the label by entering a new name in the blank field to the 
right of the cell title.  

Enable Changes 

To make changes to the layout, you must set the Override Default 

Layout option to Yes. The No option prevents changes. If you make 
changes before selecting this option, the changes will be lost and the 
layout will return to the default layout for your company. 
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Create OR Filters 

With the proper permission, you can use the Filter Bar Configurations 
page to create filters fields that use OR logic.  

Each cell in the filter bar layout has a Fields list that shows the database 
objects that are associated with the cell. The objects are listed as <object 
folder: object name>. For example, the Acctg From field shown below 
was created by dragging the Acctg From object from the Standards 
folder, so the term "Standard: Acctg From" is displayed under Fields. 

 

When only one field is listed, the cell uses AND logic, but if you drag 
another object under the Fields list, OR logic is created for that cell. This 
means that you can enter a value into that filter field to return data from 
more than one database object. In the following example, you’d be able to 
enter a date range in the Marketing Approved Date filter to return any 
transaction that has either a Marketing Approved Date OR a Marketing 

Sent Date within that range. 

To create OR logic: 

1. Open the report that contains the field you want to change. 

2. Click the Configure Filter icon  (below the Reset Page  icon) to 
open the Filter Bar Configurations dialog. 
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3. In the grid, locate the filter field where you want to build the OR 
logic.  

4. In the left pane, identify which field you want to add to the cell. 

Note that the data type (numeric, text, or date) of the second object 
must match the first.  

5. To the list of column labels under Fields, drag-and-drop additional 
fields under Fields to configure the logical OR for that cell. 

Delete a Filter 

With the proper permission, you can use the Filter Bar Configurations 
dialog to delete a filter from a report page.  

To delete a filter: 

1. Do one of the following: 

o Click the X to the right of the field name.  

You won’t be able to delete cells that don’t have an X. These cells 
are required by the system and cannot be removed. 

o Right-click the cell that you want to delete, then click Delete > 

Shift Cells Left or Shift Cells Up, depending on how you want to 
modify the layout. 

2. When you are finished, click Save to return to the main page so you 
can run a report based on the new logic. The new layout will persist 
after the report is saved.  

View Related Reports 

When you're working in a report, it can be helpful to see the report in the 
more familiar format of one of your saved reports (with your 
personalized table formats and labels) to help you better understand the 
data in the active page or report.  

To see these related reports, your Entomo Professional Services team can 
help you set up a filter (in certain reports) called Drill Down Reports (or 
a similar name). This filter allows you to apply the format of a saved 
report to the active report or page. The filter will only list reports that you 
have permission to view. The filter works the same way in analytic and 
non-analytic reports. 

To open a related (or drill down) report: 

1. Open a report and click Retrieve. 
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2. In the Drill Down Report field, select a report from the list. 

 

3. Click View Details.  

The example above assumes that you retrieved revenue information 
according to business unit, and that you wanted to see the 
corresponding transactions in the format of your “POS Management 
Sell Through” report. The results table then will display the data of 
from the "Revenue by BU" report in the format of your 
"POS Management Sell Through" saved report, as shown here. 

  

4. To return to the original report, click the Return arrow , or click 
the name of the report in the breadcrumb. 
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JSON Scripts 

It's possible to use a JavaScript Object Notation (JSON) script to define the 
behavior and layout filters on a specific page. The scripting option (via 
the Module Configuration page) for configuring filters allows you to 
change filter labels, add/delete filter fields, and change the layout of the 
filter bar, among other things. The page is available for advanced users 
with the proper permissions, but it is usually used only by your Entomo 
Professional Services team. 

Using JSON scripts, it’s possible to configure the following items: 

 Widget options (text fields, select lists, combo box/multi-select fields) 

 View restriction (read-only, default values, and required) 

 Additional filter fields for the logical OR 

 Visibility for partner/sponsor, security group, and user levels 

 Filter definitions and filter layout 

To access and edit a script: 

1. Go to Site Map > Administration > Module Configs. 

2. Do one of the following: 

o Click Retrieve. 

o Enter values in the filter fields to narrow your search to a specific 
filter bar configuration and module, then click Retrieve. 

For example, in the ID field, you can enter “*pos*filter*label*” 
(without quotation marks) to retrieve the following list of filter bar 
configurations that define the labels used in the various filter bars 
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in the system. You can identify the JSON scripts by finding the 
term “JSON” in the Value column. 

3. In the results, find the line you want, then click the icon in the Large 

Value column for that line. The Config Details page opens. (It’s 
possible to select a checkbox, then click Edit, but editing is more 
difficult and it’s easy to accidentally remove any formatting you 
might have to make the script more readable.) 

4. In the Config Details page, edit the filter bar configuration in the 
Value field. 

For example, the following script configures the filter bar shown in 
the image, below. 

JSON: 
{ 
“layouts”:[ 
[ "ID:", "Active:", "Sales Rep.:", "Company.SAttrib7" ], 
[ "Name:", "Login:", "Partner:", "Company.CustomerNumber" ], 
[ "Type:", "Mfr. Rep.:", "Any Channel:=Channel Type:" ] 
] 
} 

 

Contact your Entomo Professional Services team for help with the 
names of the controls defined in SmartHub. 

5. When you are finished with your changes, click Save. 

6. For the changes to take effect, log out of SmartHub and log in again. 

Tables 

Tables display data records that are retrieved from the SmartHub 
database based on the filters you set. The retrieved records are organized 
in rows according to columns that can include item, customer, POS 
transaction, etc. Column labels are specific to the report you are 
generating.  

Change the Visibility and Order of Columns 

People with the proper permission can change the labels, order, and 
visibility of columns in the tables that appear in pages and saved reports. 

To configure the columns in a table: 

1. Open the report you want to change. 

2. To the right of the action bar, click the Configure Columns icon  to 
open the Select and Order Visible Columns dialog. (If this icon is 
missing, you can’t make changes.)  

In the dialog, columns that are available but not yet selected, are in 
the left Choices pane. The right pane (named Selections in non-
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analytic pages and Aggregate Columns/Display Only Columns in 
analytic pages) lists the columns currently visible in the table, in the 

order that they appear. To customize column names, see Changing 
Column Labels. 

 

3. Do any of the following, as needed: 

o To add a column to the table, do one of the following: 

 Drag a column label from Choices to the right pane, placing 
the label in the position where you want the field to be 
displayed in the table. 

 Double-click a label to move a field to the end of the list in the 
right pane, where you can drag-and-drop it into any position 
you want. 

o To remove a column from display, drag the column label from a 
right pane to Choices, or double-click it. 

o To move multiple columns at one time, hold Ctrl while clicking 
multiple column labels, then drag them to the other pane. 

4. When you’re finished, click OK. 

Some people can see and click the Configure Page icon  in the right 
corner of the Select and Order Visible Columns dialog. You can 
ignore this icon for the most part since newer functionality supersedes 
most of the functions in that dialog. However, for analytic reports, a 
section of the dialog works. For more information, see Configuring an 
Analytic Page. 

 

If the column you want isn't listed in the Select and Order Visible 

Columns dialog, see Configuring an Analytic Page. 

Changing Column Labels 

With the proper permissions, you can change the column labels in a table. 

To edit column labels, do the following: 
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1. Open the table you want to change. 

2. To the right of the action bar, click the Configure Columns icon  to 
open the Select and Order Visible Columns or Select and Order 

Aggregate Columns dialog, depending on whether you're on an 
analytic or non-analytic page. 

3. For the Override Default Labels option, click Yes. 

4. Click the column you want to change. This makes the Edit Label  
icon appear. 

 

5. Click the icon and rename the column label as needed, then click the 
checkmark to save. 

6. Save the report to preserve your changes. 

The new label you entered will now be displayed on the report instead of 
the default label. 

Sorting Table Columns 

In any table, you can click a column label to make the sort arrow appear 
so you can sort the contents of the table in ascending or descending order.  

To add multiple columns to the sort: 

1. Click the first column label.  

2. Press and hold Ctrl, and click another column.  

The added columns will be numbered in the order you click them. 

3. To remove the multi-column sort, click any column. 

The sorting configuration in a table impacts the functionality of the Limit 
Results filter. For more information, see Sorting in Analytic Pages. 
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Toggle the Table Labels 

When default pages are set up, tables can be set to display either full 
column labels or a shortened version of the labels by default. Shortened 
labels can be useful in long tables to shrink the header row so you can see 
more rows without having to scroll down. If short labels are set up for a 
report or page, users can toggle between the long and short labels by 
clicking the Toggle icon . 

A table showing long labels: 

  

The same table with short labels: 

When you save a report, you can override the display default, if desired.  

For information about configuring the behavior of labels company-wide, 
see Configuring an Analytic Page. 

Analytic Pages 

Analytic pages allow you to aggregate (or group together) records using 
one or more dimensions (for example, by partner, item, or customer, or 
any combination) and see subtotals and totals for those dimensions. For 
example, in the POS Analytics page, you might aggregate sales revenue 
by partner and item so you can view sales revenue for different items for 
a given partner.  

While reports on non-analytic (list) pages (such as POS or Inventory) 
provide a view of large amounts of data, analytic pages allow you to 
focus on more specific dimensions of the data and create informative 
charts and graphs based on those dimensions. For a tour of an analytic 
page, see Analytic Page Navigation. 
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For example, in the POS page, you might see a report of all partner sales 
in a specific accounting period, but in the POS Analytics page, you can 
then configure a report to show sales revenue by partner, sold-to 
customer, and end customer so you can find your top 10 sold-to 
customers in a particular period. Consider the following example that 
shows the results of those selections. 

 

Configuring an Analytic Page 

The steps in the following procedure suggest a certain order, but many of 
these steps can be performed in any order.  

To configure the columns in an analytic page: 

1. Open the analytic report that you want to change. 

2. Set a date range for your report, usually in filters called something 
like Accting Prd. From/Accting Prd. To or Trans Date From/ Trans 

Date To. (If they are not available, your report has been pre-set to an 
accounting period so you can skip this step.) 

3. On the right of the action bar, click the Configure Columns icon  to 
open the Select and Order Aggregate Columns dialog. We'll return to 
this dialog after a few steps.)  
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4. In the upper right corner of the dialog, click the Configure Page icon 

 to open an untitled editing dialog. (If this icon is missing, you 
don’t have permission to edit the page.) 

 

5. In the Table Period field, select the interval (by week, month, etc.) 
you want in your report. 

 

6. If the Interval Date field is available, select an option to base the 
report on transaction end dates, transaction begin dates, or accounting 
dates. 

 

7. In the Last Column field, select one of the following: 

o Total – The far right column will calculate the total for each row in 
the table. 

o Average – The far right column will calculate the average (instead 
of total) of each row in the table. 
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o Difference – The far right column will calculate the difference 
between any two periods selected in a table. If more than two 
periods are in a table, you can select the two periods that you 
want to compare. Click the first period, then press Ctrl while 
clicking the second period. The selected periods are indicated with 

double angle-brackets . 

 

Note that the Difference column always calculates “last-to-first,” 
meaning that the difference is between the last-clicked period, then 
the first-clicked period. 

8. In the Records to Retrieve field (if available), select an option to 
retrieve and display data from all inventory reports, or only from the 
first/last report. 

For instructions about how to use the other fields in this dialog, see 
Change the Visibility and Order of Columns. 

9. Click OK to close the dialog. 

10. Click the Configure Table icon  again to re-open the Select and 

Order Aggregate Columns dialog. 

11. Click the Configure Subtotals tab. The left Choices pane lists the 
columns that are available, but not selected. Decide what numeric 
data or dates you want to see (for example, quantities? extended 
prices? the number of transactions? begin/end date?). Drag those 
column labels from the Choices pane to the Selections pane. 
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The results table will show columns for the numeric data you selected 
for each of the periods you set.  

 

12. Click the Configure Aggregates tab. Decide how you want to display 
the numeric data (for example, by distributor? by product type? 
both?). These “by-what” dimensions are defined as aggregate 
columns and display-only columns in this tab. Drag the column labels 
you want from Choices to one of the following panes: 

o Aggregate Columns – A Total row is displayed for each group (a 
group is whatever you have defined as aggregate columns). 

o Display-Only Columns – You’ll be able to see amounts in these 
columns, but they won’t have a Total row. 

 

Important: The right-most dimension (non-numeric) column in every 
table automatically acts like a display-only column (without a Total 
row), even if it is set as an aggregate column. 

NOTE: The columns you select will appear in your table in the same 
order as in the dialog box. If you add more than one column to the 
Aggregate Columns pane, the order in the dialog establishes the 
order of aggregation of the columns in the table, with the second and 
subsequent columns as a subset of the first column. 
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Examples 

Total and Subtotal Rows 

The following settings create the, below, which shows how subtotal rows 
are added for the first and second aggregate columns. 

Aggregate Columns Pane Display-Only Columns Pane Configure Subtotals Tab 

Disti Name 

Trans. Type 

Invoice# Part Qty 

Rptd. Ext. Resale Price 

Rptd. Ext. Quoted Price 

Clarifying Display-Only Columns 

Sometimes, adding aggregate columns can create unnecessary Total 
rows. The following tables show the effect of simply changing one 
column from an aggregate column to a display-only column. 

The first table has two aggregate columns (Disti Name and UC) and one 
display-only column (UC Country) so you can see the end/ultimate 
customers (UC) associated with each distributor and their countries. 
Totals are shown for each distributor and UC because they are both set as 
aggregate columns. 



SmartHub 11.0 User Guide   

Entomo Confidential and Proprietary Information  49 

Aggregate Columns Pane Display-Only Columns Pane Configure Subtotals Tab 

Disti Name 

Trans. Type 

UC Country Part Qty 

Rptd. Ext. Resale Price 

Rptd. Ext. Quoted Price 

Results: The countries are shown for each UC, and a Total row appears 
for each UC. Notice, however, that the Total row for the UC exactly 
repeats the numbers in the row above it. This makes the table difficult to 
read. To remove the redundant Total row, you can change UC to a 
display-only column, as shown in the second table. 

 

The second table in this example is identical to the first except that UC 
has been changed to a second display-only column. The redundant Total 
rows are gone, making the results table easier to read and more 
meaningful. 

Aggregate Columns Pane Display-Only Columns Pane Configure Subtotals Tab 

Disti Name UC 

UC Country 

Part Qty 

Rptd. Ext. Resale Price 

Rptd. Ext. Quoted Price 

Results: The redundant Total rows are gone, making the results table 
easier to read and more meaningful. 
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For more examples, see Sorting in Analytic Pages. 

13. Back to the procedure for configuring an analytic page, click OK to 
close the dialog. 

14. In Filters, select the Show Period Details checkbox to display the 
accounting periods as separate columns. If that option is not selected, 
the results table will have a single Total column on the right that 
shows the combined total for all periods, instead of one column per 
period (as shown here). 

 

15. (Optional) If you want to limit the number of records retrieved, sort 
the table appropriately, enter a limiting value in the Limit Results 

field in Filters, then press Enter to lock in the limits. For more 
information, see Sort with the Limit Results Filter, including 
instructions for creating “Top 10” reports with the Limit Results 
filter. 

16. The results table will be automatically reconfigured. (You’ll only need 
to click Retrieve if the results table should turn blank.) 
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With the proper permissions, you can also reconfigure the labels, order, 
and visibility of columns. For more information, see About Tables. 

Sorting in Analytic Pages 

The basic sorting functionality of analytic pages is the same as in list 
(non-analytic) pages, that is, clicking a column label lets you sort in 
ascending (or alphabetic) order, while clicking the label again sorts in 
descending (or reverse-alphabetic) order. (For more information, see 
Sorting Table Columns.) But sorting in analytic pages is more 
complicated because of the way that rows are grouped based on the 
definition of the aggregate and display-only columns in the Configure 
Page dialog. 

The best way to explain the sorting behavior in analytic pages is with the 
examples that follow. 

Sort by a Single Column 

If you sort a column that is defined as an aggregate column (Disti Name 
in this example), the column is sorted the same as in a list (non-analytic) 
page (in this case, ascending/alphabetically). 

 Default Page: POS Analytics 

 Filter Settings: Show Period Details – Yes 

 Table Settings: Click the Configure Table icon , then use the 
following settings. 

Aggregate Columns Pane Display-Only Columns Pane Configure Subtotals Tab 

Disti Name None Part Qty 

Rptd. Ext. Resale Price 

Rptd. Ext. Quoted Price 
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Results: For the company’s distributors, the number of parts sold in Jan–
Feb 2015 is shown, comparing the reported extended resale price and the 
reported extended quoted price for each distributor. A single Total row at 
the bottom of the table shows the totals of each column for all 
distributors. Clicking the sort arrow again on the Disti Name label will 
reverse the sort order. 

Sort by Multiple Columns 

If you sort on more than one aggregate column (for example, click Disti 
Name, then press Ctrl + UC), the contents of both columns are 
alphabetized, but restrained by the first aggregate column. 

 Default Page: POS Analytics 

 Filter Settings: Show Period Details – Yes 

 Table Settings: 

Aggregate Columns Pane Display-Only Columns Pane Configure Subtotals Tab 

Disti Name 

UC 

None Part Qty 

Rptd. Ext. Resale Price 

Rptd. Ext. Quoted Price 

 Sort Order: 

o 1 – Disti Name, ascending 

o 2 – UC, ascending 

Results: 

 The distributors are listed in ascending/alphabetical order, and the 
end customers (UC) are also in alphabetical order, per distributor. 



SmartHub 11.0 User Guide   

Entomo Confidential and Proprietary Information  53 

 Clicking the sort arrow again on either of the Disti Name or UC 
column labels will reverse the sort order of either column, 
independently. 

 Without the second sort on the UC column, the items in that column 
will be in random order. 

Sort by a Numeric Column 

Sorting by a numeric column is especially helpful to find the top 
distributors based on a numeric measure (for example, Part Qty or Rptd. 
Ext. Resale Price). 

 Default Page: POS Analytics 

 Filter Settings: Show Period Details – Yes 

 Table Settings: 

Aggregate Columns Pane Display-Only Columns Pane Configure Subtotals Tab 

Disti Name 

UC 

None Part Qty 

Rptd. Ext. Resale Price 

Rptd. Ext. Quoted Price 

 Sort Order: 1 – Part Qty, descending 
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Results: The contents of the Part Qty column are listed in ascending 
order, with the distributor with the highest total at the top. UCs are also 
sorted from highest to lowest by Part Qty, per distributor. Clicking the 
Part Qty column a second time will reverse the sort. 

 

In the next example, the same settings are used, and the distributor/UC 
combination is again sorted by the totals in the Part Qty column, but the 
end/ultimate customers (UC) are now listed alphabetically. 

 Sort Order: 

o 1 – UC, ascending 

o 2 – Part Qty, descending 
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Results: The distributors are listed according to highest total in Part Qty, 
and the UCs per distributor are shown in alphabetical order. Note that 
the UC column must be the first column in the sort. 

The distributors with the highest total Part Qty are at the top of the list. 
You could limit this list to the top 10, for example, by using the Limit 

Results filter. For more information, see Sort with the Limit Results Filter. 

Sort by Absolute Value 

Pressing Shift while you click the label of a numeric (subtotal) column 
allows you to sort by absolute value. The signed values (positive and 
negative) are displayed, but negative values are sorted as positive 
numbers. 

You can add more than one column by pressing Ctrl + Shift when you 
click the additional columns. Be sure to also press Ctrl + Shift when you 
reverse the sort order of an absolute value sort. 

 Default Page: G/L Entry Analytics 

 Filter Settings: Show Period Details – Yes 

 Table Settings: 

Aggregate Columns Pane Display-Only Columns Pane Configure Subtotals Tab 

GL Phase 

GL Entry Type 

Line Segment 1 

Account Description Amount 
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 Sort Order: 1 – Amount, ascending  

Results: The table is sorted by absolute values in the Amount column so 
you can see the offset amounts. 

 

Sort with the Limit Results Filter 

Your Entomo Professional Services team can help you set up a Limit 

Results filter (or some variation of it) in any analytic report to help you 
control the number of records that are displayed after a data retrieval. 
You can set limits for multiple aggregate columns by entering values 
separated by commas, in the order that the columns are listed in the 
Aggregate Columns pane. 

You can use values in the Limit Results filter as follows. 

Rule Example Results  Comments 

Leave blank    No limits on the records retrieved.   

Use any 
numeral  

5  Retrieve the first 5 records defined by your selection of an 
aggregate column. 

  

Use two 
numerals 
separated by 
a comma 

 5,2  Retrieve the first 5 of the records set as the 1st aggregate 
column, and the first 2 records set as either the 2nd aggregate 
column or display-only column.  

If a report has multiple aggregate columns, 
you can enter a limit for each column, 
separated by commas, in the order that 
the columns are listed in the Aggregate 
Columns pane. 

You can use any number of numerals and 
commas in the string (e.g., 5,10,2). 

Use blanks in 
a string 

 ,10 

 
 

10, , 7 
 

 Retrieve all records set as the 1st aggregate column, then the 
first 10 records of the 2nd aggregate column. 

Retrieve the first 10 records set as the 1st aggregate column, 
and all records set as the 2nd aggregate column records, and the 
first 7 records of the 3rd aggregate or display-only column. 
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Use negative 
values  

-5  Retrieve everything except the first 5 records.   

NOTE: It’s important to sort a table first, before setting limits. 

To use the Limit Results filter: 

1. Open a report, click Retrieve, then sort the results by a numeric 
column (one that is defined as a “subtotal column” in the Configure 

Columns dialog). 

The sort order that you set prior to activating the Limit Results filter 
is also used for sorting the limited results, so be sure to sort the table 
first, according to the type of limit you want to impose. Sorting on a 
numeric column usually produces the most useful results. 

2. In the Limit Results filter, enter one or more limiting values (see the 
table, above, for examples). 

3. While the cursor is still in the Limit Results filter, press Enter. 

You can now manipulate the limited results by doing any of the 
following actions: 

o Sort on a different column. 

o Change other filter settings. However, if you change the filter then 
click Retrieve, a new set of records will be displayed. 

o Create a chart. 

To remove the limitation, press Enter again (after changing the limiting 
values or deleting them) while the cursor is in the Limit Results filter, or 
exit the report without saving. 

This feature is especially helpful for creating reports that narrow data to 
the “top 10.” See Create a “Top 10” Report.  

Create a “Top 10” Report 

The Limit Results field is especially helpful for creating lists of the top x 
(number of) records per subtotal dimension, for example, “Top 5 
Partners,” or “Bottom 10 Parts by Revenue.” The following example 
creates a report of distributors whose parts have the highest net revenue. 

 Default Page: POS Analytics 

 Filter Settings: 

o Show Period Details – Yes 

o Limit Results – 10,3 

 Table Settings: 

Aggregate Columns Pane Display-Only Columns Pane Configure Subtotals Tab 

Disti Name 

Part # 

None Gross Revenue 

Net Revenue 

file:///C:/Users/alisonb/Documents/SH%2011.0/PDF%20of%20Online%20Help/Version%204/Top%23_Create_a_
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 Sort Order: 1 – Net Revenue, descending 

Steps to re-create: 

1. Open the analytic report, and click Retrieve. 

2. Click twice on the Net Revenue column label to sort that column in 
descending order. 

The table now lists all distributors, with the parts per distributor 
listed according to net revenue from the highest (top-selling) to 
lowest. The total at the end of the table is the net revenue for all parts 
of all distributors. 

Note that you could easily create a “Bottom 10 Distributors” report by 
sorting the net revenue in ascending order. 

3. In the Limit Results filter, enter “10,3” (without quotation marks), 
then press Enter. 

The results are still sorted by net revenue, but the list is limited to the 
ten distributors who have the highest total net revenue. The totals and 
subtotals of the limited results have been recalculated to reflect the 
limitation, showing the totals of the top three parts per distributor 
instead of the total of all parts per distributor. The total at the end of 
the table now reflects the total net revenue of only the three top-
selling parts of those ten distributors. 
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You can now perform certain actions on the limited results, such as 
sorting on different columns and changing filter settings. Let’s assume 
that you’d like that list in alphabetical order by distributor name, with 
the parts in order, too. 

4. Click the Disti Name column, then press and hold Ctrl while clicking 
the Part# column. 

The table lists the same ten distributors with the same part numbers 
and totals, but now the distributors are in alphabetical order, and the 
parts for each distributor are also in ascending order. The totals in the 
table are unchanged. 

Detail Pages 

Detail pages allow you to view the complete details of one record, such as 
an item, a customer, or a POS transaction. Some detail pages are editable, 
depending on your permissions, while others are read-only. Still others 
allow you to see additional details about a specific item, then let you step 
through the details for every item in a report, item-by-item.  

One type of detail page is a read-only dialog box that shows you more 
information about a specific item in a results table. To open a detail page, 
click the unique ID for any record in the results table. For example, the 
Company Detail dialog, below, shows all attributes about a specific 
company from the Customer Master.  
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Another type of detail page is an actionable dialog box that allows you to 
add/edit information to multiple rows in a table. For example, you can 
use the POS Details dialog, below, to change transaction information in a 
specific record, then click Next go through the records one at a time 
without leaving the dialog. Note that clicking Apply lets you save and 
remain in the dialog box, but if you exit the dialog box without also 
clicking Save, your changes will be lost.  

 

Other detail pages, like the CIM Programs page, are full, actionable 
pages. For example, CIM Programs page allows you to see program 
details to clone the program, create a claim, and manage the details of the 
program. Note that detail pages like this contain two movable panes. You 
can resize the panes by hovering over the central horizontal line to get the 
double-arrow pointer that allows you to drag the line up and down. 
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The layout and labels of the fields that you see in detail pages are 
controlled by the SmartHub Model Spec, where the data types and 
models are defined. The Entomo Professional Services team uses the 
Model Spec to set up SmartHub for your company by defining a variety 
of attributes and behaviors for each detail page, such as: 

 Field labels 

 Display order of the fields, built row by row, rather than in top-to-
bottom columns 

 Whether the field is required to create a record 

 Visibility of the field 

 Whether the field is required when importing 

 Whether the field is editable in the detail page 

Following is an example Model Spec that defines the Company Details 

page, with a snapshot of the resulting page. 
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Recently Accessed Reports  

The Most Recently Accessed listing at the top of your favorites pane 
tracks the reports you open. Click the group to expand/hide the list. If 
you have marked any of them as a favorite, the star appears yellow.  

 

Each user controls whether the Most Recently Accessed list appears at 
the top of their favorites pane  

To turn the feature on/off, do the following: 

1. Click your name at the top of the page to open the User Settings 

page.  

2. Select the Enable Recently Accessed Reports option. 

3. In the Max. Recent Reports fields, enter the number of reports you 
want to see in the list on your favorites page.  

4. Click Save. 

Chapter 6 | User and Company Settings 

User and company settings are used to configure SmartHub to suit the 
needs of companies and individuals. Every user can configure certain 
settings for themselves (passwords, and table and page formatting) by 
clicking their name in the top right corner of any page in SmartHub to 
open their user profile (the User Settings page). Other settings (user 
setup, resetting passwords, managing group membership and proxies) 
are configured by system administrators for your company. 
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User Settings 

Every user can open their personal profile, called User Settings, to reset a 
password, manage authentication channels/devices, and personalize 
certain table and page behaviors. To open User Settings, click your name 
in the top right corner of any page in SmartHub.   

 

The User Settings page contains the following: 

 Reset Password – See Passwords. 

 Authentication and Remembered Devices – See Two-Step 
Authentication. 

 User Name and Information – The first five fields on the page are not 
editable. They are populated with information based on your user 
profile. Consult your system administrator if any of this information 
needs to be changed. 

 Customized Formatting – You can configure certain settings for 
yourself. See Date and Report Formatting. 

 Security Questions – Fields for security questions and answers 
appear only if your company requires them. If one or more questions 
are required, you’ll be prompted to answer the security questions 
upon log-in. You can select alternate questions or change your 
answers as needed. The input in the Confirm fields must match your 
entry in the answer fields. For more information, see Password 
Security. 

 Recent Reports – See Recently Accessed Reports. 

Set Up Date and Report Formatting 

To set up date and report formatting: 

1. Click your name in the top right of the home page to open the User 

Settings page.  

 

The Login ID, First Name, Last Name, Company Name, and Email 
fields are automatically populated from your system information.  

2. In the Date Format field, select the date format from the list that you 
want to use.  

Entomo User 

Entomo User 
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3. (Optional) In the Rows Per Page field, enter the number of rows that 
you want to see per page on reports. This default number can be 
modified in any active report by changing the # of Rows value at the 
bottom of all reports.  

4. (Optional) In the Paging Table Header Display Format field, select 
the size for your column labels in reports. (The term “paging table” 
simply means a table that can span more than one page.)  

o Select Long to see the full names of columns.  

o Select Short to narrow the header row to a single row (which 
shortens the labels if the company has entered short names in 
Company Settings).  

Your selection becomes the default behavior, but you can toggle 

between Short and Long in any report by clicking the  icon. Table 
label formatting can be set company-wide. See Table Label 
Formatting. 

5. (Optional) In the Paging Table Column Short Label Max Size field, 
enter a number to limit the number of characters in a Short label.  

6. (Optional) The Favorites Pane Expand Mode field, refers to the 
behavior of the report groups in the favorites pane: 

o Single – Restricts the expansion behavior so you can only expand 
one report group at a time. 

o Multiple – Allows you to expand more than one report group at 
the same time, as shown below.  

o If left blank, the company default is used.  
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Multiple is the default, as shown in the following image.  

 

7. When you are finished, click Save. 

8. Log out of SmartHub and log in again to apply the new settings. 

Table Settings 

With the proper permissions, you can configure the behavior of tables 
and pages for the entire company. Users can override some of the 
company settings with their individual settings (via User Settings) and 
by customizing the formatting of the reports they use.  

This section configures the default currency precision and label behavior 
in all SmartHub tables.  

To set the number of decimal places displayed for currency.  

1. Go to Site Map > Administration > Company Settings. 

2. In the Number Formatting section, enter the number of decimal 
places that you want for displaying currency values in the following 
fields:  

o Min. Currency Precision – The minimum number of decimal 
places to display for currency values (other than for unit values). 

Two expanded 
report groups 
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o Max. Currency Precision – The maximum number of decimal 
places to display for currency values (other than for unit values). 

o Min. Unit Currency Precision – The minimum number of decimal 
places to display for unit values.  

o Max. Unit Currency Precision – The maximum number of 
decimal places to display for unit values.  

For example, if you import records that report unit values to four 
decimal places, you might want to set Max. Unit Currency 

Precision to “4” so you can see all of the imported decimal places, 
but set Max. Currency Precision to “2” so extended currency 
values are displayed with only two decimal places. The results of 
these settings might show 200 units, for example, with a unit cost 
of $4.2945 each, but with an extended total cost of $858.90. 

3. (Optional) In the Paging Table Header Format field, do one of the 
following: 

o Select Long to display the full names of column labels.  

o Select Short to display table labels in a single row (and shorten the 
labels).  

Your selection of Long or Short sets the default behavior for all 
tables, but users will be able to toggle between long and short 

labels by clicking the toggle  icon on any table.  

4. (Optional) In the Paging Table Short Label Max Size field, enter the 
maximum number of characters allowed for a short label. This value 
will limit the width of a Short label.  

5. When you are finished, click Save. Continue with Page Configuration, 
if needed.  

User Manager 

The User Manager page controls how users interact with SmartHub at an 
administrative level. With the proper permission, you can access Site 

Map > Administration > User Manager to add/delete users from 
SmartHub, add/edit/delete group memberships, export a list of users, 
manage user proxies, and more. 

User Manager – Filters 

The Filters section has the following fields that you can use to narrow 
your data retrieval. 

 Company – To narrow the data retrieved to a single company, select 
that company from the dropdown list; otherwise, leave blank or click 
the blank option at the top to retrieve groups for all companies. 

 User – To narrow the retrieval to specific users, either type in the 
login IDs for those users, or click the magnifying glass icon and select 
the checkboxes for users you want. 
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 Group – Use the dropdown to narrow the retrieval to a specific 
security group. 

 Role – A role is a group that is assigned to a workflow (such as an 
approval workflow). 

o Select Yes to retrieve users who have been assigned a role in a 
workflow.  

o Select No to retrieve users who have no roles assigned. 

o Select the blank option at the top to retrieve both sets of users.  

 Active – Select Yes to retrieve users who currently have an active 
status. Select No to retrieve users that are not active. 

 Category – Double-click the field or click the magnifying glass icon to 
select users designated by a certain category (such as various types of 
incentive programs) or set of categories.  

User Manager – Actions 

 Retrieve – Click to return a list of users based on your settings in 
Filters. 

 New – Click to add a new user to the system. For instructions, see 
Add a New User. 

 Export – Click to open the Export As dialog that allows you to select 
between various export options. For more information, see Exporting 
Reports.  

 Save Report – Click to open the Create a New Report dialog that 
allows you to save a report based on the User Manager page. 

Add a New User 

With the proper permissions, you can add users to SmartHub.  

To add a new user: 

1. From your home page, go to Site Map > Administration > User 

Manager.  

2. Click New to open the User Details page. 

3. In the Login field, enter a login ID for the user.  

4. In the First Name field, enter the user’s first name.  

5. In the Last Name field, enter the user’s last name. 

6. Depending on the configuration of your system, the Company Name 

and Company ID fields might already display your company’s info, 
which cannot be changed. However, if partner companies are enabled 
for log-in, the Company Name field will display a drop-down list 
with the names of the partner companies. If the field is editable, select 
the appropriate company name for the user. 
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7. Double-click the Email field or click the  icon to the right to open 
the Email dialog, then do one of the following: 

o New Email – Enter a new email address in the text field at the top 

of the dialog, then click the Add Address  icon. Repeat for each 
email that you want to add.  

 

o Existing Email – Select the checkbox of an existing email address 
from the list, click Append (to add to an address already in the 
Email field) or click Replace (to replace an address already in the 
Email field). The address now appears at the top of the dialog.  

8. When you are finished, click OK to return to the User Details page. 
The new email address will now appear in the Email field.  

9. (Optional) In the Phone Number field, enter a phone number for the 
user.  

10. (Optional) In the Fax Number field, enter a fax number for the user. 

11. In the Active field, do one of the following: 

o Select Yes to allow the user immediate access the system. 

o Select No to set up a user without activating them.  

12. (Optional) In the Federated ID field, enter a federated ID for the user. 

13. (Optional) In the Home Page field, select a home page for the user. If 
no home page is selected, the system will assign one based on the 
user’s group membership.  

14. In the Category field, assign a category (for example, an incentive 
program) to the user, if applicable. 

15. In the CBI enabled field, select Yes if your company uses CBI 
(Consolidated Business Intelligence) within SmartHub; otherwise, set 
to No.  

16. When you are finished, click Apply to save and continue with the 
next procedure; otherwise, click Save to save your changes and exit.  

Create or Reset a Password  

With the proper permissions, you can set up a new password for a new 
user or reset a password for a user who has forgotten theirs.  

To create or reset a password: 

1. Do one of the following: 
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o To continue from the previous procedure, remain in the User 

Details page and skip to step 2.  

o From your home page, go to Site Map > Administration > User 

Manager, click Retrieve, then click the name of the person for 
whom you want to create a password.  

2. Do one of the following: 

o In the New Password and Verify New Password fields of the 
Password Settings section, enter a password. 

o Click the Generate Password button to auto-generate a password, 
which populates both the New Password and Verify New 

Password fields.  

3. Click Apply. 

4. Click Email Password to send the password to the email address 
shown in the Email field. 

5. In the Force Password Change field, select Yes to force the user to 
change the password from the temporary one you emailed to a more 
secure one that has not been sent via email.  

6. When you are finished, click Apply to save and continue with 
Manage Password Settings; otherwise, click Save to save your 
changes and exit.  

Manage Password Settings 

With the proper permissions, you can manage certain password behavior 
for other users. For information about how a user can reset their own 
password, see Create or Reset a Password. 

To manage password settings for an individual user: 

1. Do one of the following: 

o To continue from the previous procedure, remain in the User 

Details page and skip to step 2.  

o From your home page, go to Site Map > Administration > User 

Manager, click Retrieve, then click the name of the person for 
whom you want to make changes.  

2. In the Password Settings section, use the following fields to manage 
the password behavior for the user.  

Field Purpose 

Force Password Change By default, this field reflects the company-level setting in 
Administration > Security Settings.  
Select Yes to require the user to change their password the next time 
they log in.  

Answer Security Questions By default, this field reflects the company-level setting in 
Administration > Security Settings.  
To change the setting for an individual, select Yes to require the user 
to answer security questions upon log-in.  
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Field Purpose 

Enable Admin Mode? By default, this field reflects the company-level setting in 
Administration > Security Settings.  
Select Yes to grant the user administrative privileges. 

Password Min. Age (Optional) A value in this field prevents a user from changing their 
password until that number of days has passed since their last 
password change. For example, to allow only one password change 
every 30 days, enter 30. 

Password Max. Age (Optional) A value in this field requires the user to change their 
password after that number of days. For example, to require the user 
to change their password every 3 months, enter 90. 

Account Locked? By default, this field is set to No.  
Select Yes to prevent a specific user from logging in to SmartHub.  

 

The remaining fields are automatically populated by the system when 
a user is created or updated. 

3. When you are finished, click Apply to save and continue with Assign 
or Modify Group Membership; otherwise, click Save to save your 
changes and exit.  

Assign or Modify Group Membership 

The User Security Group tab on the User Details page provides a quick 
and simple way to assign users to one or more security groups that are 
defined for your company.  

To assign or modify group membership: 

1. Do one of the following: 

o To continue from the previous procedure, remain in the User 

Details page and skip to step 2.  

o From your home page, go to Site Map > Administration > User 

Manager, click Retrieve, then click the name of the person you 
want to assign to a security group.  

2. Click the User Security Group tab. 

3. Click Edit Group Membership to see a list of all security groups 
defined for your company.  

4. Select one or more checkboxes to assign the user. (Clicking the name 
of any group opens the Group Details page so you can see the 
responsibilities associated with the group and the people already 
assigned to it.)  

5. When you are finished, click Apply to save and continue with 
Proxies; otherwise, click Save to save your changes and exit. 

Proxies 

In SmartHub, the ability to log in as a different user is called being a 
proxy. For example, if a program approver goes on vacation, an 
administrator can give proxy privileges to another person who can 
approve the program in the absence of the original approver.  
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Before you can proxy someone else’s account, you must be granted 
permission by someone with administrator privileges. An administrator 
can give a proxy privilege to one or more individual users or to an entire 
group of users. The timeframe of proxy privileges can also be controlled.  

CAUTION: When a person proxies someone else's account, everything 
they do in that account is as if the account owner made the changes. 

Note that the proxy feature does not affect or redirect anyone’s email.  

Grant Proxy Privileges 

To set up proxy privileges: 

1. From your home page, click the Proxy link at the bottom of the 
Favorites pane, or go to Site Map > Administration > User Manager. 

2. In the User Manager page, do one of the following: 

o Click Retrieve, then click the name of the user you want to give 
the ability to proxy. When their User Details page opens, click the 
User Proxy Settings tab. You can modify an existing proxy 
privilege or click Add Line to create a new one. The instructions 
in this procedure assume that you added a line.  

  

o Click the Manage User Proxies button to open the User Proxy 

Map page, then click Retrieve > Edit > New. 

 

3. Use the By User Name or By Security Group fields to select the user 
or group that you want to allow to act as proxies.   
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4. Use the For User Name or For Security Group fields to select the 
accounts that will be accessed. 

You can set up proxies various ways: 

o Group to Group – Anyone in the By Group can log in as any 
member in the For Group. 

o User to User – The By User can log in as the For User. 

o User to Group – The By User can log in as anyone in the For 

Group. 

o Group to User – Anyone in the By Group can log in as the For 

User. 

For example, if an approver is on vacation, an alternate approver can 
log in as the original approver and approve workflow items for the 
original approver. The settings might look like this: 

By User Name  By Security Group For User Name  For Security Group 

Alternate approver   Original approver  

Alternately, if any member of a group can be the alternate approver, 
the settings would be like this: 

By User Name  By Security Group For User Name For Security Group 

 Anyone in the group of 
alternate approvers 

Original approver  

Likewise, anyone in a By Group can log in as anyone in a For Group 
like this: 

By User Name  By Security Group For User Name For Security Group 

 Anyone in the group of 
alternate approvers 

  Anyone in the original 
group of approvers 

 

5. (Optional) You can set a time limit on any proxy. Use the Valid From 
and Valid To fields to specify a time limit for the proxy privilege. The 
day after the Valid To date, the proxy privilege will expire.  

6. (Optional) Click New again to create another proxy privilege. You can 
grant multiple proxies to a single individual.  

7. (Optional) Select check boxes on the left to save specific lines. (If you 
don’t select specific check boxes, all lines are saved.) 

8. Select the checkbox for the new proxy. 

9. Click Save to save and go back to the User Manager page. (Clicking 
Apply will let you save, but remain on the page.) 

Acting as a Proxy 

Before you can log in to someone else’s account as a proxy, a person with 
administrative privileges must first grant you proxy privileges. See Grant 
Proxy Privileges.  
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One person can access (proxy) multiple accounts as long as they’ve been 
granted proxy privileges for each of those accounts, but accounts can only 
be proxied one at a time.   

To log in as a proxy: 

1. Do one of the following: 

o Go to Site Map > Administration > User Manager.  

o From your home page, click Proxy at the bottom of the favorites 
pane.  

 

2. In the User Manager page, locate the account you want to access, and 

click the Login icon  to the left of the user's name.  

 

VP Sales ( 

Program 

Finance 

ACME 
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3. In the confirmation dialog, click OK to end your own session and log 
in to the other person's account. 

Note that everything you do is as if the other person was doing it.   

4. To end your proxy session, click Exit Proxy at the bottom of your 
favorites pane.  

An individual can proxy multiple accounts, but not at the same time. For 
each account, start with step 1 of this procedure.   

Update an Existing User Profile 

To update the profile of an existing user: 

1. From your home page, go to Site Map > Administration > User 

Manager.  

2. (Optional) Set filters to narrow your retrieval. For descriptions of the 
filters, see User Manager - Filters. 

3. Click Retrieve. 

4. In the Name column, click the name of the user you want to update. 

5. In the User Details page, make changes as needed. For descriptions of 
the fields and action buttons on this page, see the various sub-sections 
of Add a New User.  

6. When you are finished, click Save to return to the User Manager 
page.   

Two-Step Authentication 

SmartHub offers an optional verification process that provides an extra 
level of security for user accounts. When the authentication feature is 
activated, you are required to log in to SmartHub with a dynamically 
generated, one-time security code in addition to your regular password. 
The security code is retrieved from an email account, text message, or the 
Google Authenticator app (on a Smartphone). In SmartHub, these 
authentication methods/types are called factors. It’s possible to configure 
multiple factors, including multiples factors of the same type, such as two 
different email addresses. 

Another optional feature is the ability to configure SmartHub to 
remember the browser that you use to log in to SmartHub. Creating a 
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remembered device allows you to log in to SmartHub with a password 
alone (without a security code) when you use a remembered browser. 
This feature is especially helpful if you log in to SmartHub on multiple 
devices (like a tablet and a Smartphone).  

Your system administrator can limit the length of time that a browser can 
be remembered. When that time expires, you will be required to repeat 
the authentication process.  

First Authentication  

If your company opts to use two-step authentication, use the following 
procedure to log in to SmartHub for the first time. 

To log in to SmartHub the first time with authentication: 

1. Log in to SmartHub with your company ID, login ID, and password.  

The Configure Remaining Authentication Types dialog opens.  

2. If you see a dropdown list in field 1, select either Google 
Authenticator, email, or SMS (text message) as the method for 
authenticating your log-in credentials; otherwise, if no dropdown is 
offered, skip to the next step. 

3. In field 2, do one of the following: 

o Email or SMS – If you select Email or SMS, one of the following 
dialogs open; otherwise, you will see one of them by default.  

 

a. Enter the email address or phone number that you want to use 
for authentication purposes.  

b. Click Send.  

A new verification code is sent to you via email or text message. (If 

you can’t find the new password in your email, check your Spam 

folder.) 

c. Go to step 4.  

o Google Authenticator – If you select Google Authenticator, the 
following dialog box opens. Field 2 offers both a key (an 
alphanumeric string) and a Quick Response (QR) code that can be 
scanned with your Smartphone, assuming that you already have 
Google Authenticator installed.  
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4. Do one of the following: 

o Alphanumeric Key – Enter the key in field 2 into Google 
Authenticator, then click Add in the Authenticator to produce a 
six-digit, one-time password. Go to step 4.  

o QR Scanner – If the Google Authenticator app on your phone is 
set up for QR scanning, use your phone to scan the QR barcode 
that appears in the dialog box. Google Authenticator will generate 
a six-digit, one-time password. Go to step 4.    

5. After retrieving the new password/verification code from your 
email/text message/Google Authenticator, enter the code into the 
field designated in the SmartHub dialog, then click Verify. 

6. Depending on your previous choices one or more of the following 
questions now appear in the dialog box: 

o Primary Factor – Whenever you set up multiple factors (for 
example, an email account and a Google Authenticator instance), 
you can designate one as your primary so it will be automatically 
selected when you next login. Select Yes to make the current 
factor the primary. 

o Remembered Device – Decide whether you want SmartHub to 
remember the browser you are currently using.  

If you select Yes, you won’t have to perform the authentication 
steps (retrieving the code from email/text/Google Authenticator) 
for the length of time determined by your system administrator. 
When that time expires, you will be required to repeat the steps 
above to log in and remember your computer again.  

o Device Name – When you choose to have SmartHub remember 
your browser, you have the option to assign a name to it (for 
example, “Chrome at Work” or “Firefox on Tablet”). This name 
will appear in the Remembered/Authenticated Devices page of 
your user profile in User Settings.  
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It’s helpful to assign a name to a remembered device if you use 
multiple browsers so you can differentiate between them in the 
user profile list. 

7. When you are finished, click Save.  

8. If another authentication factor is required by your company (in 
addition to your password), repeat steps 1-6 as needed. 

9. Click Login.  

Every time you create an authentication factor or remembered device, 
your User Settings page is updated. You can add/delete factors. For 
more information, see Add a New Authentication Factor. 

Add a New Authentication Factor 

Users can set up as many authentication factors and remembered devices 
as they want in their user profile. It can be helpful to set up more than 
one authentication method in case something happens to the first factor, 
such as a lost or damaged cell phone.  

The Authentication Factors and Authenticated Devices tabs in a user 
profile (User Settings) show all of the authentication factors and devices 
you set up. For the tabs to appear, the Second Factor Authentication 

Settings and Devices Registration Settings must be enabled at the 
administrative level. For more information, see Authentication Settings.   

To add a new factor: 

1. From the home page, click your name in the upper right corner to 
open User Settings. 

 

2. Click Two-Factor Authentication.  

The Authentication Factors page opens. Previous keys, if any, are 
listed in the Value column. You can delete any of them by selecting a 
checkbox, then clicking Delete. Click in the Type column to change 
the setting for Primary, if needed. 

Entomo User 
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3. In the Authentication Factors page, click New.  
 

4. In the Two-Factor Settings dialog, select an authentication factor (the 
method you want to use to retrieve the security code) in field 1. 

5. Depending on your selection, do one of the following: 

o Email or SMS – If you select Email or SMS, one of the following 
dialogs open.  

a. Enter the email address or phone number that you want to 
use for authentication purposes, then click Send.  

b. A new verification code is sent to you via email or text 
message. (If you can’t find the new password in your email, 
check your Spam folder.) 

c. Go to step 6.  

o Google Authenticator – If you select Google Authenticator, the 
following dialog box opens. Field 2 offers both a key (an 
alphanumeric string) and a Quick Response (QR) code that can be 
scanned with your Smartphone, assuming that you already have 
Google Authenticator installed.  

6. Do one of the following: 
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o Alphanumeric Key – Enter the key in field 2 into Google 
Authenticator, then click Add in the Authenticator to produce a 
six-digit, one-time password. Go to step 6.  

o QR Scanner – If the Google Authenticator app on your phone is 
set up for QR scanning, use your phone to scan the QR barcode 
that appears in the dialog box. Google Authenticator will generate 
a six-digit, one-time password. Go to step 6.    

7. After retrieving the new password/verification code from your 
email/text message/Google Authenticator, enter the code into the 
field designated in the SmartHub dialog, then click Verify. 

8. In field 4, decide whether you want to establish the factor you just 
created as the primary authentication method. Select Yes to make the 
current factor the primary.  

If you set up more than one factor (for example, an email account and 
a Google Authenticator instance), it’s helpful to designate one as the 
primary so it will be automatically selected when you next need to 
authenticate your log-in.  

9. When you are finished, click Save.  

Configure the Authentication Tabs 

Users can configure the columns and behavior of the Authentication 
Factors and Authenticated Devices tabs in their profile pages. 

To configure the authentication tabs: 

1. From the home page, click your name in the upper right corner to 
open User Settings. 

2. In the Authentication Factors page, click the Configure Columns 
icon to open the Select and Order Visible Columns dialog.  

Only columns in the Selections pane are viewable. Move the columns 
you want to see from the Choices pane to the Selections pane (or vice 
versa to hide them). 

3. (Optional) To change a label, do the following:  

a. Set the Override Default Layout option to Yes (the No option lets 
you move columns, but not change the labels). 

b. Click the label you want to rename.  

c. When the Edit  icon appears, click it.   

d. In the field, change the column label by entering a new one.  
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e. Click the green arrow to save.  

 

f. Repeat for any other label that you want to change.  

g. When you are finished, click OK to save and return to the 
Authentication Factors page; otherwise, you can further configure 

the behavior of the columns by clicking the Configure Page  
icon for the current session only. Changes are lost when you leave 
the page.  

For instructions about changing page behavior, see Date and 
Report Formatting.  

4. When you are finished, click OK to return to the Authentication 

Factors page. 

Authentication Settings 

With the proper permissions, you can set the number of required layers 
of authentication and the length of time that they are remembered. Users 
can see their own authentication settings in their individual user profiles.  

To enable and configure authentication settings company-wide: 

1. From the home page, go to Site Map > Administration > Security 

Settings.  

2. In the Two-Factor Authentication Settings section, select the Enable 
option. 

3. Use the Email, SMS, and Google Authenticator checkboxes to select 
all of the options that you want to make available for users.  
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4. In the Min. Auth Factors field, select the number of authentication 
factors (email, SMS, or Google Authentication) that you want to 
require each user to configure.  

If this field is left blank, users will not be required to set up any 
authentication factors, but they can choose to set up one, if they want. 

5. (Optional) In the Remembered Device Settings section, click Enable 
to allow users the option of having the system remember their 
browser upon log-in, and skip authentication for the length of time set 
in the Number of Days to Remember field.   

If this option is left blank, authentication will be required every time 
users log in.  

6. In the Number of Days to Remember field, enter the number of days 
a browser can be remembered.  

7. When you are finished, click the Test Security Settings to ensure that 
your changes are valid. Make corrections, if needed.  

 

8. When you are finished, click Save.  

Recover Lost Authentication Factors 

When a second factor is lost, contact your system administrator, who can 
delete the lost factor for the user. This might cause the user to reconfigure 
their factors on the next log-in. If security questions are configured, the 
user might also be required to answer one of them at log-in. More drastic 
measures (resetting password, security questions) can be taken if 
password theft is assumed.  

Authentication Privileges 

The following responsibilities allow administrative users to configure 
two-factor authentication and manage the authentication factors and 
remembered devices for other users. No special responsibilities are 
required for a user to manage their own authentication factors and 
remembered devices. 

 The “Two Factor Authentication View” privilege lets a user view 
factors for other users.  

 The “Two Factor Authentication Delete” privilege lets a user delete 
factors for other users. 
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 The “User Device View” privilege lets a user view and reset 
remembered devices for other users.  

 The “Two Factor Authentication Config View” privilege lets a user 
view the Security Settings page.  

 The “Two Factor Authentication Config Modify” privilege lets a user 
edit the Security Settings page. 

Manage Table Behavior Company-Wide 

Use the lower section of the Company Settings page to set the default 
table behavior for specific reports.  

To format table behavior: 

1. If you’re continuing from the previous procedure, remain in the 
Company Settings page; otherwise, go to Site Map > Administration 

> Company Settings.  

2. In the Paging Table Header Format field, do one of the following: 

o Select Long to display the full names of column labels.  

o Select Short to display table labels in a single row (and shorten the 
labels).  

Your selection of Long or Short sets the default behavior for the 
selected report-building page, but users can still toggle between 

long and short labels by clicking the toggle  icon.  

3. (Optional) In the Column Label Max Size field, enter a number of 
characters to limit the width of a Short label.  

4. (Optional) To create shortened labels, select the checkboxes for the 
labels you want to shorten, then click Edit to open the UI Table 

Configuration page. Simply type a new, shortened name into the 
Short Title field for each column. When you are finished, click OK to 
return to the Company Settings page.  

5. When you are finished, click Save. 

6. Log out of SmartHub and log in again to apply the new settings. 

The table formatting is this procedure can be overridden by individual 
settings (via User Settings), settings in a specific saved report, or by page-
specific settings within Company Settings at the individual report level, 
as in the next procedure. 

Set Up Report-Building Pages 

With the proper permissions, you can use the lower portion of the 
Company Settings page to configure the behavior for specific pages that 
users can then use to create their own views or versions (a.k.a. “saved 
reports”) that can be saved to their favorites pane.  

To configure a report-building page: 
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1. If you’re continuing from the previous procedure, remain in the 
Company Settings page; otherwise, go to Site Map > Administration 

> Company Settings.  

2. In the List Page Selection field (in the Page Configuration section), 
select the page you want to configure. Your selection automatically 
displays the columns associated with that page.  

The following steps let you set the visibility of columns for people 
who use a report-building page. If you need to add or remove 
columns from this list of available columns, see Enabling/Disabling 
Columns. 

3. (Optional) Use the Visible Columns field to narrow the display of 
columns:   

o Select Yes to display the visible columns only. 

o Select No to display the hidden columns only. 

o Click the blank row at the top of the list (or leave blank) to display 
the full set of columns.  

4. In the Rows per Table field, enter the number of rows you want to 
display as the default for the selected report-building page. The 
default is 200 rows.  

5. In the Paging Table Header Format field, select Long or Short as the 
default behavior for all of the column table labels in the page you’re 
configuring.   

This setting overrides the setting in the Paging Table Header Format 
field above (under General Settings) for the selected page. Leave it 
blank to use the value in the Paging Table Header Format field.  

6. (Optional) In the Paging Table Short Label Max Size field, enter a 
number of characters to limit the width of a Short label.  

This setting overrides the setting in the Paging Table Short Label 

Max Size field above (under General Settings). Leave it blank to use 
the value in the Paging Table Header Format field. 

7. Perform any of the following actions as needed: 

Goal Action 

Create a short label Select the checkboxes for the labels you want to shorten, then click Edit 
to open the UI Table Configuration page. Simply type a new, shortened 
name into the Short Title field for each column. When you are finished, 
click OK to return to the Company Settings page. 

Change column 
visibility 

Click Configure Visible Columns to open a dialog where you can move 
columns between the Choices pane (to hide them) and the panes on the 
right (to make them visible). Click OK when you’re finished. 

Reset column labels Select the checkboxes for the rows you want to change, then click Set 
Defaults. 

Reset entire page Click Reset. 

Create spreadsheet 
with current settings 

To create a comma-delimited file, click Download, then follow the 
prompts.   
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8. When you are finished, click Save to save your current settings, and 
remain on the page.  

9. Either repeat the steps in this procedure to configure another report-
building page or exit the page by clicking the home icon.  

10. Log out of SmartHub and log in again for your changes to take effect.  

Enabling/Disabling Columns  

While implementing your SmartHub solution, your Entomo Professional 
Services team works with your company to determine what columns are 
needed for reporting. With this information, report-building pages are 
then configured and made available at Site Map > Administration > 

Reports. Anyone with the proper permission can use these pages to 
create a saved report (or view) and change the visibility of columns in 
that report by using the Select and Order Visible Columns dialog (via 

the Configure Columns icon ). 

Use the following procedure to manage the list of columns available in 
the Select and Order Visible Columns dialog for a specific report-
building page.  

 Enable – To enable a column means that it is available in the Select 
and Order Visible Columns dialog.  

 Visible – To make a column visible means that it will appear by 
default in the report-building page. When a user wants to hide the 
column for a saved report, they can move the column from Selections 
to Choices in the Select and Order Visible Columns dialog. 

To enable/disable the columns that appear in the Select and Order 

Visible Columns dialog: 

1.  Go to Site Maps > Administration > Company Settings. 

2. In the Page Configuration section, select from the Page field the page 
you want to change. Your selection automatically displays all of the 
columns available for that page.  

3. Select the checkboxes of the columns you want to enable/disable.  

4. Click Edit. 

5. In the list of columns on the UI Table Configuration page, do one of 
the following: 
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o Select/deselect individual checkboxes in the Enabled column. 
Enabled columns will be available for selection in the Select and 

Order Visible Columns dialog. 

o Use the Disable All Columns or Enable All Columns buttons in 
the action bar to change all of the columns at once.  

6. In the Visible column, select/deselect checkboxes to determine 
whether a column will appear by default in the page:  

o Enabled, But Not Visible – The column will appear in the Select 

and Order Visible Columns dialog, but it will not appear on the 
report-building page until a user  moves the column from Choices 
to a right pane in the Select and Order Visible Columns dialog.  

 

o Enabled and Visible – The column will appear in the Selection 
pane of the Select and Order Visible Columns dialog and it will 
appear by default on the report-building page. Users can hide the 
column for a saved report by moving the column back to Choices 
in the Select and Order Visible Columns dialog.  

For these columns to 
appear here… 

…they must be set to Enabled, but not 
Visible in Company Settings 
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o Visible, but Not Enabled – This is an invalid choice. The system 
automatically sets the column to “not visible.” 

7. Click OK to return to the Company Settings page. Your changes are 
not yet saved.  

8. To save your changes, click Save. 

9. Log out of SmartHub and log in again for your changes to take effect. 

Chapter 7 | Security Groups 

In SmartHub, application security (permissioning) is managed through 
the Group Manager page, which uses the following hierarchy of 
privileges, responsibilities, and groups to control user access to modules 
and to actions within the modules: 

 Privilege – A specific action or group of actions (for example, to view, 
create, import, open, analyze, resolve) that are predefined in 
SmartHub. 

 Responsibility – A collection of related privileges that permit users to 
interact with a specific SmartHub function or feature. For example, 
the Background Job Responsibility might contain privileges that grant 
permission to delete/modify/schedule a job, 
create/delete/modify/view a job template, and create a company-
level job template. 

 Security Group – A collection of responsibilities granted to a specific 
business group. For example, you might want to limit the Direct Sales 
group to certain responsibilities, such as Item Cost View and Item 
Price View (in the Item Responsibilities category) so that all users in 
the Direct Sales group will only have permission to view (not edit) 
Item Cost and Item Price information.  

For this column to 
appear by default in 
the report-building 

page (and in the 
Select and Order 

dialog)…. 

…it must be set to Enabled and Visible 
in Company Settings 
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Your Entomo Professional Services team will work with you to set up 
specific groups of users (for example, Executive, Finance, and Marketing) 
and assign responsibilities to those groups based on the needs of your 
company. Users with administrative roles can then use the Group 

Manager page to add and remove users from these groups, and create 
new security groups.   

Group Manager Page  

With the proper permissions, you can access Site Map > Administration 

> Group Manager, where you find the following fields, buttons, and tabs 
to create and manage your company’s security groups.  

 

Group Manager – Filters 

The Filters section has the following fields that you can use to narrow 
your data retrieval. Filters are cumulative.  

 Role – The term role is used in SmartHub to designate a person who is 
assigned to a workflow (such as an approval workflow). 

o Select Yes to retrieve people who are assigned to workflows.  

o Select No to retrieve everyone who is not assigned to a workflow. 

o Select the blank option at the top to retrieve users without 
considering role.  

 Company – If you want to narrow the data retrieved to a single 
company, select that company from the dropdown list; otherwise, 
click the blank option at the top to retrieve groups for all companies.  

 Group – If you want to retrieve a specific group, you can enter the 
name of the group; otherwise, click the magnifying glass to open a 
dialog that lists all groups. You can select one or more groups. 
Clicking Append will add your selections to any value already 
populating the Groups field. Clicking Replace will replace any value 
in the Groups field with your current selection. To clear the field, do 
one of the following: 

o Press Backspace. 

o Click the magnifying glass, make no selections in the dialog that 
opens, then click Replace.  
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Group Manager – Actions 

 Retrieve – Click to return a list of groups based on the parameters 
you set in Filters. 

 New – Click to open the Group Details page, where you can create a 
new security group. For instructions, see Create a New Security 
Group. 

 Save Report – Click to open the Create a New Report dialog, where 
you can save your filter settings and page configuration to your 
favorites pane and/or associate a favorite group to the report.  

Create a New Security Group 

With the proper permissions, you can create new groups in the Group 

Details page.  

To create a new group: 

1. From your home page, click Site Map > Administration > Group 

Manager.  

2. Click New. 

 

3. In the ID field of the Group Details page, enter a name for the new 
security group (usually something like <name, department, action>).  

4. (Optional) In the Description field, click the pencil icon to open a 
dialog where you can describe the group. When you’re finished, click 
OK to close the dialog. 

5. (Optional) If the group members are all from one company, select that 
company from the Company Name list. 

The Group Members tab is now populated with the users associated 
with the company you selected.  

6. In the Role field, select Yes to assign the group to an approval 
workflow (groups are called “roles” when they become part of a 
workflow); otherwise, select No.  

The Responsibilities tab displays the responsibility sets that are 
available.  
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7. (Optional) In the Category field, select a responsibility set from the 
list to limit the responsibilities that are displayed.  

8. (Optional) Use the Enabled field to filter the list based on whether a 
responsibility set is assigned to the group: 

a. Select Yes to show only the assigned responsibilities.  

b. Select No to show only the unassigned responsibilities.  

c. Select the blank option at the top to retrieve all responsibilities.   

9. In the Description column, select the responsibilities you want to 
assign to the group by selecting their associated checkboxes.   

10. In the Group Members tab, select the checkbox of each user that you 
want to assign to the new group.  

11. (Optional) Use the Enabled field to filter the list based on whether a 
user is selected.  

o Select Yes to show only the selected.  

o Select No to show only unselected users.  

o Select the blank option at the top to retrieve the entire list of 
available users.   

12. Click Save to save and exit; click Apply to save without exiting. (You 

can click the Cancel icon  here to exit completely without saving.) 

Delete a Security Group 

Once you create a group, it cannot be deleted if it has other dependencies 
in the system, such as an associated report or job, until you remove those 
dependencies. The following steps assume that the security group that 
you want to delete has no dependencies.  

To delete a group that has no dependencies: 

1. From your home page, click Site Map > Administration > Group 

Manager.  

2. In the Group field in Filters, click the magnifying glass icon to open a 
dialog. 

3. In the dialog, select one or more groups that you want to delete, then 
click Append to add your selections to the search field. 

4. Click Retrieve.  

5. In the table, click the name of a group to open the Group Details 

page. 

6. Click Delete.  

7. Repeat steps 5 and 6 as needed for any other groups you want to 
delete.  

Change Responsibilities or Members in a Security Group 

Users (usually administrators) with the User Management privilege can 
edit user records using the following steps. Users with the User View 



SmartHub 11.0 User Guide   

Entomo Confidential and Proprietary Information  90 

privilege can view the group details, but they cannot edit. Users without 
User View cannot access the Group Manager page.  

To change information in an existing group: 

1. From your home page, click Site Map > Administration > Group 

Manager.  

2. Click Retrieve. 

3. Click the name of the group you want to change.  

4. In the Group Details page, click Edit, and do one or both of the 
following: 

o Change Responsibilities – With the Responsibilities tab active, 
click Edit Responsibilities, then select/deselect the responsibility 
checkboxes in the Description column as needed. When you are 
finished, click Apply to save without exiting.  

o Change Group Membership – To add and remove group 
membership, click the Group Members tab, then select/deselect 
users as needed. Use the Enabled field to see only the actively 
assigned people (Yes), only the unassigned people (No), or 
everyone (leave blank). When you are finished, click Apply to 
save without exiting.  

5. When you are finished making changes, click Save to save and return 
to the main Group Manager page.  

Security Groups for Workflows 

SmartHub allows your company to set up automated workflows 
according to rules and business processes that you define, such as an 
approval process for channel incentives, commission splits, or other 
programs. These workflows can include specific activities, such as multi-
level approvals.  

Workflow membership is defined by security groups that are customized 
for your company by your Entomo Professional Services team. When you 
assign a user to a workflow security group, they are assigned the Role 
attribute so you can set filters based on Role.  

When a workflow item requires approval or some other action, the item 
will appear in the To Do List (on the home page) of the person with the 
appropriate role (as defined by the workflow). (The To Do List is only 
visible when a user is required to participate in a workflow.) When the 
action is completed, the item then advances to the next step in the 
workflow.  

Audit Report for Responsibilities 

With the proper permissions, you can see a report that lists all of the 
responsibilities currently assigned to users.  

To audit responsibilities: 
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1. Go to Site Map > Administration > User Summary. 

2. Do one of the following: 

o Click Retrieve. 

o Enter values in the Filters section to narrow your search, then click 
Retrieve.  

The User Summary page lists the security groups and responsibilities 
currently assigned to each user.  

3. (Optional) For more detail, click one of the following links: 

o Login ID – Opens the User Details page for a specific user. 

o Company Name – Opens the Company Details dialog box.  

o Group Name – Opens the Group Details page for more 
information about a specific security group.  

4. (Optional) To export specific rows to a spreadsheet or comma-
delimited (.csv) file, select the checkbox for one or more rows, the 
click Export. 

User Summary – Filters 

The Filters section of the User Summary page has the following fields 
that you can use to narrow your data retrieval. Filters are cumulative.  

 Company – If your system is set up with multiple companies, select 
one from the list; otherwise, accept the default.  

 Responsibility – Click the magnifying glass to select and search for 
one or more responsibilities. In the dialog, move the responsibilities 
that you want into the Selections pane, then click OK.  

 Mfr. Rep – Select Yes to narrow your search to manufacturer reps 
only. Select No to retrieve everyone except manufacturer reps.  

 User – Click the magnifying glass to narrow your search to one or 
more users. In the dialog, select as many users as needed, then either 
click Append to add the selected users to any names already in the 
filter field, or click Replace to replace anything in the filter field with 
the currently selected names. 

 Resp. Category – Click the magnifying glass to select and search for 
one or more responsibility categories (such as Administrator, Audit, 
Workflow, etc.). In the dialog, move the categories that you want into 
the Selections pane, then click OK.  

 Any Channel – If your system implements multiple sales channels 
(such as distributor, end customers, and reseller), select one to narrow 
your search. 

 Group – Select a security group to narrow your search to people who 
belong to that group.  
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 Type and Category – If these fields are active for your system, use 
them to narrow your search to a specific type and category of security 
group.  

 Active – Select Yes to narrow your search to active users only. Select 
No to retrieve everyone except active users.  

 Role – Select Yes to narrow your search to users who are assigned 
roles in any workflow. (In SmartHub, when a user is assigned to a 
security group that is designated as an approval workflow, the user 
has a role.) Select No to retrieve everyone except users with roles. 

 Add Time – Enter a date range to narrow your search to new 
responsibilities added within that date range. 

 Mod Time – Enter a date range to narrow your search to 
responsibilities modified within that date range. 

User Summary – Actions 

The action bar on the User Summary page provides the following: 

 Retrieve – Return a list of users and their currently assigned security 
groups and responsibilities based on the parameters you set in Filters. 

 Export – Export the rows you select by checking the checkboxes to the 
right of the User Name column.  

 Save Report – Click to open the Create a New Report dialog. For 
more information, see Saving Reports.  

 Configure Columns – Use the  icon to show/hide the columns 
that are displayed in the table on this page. Some of the more helpful 
columns include Active (Effective), (Group) Add User ID, and 
(Group) Last Mod. Time, which show the dates when a user was 
made active, the date a user was added, and the date that a group was 
last modified. For more information, see Modify Report Columns. 

Security-Based Ownership 

In SmartHub, the data you can access and the actions available to you are 
controlled by the security groups to which you are assigned. Specific 
reports, dashboards, home pages, and favorites lists are controlled by, 
and restricted to, an owner or set of owners. 

Ownership can be assigned to a company, security group, or individual 
user. If a company is the owner, all users belonging to that company will 
have access. If a security group is the owner, all users belonging to that 
security group will have access. If a user is selected as the owner, only 
that user will have access. 

Ownership can be designated as follows: 
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 Reports – When you save a new report, you can designate the owner 
as a company, security group, or user. See Creating and Saving 
Reports. 

 Dashboards – When you set up a new dashboard, you can designate 
the owner as a company, security group, or user. See Creating 
Dashboards. 

 Favorites – When you set up a new favorites list, you can designate 
the owner as a company, security group, or user. See Configure a 
Favorites List. 

 Home Pages – When creating a new home page, you can designate 
the owner as a company, security group, or user. See Create a New 
Home Page. 

If your access to anything in this list is erroneously prohibited, contact 
your system administrator. 

Chapter 8 | Reports 

With SmartHub, a wide variety of reports are possible, most of which will 
be customized for each Entomo customer. Because reports are so 
customized, it isn’t possible to explain in this guide how to use individual 
reports. Instead, this section covers the basic functionality of reports, in 
general. For information about how to use specific reports, contact your 
Entomo Professional Services team.  

SmartHub has two types of reports: 

 Default Reports – With the proper privilege, you can access default 
(template) reports in SmartHub via the Site Map menu. Once in a 

default report, you can use the Configure Columns  icon to see all 
of the currently enabled columns, with their default labels, and 
additional columns that are available but not active. 

 Saved Reports – The reports in the favorites pane  are customized 
and saved versions of default reports. Typically, your Entomo 
Professional Services team works with your company to create a list 
of reports that all users can see in their favorites pane when they log 
in to SmartHub for the first time. The reports you have permission to 
see will appear in your favorites list.  

Opening Reports 

You can open/run reports on any data in the SmartHub database that 
you have permission to access based on your security group assignments. 
For example, Distributor A might have permission to see a report that 
contains data related to their own company's transactions, but not the 
transactions of Distributors B through Z. Likewise, data can be 
permissioned according to departments, where Department X can't access 
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or run a report that contains sensitive data that only Department Z 
should see.  

To open a saved report in your favorites pane: 

1. Click  to open the favorites pane. 

2. Click the name of the report you want to open.  

Some reports run automatically with preset filters when you click the 
name of the report, but if you open a report and the page opens without a 
results table, click Retrieve. If you still don't see results, consider the 
following: 

 Check the filter parameters. If needed, expand the Filters section by 
clicking the down arrow. 
Consider revising your filter 
criteria to include parameters 
that will ensure that data will 
be returned. For example, have 
you selected a valid accounting 
period that contains the data you're looking for? 

 Check date ranges. The values you specified in date fields might be 
outside the acceptable range. Consider revising them to ensure that 
data will be returned. 

 Check your permissions. You might not belong to the security group 
that can access the data. Contact your system administrator for help.  

Saving and Creating Reports 

You can save reports by clicking Save Report on any page that offers that 
button. You can save a report three ways: save your changes as a new 
report, update an existing report, or rename an existing report.  

To save or create reports: 

1. Open the report that you want to modify or use as the basis for your 
new report.  

2. Modify the filters or column configuration as needed.  

3. Click Save Report to open the Create a New Report dialog. 

4. In the dialog, select one of the following options: 

o New – Saves your changes as a new report, and assigns it to a new 
user or security group. 

o Update – Saves your changes to an existing report, without 
changing its name or who it’s assigned to.  

o Rename – Saves your changes and rename the report, without 
changing who it’s assigned to.  

5. If Report Name is available, enter a new name for the report.  
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6. The Create Output Types field is available only after you retrieve a 
report. If it is available, the retrieved results can be saved and made 
viewable from Site Map > Administration > Reports. In the Create 

Output Types field, choose a format for the output: 

o CSV for a comma-separated file (the output will match the 
columns in the report) 

o PDF for a portable document file (.pdf) 

o Excel for an Excel spreadsheet 

7. For new reports, the fields in the Owner Type row will change 
depending on your selection in the Owner Type field. Select 
Company, Security Group, or User, then specify a company, 
security group, and/or individual from the other dropdown lists in 
the row. 

8. In Report Description, click the edit pencil to open the Description 
dialog, where you can add a description, then click OK.  

9. In Report Group, select one of the groups in your favorites pane  
to assign the report to that group.  

10. Select the Retrieve Results on Run option to set the report to 
automatically retrieve results when the report is opened. The results 
will be based on your saved filters.  

11. You will only need the Select Favorites This Report Belongs To 
section if more than one favorites pane is available to you based on 
your security group assignments. If needed, move one or more items 
from the Choice List to the Selections list with the arrow buttons 
between the two panes or by double-clicking your selection.  

12. Click OK to save and close the dialog. 

13. At the top of the favorites pane, click the Refresh  icon.  

If you chose to include the new/updated/modified report in your 

favorites pane , it is now displayed.   

Report Maximums 

The maximum number of records that can be retrieved (usually 500) is set 
by your company with the help of your Entomo Professional Services 
team. If you run a report that returns more than the maximum allowed 
records, you'll be able to view (in the results table) only the maximum 
records allowed.  

To view all of the records (including those that exceed your company's 
maximum), you can export the results as a .csv or DDF file. (For more 
information, see Exporting Reports.) Otherwise, consider revising your 
filter criteria to return a subset of data rather than all records, or limit the 
scope of the data to a specific date range. 
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Modify Report Columns 

The columns that appear in reports are defined in Site Map > Company 

Preferences. Your Entomo Professional Services team will work with 
your company to design a default set of reports for each business group 
that uses SmartHub. Users will be allowed to use those default reports, 
and also create customized versions, as needed. For more information, 
see Configuring Tables.  

Exporting Reports 

Data can be exported from SmartHub whenever the Export command is 
available in the action bar. To print a report, you must first export it.  

To export a report: 

1. From the action bar, click Export. 

2. In the Export As section, select a format for your data:  

o CSV creates a comma-separated (.csv) file (the output will match 
the columns in the report).  

o Excel creates a spreadsheet.  

o PDF creates a .pdf file.  

o DDF creates a file in the Data Definition Format (DDF). Usually, 
this option is only used by the Entomo Professional Services team. 
Instead of showing you the columns in your saved report, this file 
shows all possible columns that could be used in the report. 
(Rarely does any company use all of the columns that are 
available.) In addition, the column names in the file will be the 
ones used to import data instead of the names that might have 
been customized for your company.   

  

3. In the Export To section, do one of the following, depending on 
where you want to save the file: 

o Desktop – Select this option to save the file in the format you 
selected, above, to a local or network drive; alternately, you can 
open the file without saving. 
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o FTP – Select this option to run a report in the background, then 
save the finished report to the Entomo FTP site, assuming that 
your company has access to the site. Typically, exports to the FTP 
site are automatically uploaded by whatever company-based 
system needs the information.  

Selecting this option allows you to navigate away or log off the 
system while the report is being generated. You can opt to be 
notified by email when the report is complete.  

o Email – Similar to the FTP option, the Email option allows you to 
run a report in the background and then email it to one or more 
recipients without requiring them to log into the system. This 
option is especially useful for generating large reports that will 
take more than a few seconds to run. 

 

4. In the Export Options section, click the Recipients icon.  

5. Select the checkbox for each recipient, then do one of the following: 

o Click Append to add your selection to the list of recipients already 
listed.  

o Click Replace to overwrite an existing list with your new 
selections.  
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6. If you need to add an external email address, enter the email address 
in the top (unnamed) field, then click the envelope icon to add the 
address to your selection list. Repeat this step as needed for 
additional addresses.  

 

7. Select the checkboxes for the recipients you want, then click OK to 
return to the previous page. SmartHub will generate the report and 
email it to the designated recipients.  

Printing a Report 

To print a report in SmartHub, you must first export it. For instructions, 
see Exporting Reports. 

Managing Reports 

The Reports page provides a list of your company’s reports. The page 
lists the reports that belong to you, your company, and the security 
groups that you belong to. You can open any of these reports. However, 
users with the Create Group or Company Level Report permissions can 
see the entire list of reports in the system and open any of them, 
regardless of ownership.  

The Reports page (Site Map > Administration > Reports) has the 
following fields, buttons, and tabs. 

Reports – Filters 

The Filters section has the following fields that you can use to narrow 
your data retrieval. Filters are cumulative.  

 Owner – Retrieve reports visible to a specific security group or user. 

 Owner Type – Retrieve reports according to type of owner—users, 
security groups, or the entire company. 

 Report Group – Retrieve the reports listed in a specific report group 

in your favorites pane . 
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 Report Favorites – Retrieve reports that belong to a specific set of 
favorites. 

 Report Company – Retrieve reports that belong to a specific 
company.  

Reports – Actions 

Some of the following actions are restricted to administrators.  

 Retrieve – Return a list of reports based on the parameters you set in 
Filters. 

 Delete – Delete the reports that you have selected (by clicking 
checkboxes).  

 Export – Export the list of reports.  

 Report Output – View a list of your most recently saved files that 
were created from a job template or the Create Output Types section 
of the Create a New Report dialog. (See Saving and Creating 
Reports.) You can open reports from links in the list.  

 Manage Report Groups – Open the Report Groups page, where you 

can see the organization of reports in your favorites pane  and 
export a list of your report groups. With the proper permissions, you 
can add/delete report groups.  

 Manage Report Favorites – Open the favorites page, where you can 
drill down to see a list of the reports in each of the configurations 
defined for the favorites pane on your system. (Most companies only 
create a single configuration for everyone to use, but individuals 
might also create their own.) With the proper permissions, you can 
add/delete/edit a configuration for a favorites pane. See Configuring 
a Favorites List. 

 Save Report – Open the Create a New Report dialog. For more 
information, see Saving and Creating Reports.  

Configuring a Favorites List 

1. From the home page, go to Site Map > Administration > Reports. 

2. In the action bar, click Manage Report Favorites to open the 
Favorites page.  

3. Do one of the following: 

o Edit an existing favorites configuration:  

a. Click Retrieve.  

b. Click the name of the favorites list that you want to edit. 

c. Modify the setting in the Favorites page as needed.  

o Create a new favorites configuration: 

a. Click New.  

SmartHub%2011.0%20Online%20Help.docx
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b. Enter a name and description in the ID and Description 
fields.  

c. In the Enabled field, select Yes for the list to be visible.  

d. In the Owner field, assign the configuration to a user or 
security group. 

4. The Favorites page lists the reports visible to the members of the 
security group you selected. Deselect a checkbox to remove that 
report from view by the members of the security group.  

5. When you are finished, click Save.  

You can toggle between favorites lists if you have permission to configure 
your home page. Go to Site Map > Administration > Home Page Config, 
click Retrieve, click <CompanyName> Homepage, then select the 
favorites list you want in the Favorites field.   

Adding a Report to Your Favorites Pane 

You can add reports to your favorites pane by clicking the Save Report 

button in a report. For more information, see Saving and Creating 
Reports.  

Chapter 9 | Home Page and Dashboard 

The home page is the page that opens first when you log in to SmartHub. 
With the proper permissions, the Home Page Config page allows you to 
format home pages and configure them to show different combinations of 
dashboards and favorites panes based on security group, user, or 
company.  

For information about navigating the home page, see Home Page 
Navigation.  

Create a New Home Page 

To create a new home page: 

1. From the home page, go to Site Map > Home Page Config. 

2. Click New to open the Home Page Details page.  
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3. In the ID field, enter a unique alpha-numeric ID as a label for the 
new home page.  

4. (Optional) In the Description field, click the Edit   icon to open a 
dialog where you can enter a description. When you’re finished, click 
OK.  

5. In the Home Enabled field, select Yes to allow the home page to be 
visible as soon as you save.  

6. In the Dashboard Alignment field, make a selection (for example, 
Top, Left, or Bottom) based on where you want the dashboard 
portion of the home page to appear. 

7. In the Owner field, select a security group, individual user, or 
company to determine who will be able to see the home page.  

The Module field is not editable. 

8. In the Dashboard Enabled field, select Yes to allow the dashboard 
that you select in the next field to be visible on the home page. If you 
select No, the dashboard will be hidden from all users.    

9. In the Dashboard field, select an existing dashboard to associate with 
the new home page you’re creating. See Creating a New Dashboard. 

10. In the Favorite field, select an existing favorites list to associate with 
the home page.  

For instructions about how to create a favorites list, see Configure a 
Favorites List. 

11. When you’re finished, click Save. 

12. To test the new home page, log out, then log in as a user or a member 
of the security group or company you associated with the new home 
page.  

Logic for Home Page Viewing 

Users see the home page (with its associated dashboard and favorites list) 
that is set-up and enabled for them either in the User Details page (Site 

Map > Administration > User Manager > User Details) or in the Home 
Page Details page (Site Map > Administration > Home Page Config > 

Module Homes) by their system administrator.  
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However, if a home page isn’t assigned by a system administrator when 
multiple home pages are available to a user, SmartHub will automatically 
select a home page for the user based on the following logic (in the 
following order): 

 If the user owns a home page, it is displayed; otherwise, the next rule 
is used. 

 If the user belongs to a security group that owns a home page, it is 
displayed. But if the security group owns multiple home pages, they 
are sorted according to the owner name (in descending order), then 
by the ID of the home page. The home page at the top of the sorted 
results is displayed; otherwise, the next rule is used. 

 If the user belongs to a company that owns a home page, it is 
displayed. 

The logic above applies to the automatic selection of a dashboard and 
favorites list. In your home page, you can choose to specify a dashboard 
and favorites list, or you can leave these fields blank. If blank, SmartHub 
will automatically select an appropriate dashboard and/or favorites list 
for you using the logic above.  

For information about how to create security groups with a favorites list, 
see Create a New Security Group.  

Change a User’s Home Page 

Usually, system administrators either set up home pages, dashboards, 
and favorites lists according to security group or they set up one for the 
entire company. It’s possible, however, with the proper permissions, to 
change the home page, dashboard, or favorites list for a specific user.  

To change what an individual user sees on their home page: 

1. From the home page, click Site Map > Administration > User 

Manager. 

2. Click the magnifying glass for the User filter to find the user’s name, 
then click Append.  

3. Click the link for the user’s name to open the User Details page.  

4. From the Home Page dropdown, select the home page that you want 
the user to see.  

5. Click Apply. 

This setting will override any other home pages associated with the 
security groups or companies to which the user belongs.  

Dashboard Configuration 

The SmartHub dashboard is a set of one or more charts on the home page 
that are based on favorite reports. With the proper permissions, you can 
create new charts, then assign ownership and permission to see the charts 
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to a specific user, to a security group, or to the entire company. For more 
information, see Home Page Navigation.  

Dashboard Config – Filters 

The Filters section has the following fields that you can use to narrow 
your data retrieval. Filters are cumulative. 

 Owner – Search for dashboard configurations associated with a 
specific security group or user. 

 Owner Type – Search for dashboard configurations based on whether 
the owner is a company, security group, or individual user.  

 Report Company – Search for dashboard configurations for a specific 
company; otherwise, click the blank option at the top to retrieve 
groups for all companies. 

Dashboard Config – Actions 

The following actions are available: 

 Retrieve – Return a list of dashboard configurations based on the 
parameters you set in Filters. 

 New – Open the Dashboard page, where you can create a new 
dashboard. 

 Delete – Delete the dashboard that you have selected (by clicking 
checkboxes).  

 Export – Export the list of dashboards.  

 Job Status – Check the status of the most recent export.  

 Create Dashboard Charts – Do not use. Instead, follow the procedure 
in Creating Charts and Graphs for the Dashboard. 

Creating a New Dashboard 

To add a new dashboard to the home page: 

1. From the home page, click Site Map > Administration > Dashboard 

Config. 

2. Select New to open the Dashboard page. 

3. In the ID field, enter a name for the dashboard (for example, 
“Accounting Dashboard”). 

4. In the Description field, describe the purpose of the new dashboard.  

5. In the Owner field, assign ownership of the dashboard to the entire 
company, a security group, or an individual. The owner selected for 
the dashboard should match the owner selected when creating a 
home page. For instructions about creating a home page, see Create a 
New Home Page. 
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6. In the Enabled field, select Yes or No. If you choose No, the 
dashboard will not be available to add to your home page. For 
instructions about adding a dashboard, see Adding a Dashboard to 
the Home Page. 

7. In the Width and Height fields, define the size of the chart in terms 
of pixels (for example, 900 pixels wide and 550 pixels high). The 
optimal selections for width and height will vary depending on your 
screen size and the number of charts you wish to display.  

8. In the # Rows and # Columns fields, choose the number of rows and 
columns you wish to display your charts in. For example, if you plan 
to add four charts to your home page, you might consider 2 rows 
and 2 columns, to format the charts in a 2x2 grid. 

9. In the Elements section, choose Add Line once for each chart you 
want to add. A new line will allow you to specify an analytics report 
to appear in the dashboard.  

a. (Optional) In the Description field, click the pencil icon to 
add a description of the report.  

b. In the Report field, select the report that you want to appear 
in the dashboard. 

c. The Width, Height, Column Idx, Row Idx, Column Span, 
and Row Span fields are not editable, but they will be 
computed when you save the page. These values are 
determined by the total width and height you’ve specified for 
the dashboard and the number of rows and columns 
specified.  

d. The Enabled option determines whether the chart will be 
used on the dashboard; by default when a line is added, it is 
enabled.  

10. When you are finished adding lines, click Save. 

The dashboard is now available to be added to your home page. See 
Adding a Dashboard to the Home Page. 

Restrictions and Interactions 

The following restrictions and interactions apply to the charted data: 

 The quantities to be charted are selected from the columns that are 
configured via the Configure Subtotal Columns menu item on the 
analytic page. 

 For a trend chart, the From and To filters on the analytic page 
determine the span of periods for which data is charted. 

 The Show Period Details UI checkbox on the analytic page controls 
whether or not a chart is a trend chart.  
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o Checkbox Selected – The chart is a trend chart. The labels on the 
x-axis of the chart are period names. The graph shows how the 
configured quantities vary over time.  

o Checkbox Not Selected – The chart is not a trend chart. It does 
not show how the values of the configured quantities vary over 
time. However, the data being charted may be constrained to fall 
in a specific time range by specifying From or To filter values, 
and/or Trans From or Trans To filter values (if the analytic page 
supports those). 

Adding a Dashboard to the Home Page 

After you create a new dashboard, you will need to add it to a home page 
before you can use it. If you don’t explicitly specify the dashboard in the 
home page, SmartHub will automatically choose one for you.  

1. From the home page, click Site Map > Administration > Home Page 

Config. 

2. Click Retrieve, then click the name of the home page that needs the 
dashboard.   

This opens the Home Page Details page.  

(To create a new home page, see Create a New Home Page.) 

3. In the Dashboard field, select the dashboard you want to use. This 
list is populated with those dashboards that have the same owner as 
the owner specified on your home page. If the field is blank, your 
company is not using dashboards. 

For an explanation of the logic behind what users see in their home 
page, see Logic for Home Page Viewing. 

4. In the Dashboard Enabled field, select Yes.  

5. When you’re finished, click Save. 

6. To see changes to the dashboard, do one of the following: 

o Log out and log in again. 

o From the home page, select Update Dashboard.  

Either action will prompt a job to run in the background. When the job is 
complete, the updated dashboard will be available. 

Adding a New Chart to the Dashboard 

To add a new chart to the home page through an existing dashboard: 

1. From the home page, click Site Map > Administration > Dashboard 

Config. 
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2. Click Retrieve. 

3. Click the link for the dashboard you want to edit. 

4. In the Dashboard page, go to the Elements section and do any of the 
following: 

o Click Add Line.  

o Select the checkbox of the chart you want to remove from the 
home page, then click Delete Line.  

o In the Report field, select the analytics report from which you 
want to generate the chart on your home page.  

5. When you’re finished, click Save.  

6. To see changes to the dashboard, do one of the following: 

o Log out and log in again. 

o From the home page, select Update Dashboard.  

Either action will prompt a job to run in the background. When the 
job is complete, the updated dashboard will be available. 

If you created a new dashboard, you need to first add the dashboard to 
your homepage. For instructions, see Adding a Dashboard to the Home 
Page. 

Creating Charts and Graphs for the Dashboard 

With the proper permissions, you can create charts and graphs for 
yourself and others in your security group that can be viewed from the 
home page. Note that these charts are separate from the charts you can 
create below individual reports.  

To create a new chart for the dashboard: 

1. Open the analytics report that you want to add to the dashboard as a 
chart. 

2. Set the filters and configure the table as needed to display the data 
you want in your chart. For more information, see Configuring 
Tables. 

3. (Optional) Click the Chart  icon to configure the chart. 

o Chart – Specifies the type of chart: 

o Bar – Groups of bars for each category 

o Bar by Period – Groups of bars by period and bars for each 
category 

o Line – Standard line graph that plots data points 

o Pie – Standard pie graph that segments the data set 
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o Stacked Bar - A bar for each category is given and each bar has a 
segment for each period 

o Stacked Bar by Period – A bar for each period with a segment for 
each category 

o Chart Width and Height – Manages the size of the chart in pixels 

o Chart Title Type – Use the default title or create your own custom 
title 

o Only Chart Totals – Shows no period data 

o Number of Values to Chart – Either one or many 

o Values to Chart – The data that will be charted 

o Max. Bars/Lines/Slices – Limits the amount of data displayed. 
The remaining values are summed to produce an “Others” 
bar/line/slice. 

o Min Pie Slice Percentage – Select the level at which data slice will 
be shown. All percentages below the minimum value will be 
aggregated into an “Other” slice. 

o Show Pie Slice Label – Show labels for slices or to use a legend 

4. Click OK when you finish configuring the chart. 

5. Click Save Report to save the updated report or to save a new report.  

The report is now available for selection when you configure your 
dashboard. See Adding a New Chart to the Dashboard. 

Favorite Reports Configuration 

For instructions, see Configure a Favorites List. 

Chapter 10 | Jobs and Events 

In SmartHub, jobs allow you to manage and manipulate your data, such 
as an analysis, resolution, export, or valuation. Jobs are usually pre-set in 
the Job Template page (Site Map > Administration > Job Template) by 
your Entomo Professional Services team for your company, but with the 
proper permissions, you can use the Job Template page to create a new 
one. See Run a Job and Create a Job.  Then, using the Event Template 

page, you can schedule one or more jobs to run at a specific time. For 
more information, see Events.  

Large jobs can run in the background so you can continue to navigate the 
system or log out of the system while a job runs.  

You can also perform a job on a specific record or set of records using the 
Analyze or Resolve buttons that are available on certain pages, 
depending on your permissions. Using these buttons allows you to run a 
job without leaving the page. These localized jobs affect only the records 
that are retrieved on that page based on the filters you set. For example, 
you might click Resolve to unmap a transaction of a specific distributor 
after updating a pattern map, then resolve it again. This action will affect 
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the selected transaction only, instead of all of the transactions for that 
distributor.   

An advantage of using the Analyze and Resolve buttons to run jobs is the 
ability to customize certain job options. For example, the Resolve button 
allows you to select specific rule templates and the option to unmap 
versus resolve. The Analyze button allows the option to select the type of 
evaluation for a POS job, and for inventory jobs, the option between price 
book and FIFO, and whether to set the adjusted end inventory.    

Job Template - Filters 

The Job Template page provides the following filter fields. Leave a field 
blank (or click the gray space at the top of the dropdown list) to retrieve 
jobs without that filter.  

 Type – Retrieve jobs according to type. The list for your company 
might vary: 

o CIM Analysis – Jobs that analyze channel incentive data (in the 
CIM module), such as ship and debit, and price protection. 

o CIM Reserves Analysis – Jobs that calculate reserves (the amount 
set aside to cover upcoming/outstanding claims) for CIM 
programs.  

o Claim Resolution – Jobs that resolve (or possibly unmap) claim 
data (related to CIM).  

o Export – Jobs that export report data by FTP or email, or by saving 
the data in the system. 

o Forecast – Jobs that hide previous forecast/backlog reports, 
remove them from inventory reconciliation, and move them to the 
next open period (not for resolution or analysis, which are 
handled by other job types). 

o G/L Analysis – Jobs that calculate values for journal 
entries/general ledger entries (GLM/RRM).  

o Integration Analysis – Jobs that calculate the number of files 
received versus expected for a specific period.  

o Inventory Reconciliation – Jobs that run analysis to reconcile 
inventory (reported versus calculated for POS, sponsor sales, etc.). 

o Inventory Resolution – Jobs that resolve (or possibly unmap) data 
for inventory. 

o Master Worker Jobs – Jobs that run multiple other jobs in a 
specific order, usually referred to as master templates. 

o POS Resolution – Jobs that resolve (or possibly unmap) data for 
POS. 

o Script – Jobs that have been created to process specific records. 
For example, a script job can be customized to apply a flag to 
identify POS records that that are not unique (submitted more 
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than once) based on distributor + invoice number + invoice line + 
quantity + serial number.   

o Shipment – Jobs that map shipment receipts to sponsor sales. 

o Unhide – This job changes hidden values in records from true to 
false. While records are hidden, other jobs don’t pay attention to 
them. For example, you can use the hidden flag for POS, 
inventory, and sponsor sales records so newly imported records 
don’t impact already running jobs, then unhide them for a future 
job.  

o Valuation – Jobs that associate cost or price to records, and value 
data (for example, RMA, POS, and inventory by using Sponsor 
Sale FIFO). 

o Blank – Leave this field blank (the gray space at the top of the 
dropdown list) to retrieve jobs regardless of type.  

 Category – Select System to retrieve jobs that are owned by the 
company in general or a security group. Select User to retrieve the 
jobs that are owned by a specific user. 

 Sponsor Company – This field is not editable. 

 Owner Company – If your system is set up with multiple companies, 
select a specific company to narrow your results.  

 Owner Type – Narrow your search to a company, security group, or 
user.  

 Owner – Search for jobs that are visible to a specific user or security 
group.  

 Job ID – Search for a specific job number.  

Job Template - Actions 

 Retrieve – Click to return all records that meet the parameters you set 
in Filters.  

 New – Click to open a page where you can create a new job.  

 Run – Click to run a job, first opening the Job Parameters page where 
you can select a period and/or partner company for the job. For 
instructions, see Run a Job. 

 Delete – Select the checkbox of a job you want to delete, then click 
this button.  

 Job Status – Click to open the Job History dialog, which lists the 
status of all jobs. You can stop any job that is in progress. For 
instructions, see Stop a Job.   

 Export – Click to export the list of retrieved jobs to a .csv, .xls, or .pdf 
file. For more information, see Exporting Reports. 
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 Save Report – Click to save your report as a .csv, .xls, or .pdf. For 
more information, see Saving and Creating Reports. 

Create a Job 

With the proper permissions, you can create new jobs via the Job 

Template page. The fields on the page differ depending on the type of 
you select. 

You can also create a job by cloning an existing one. See Clone an Existing 
Job. 

To create a new job: 

1. From the home page, go to Site Map > Administration > Job 

Template. 

2. In the Job Template page, click New. 

3. Complete the following fields: 

Field Name Action 

ID A name for the job is entered by default, but you can change it, as 
needed. 

Description (Optional) Click the pencil icon and enter a description in the 
dialog box. When you’re finished, click OK.  

Type Make a selection from the dropdown list. For a description of the 
types, see Job Template – Filters. 

Category Select System to create a job that is owned by the company in 
general or a security group.  

Select User to create a job owned by a specific user. 

Owner 
Company 

If multiple companies are available, select one from the 
dropdown list; otherwise, the default is not editable.  

Owner Type  Select Company, Security Group, or User as the owner of the job. 

Owner Group 
or Owner User 

The appearance of these fields depends on your selection in 
Owner Type. Select an owner, as needed. 

Script ID This field is not editable.  

If a script is associated with this job later, the ID will appear in this 
field. 

Java Class 
Name 

This field is auto-populated and is not editable.  

Is Native Java 
Code 

This field is auto-populated and is not editable. 

Comments (Optional) Click the pencil icon to open a dialog where you can 
enter a freeform comment about the job. When you’re finished, 
click OK.  

Alert Type This field becomes editable if you select Yes in the Is Alert 
Enabled field. 

Is Alert Enabled (Optional) Select Yes to enable the completion message for this 
job.  
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Field Name Action 

Alert Message (Optional) Click the file icon to open a dialog where you can enter 
a freeform message. Click OK when you’re finished.  

Alert 
Recipients 

(Optional) Click the file icon to open a dialog where you can 
manually enter email addresses or select existing SmartHub users 
who will be able to see the alert. When you’re finished, click OK.    
See Exporting Reports for instructions about how to use a similar 
dialog. 

 

4. Your selection in the Type field, above, determines the fields that 
appear in the Parameters section. In the Parameters section, enter 
and select the parameters needed for the job you’re creating. For 
definitions of the parameters, see Appendix A – Parameter 
Definitions.  

5. When you’re finished, click Save. 

The new job now appears in the Job Template page after you click 
Retrieve. For more information, see Run a Job. 

Edit a Job 

1. From the home page, go to Site Map > Administration > Job 

Template. 

2. In the Job Template page, do one of the following: 

o Use the fields in Filters to narrow your search, then click Retrieve. 

o Click Retrieve for the full list of jobs. 

3. In the ID column, click the name of the job that you want to change. 

4. Click Edit.  

5. Make changes, as needed. When you are finished, click Save.  

Clone an Existing Job 

Cloning provides an easy way to create a job based on an existing job.  

To create a new job by cloning an existing job: 

1. From the home page, go to Site Map > Administration > Job 

Template. 

2. In the Job Template page, do one of the following: 

o Use the fields in Filters to narrow your search, then click Retrieve. 

o Click Retrieve for the full list of jobs. 

3. In the ID column, click the linked name of the job you want to copy. 

4. In the Job Template > Job Template page, click Clone.  

5. The system provides a copy of the job with an auto-generated ID and 
editable fields. Make changes as needed. See the table in Create a Job 
for descriptions of the fields. Unless you change the value in the ID 
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field, the default value is used. When you’re finished making 
changes, click Save. 

The new job now appears in the Job Template page with the name that 
was in the ID field.   

Run a Job  

With the proper permissions, you can run jobs via the Job Template 

page. When you run a job from this page, the Job Parameters page opens 
so you can specify beginning and end periods for the job, as well as select 
the partner companies that will be affected. 

The selections you make in the Job Parameters page will overwrite the 
defaults for the template and for the filters in the report that is associated 
with the job template. 

When a job impacts the general ledger (G/L), all partner companies will 
be updated, even if you only specify one company in the setup.  

To run a job: 

1. From the home page, go to Site Map > Administration > Job 

Template. 

2. (Optional) In the Job Template page, use the fields in Filters to 
narrow your search; otherwise, skip to the next step.  

3. Click Retrieve. 

4. In the results, select the checkbox of the job you want, then click Run.   
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5. Make changes to the Job Parameters dialog according to the 
instructions in the following table:  

See the note following this table. 

Field Name Action Comment 

Begin Period/ End 
Period 

Specify the accounting periods you 
want for the job. 

 

Partner Company 
ID/Name 

(Optional) Add one or more 
partner/distributors to the job by 
entering their name or ID, or select 
a name from a list using the 

magnifying glass icon .  

If the job affects the G/L, all 
partners/distributors will be 
updated, not just the ones 
you select here.  

Create Audit Logs You might have the ability to 
generate logs, such as FIFO, during 
certain analyses. Select Yes if you 
want to generate these logs. Select 
No if you do not want to generate 
them. 

Leave this field blank to use 
the setting from the job 
template.  

Selecting Yes can potentially 
increase job run times.  

Send Completion 
Alert 

Checked by default, this option will 
send an email to you when the job 
is finished. 

You can see the status of a 
job any time in the Job 
History page.  

Sequential Checked by default, this option will 
run any selected job templates in 
sequential order.  

Generally, you will want to 
leave this option selected. 
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Field Name Action Comment 

Job Options Use the following options to 
configure when the job will run: 

 Run (Always run job) – The job 
will start immediately after you 
click OK. 

 Next (Queue job after last 
currently running instance) – 
This job will run after any 
currently queued jobs of the 
same job type. 

 Last (Queue job after last 
currently running job) – This job 
will run after all other currently 
queued and running jobs are 
complete, including import jobs. 

 Skip (Skip job if already 
running) – If a currently running 
job is the same job type as the 
one you are attempting to set 
up, this new job will be 
canceled. 

 

NOTE: Non-blank values on the Job Parameters page always 
override the values in a master template, job template, or saved 
report. In general, the system looks for values in this order: 

1. Job Parameters page 

2. Master Worker Job Template page 

3. Job Template page 

4. A saved report 

A value in a saved report is used only if that field is blank in all of the 
pages above it. Additionally, values in the Job Parameters page, 
master template, and job template can’t change a value in a saved 
report to blank. For example, if a saved report specifies the Partner 

Company ID as “ABC,” it is not possible to override “ABC” by 
making the Partner Company ID field blank in any of the higher 
levels. Thus, it’s best to leave a field blank in a saved report and to 
specify it instead in its Job Template page. 

6. When you are finished, click Save.  

An alert message will let you know when a job is running in the 
background. When the job is complete, you will receive an alert or email 
if you set up the job to produce one. Otherwise, you can check the status 
of the job in the Job History page. For more information, see Job Status.  

Job Status 

The Job History page displays the status of all jobs. You can search for 
specific jobs and export your search results.  
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To check the status of a job: 

1. From the home page, go to Site Map > Audit Trail > Job History.  

(You can also open this page via Site Map > Administration > Job 

Template > Job Status.) 

2. Do one of the following: 

o Use the fields in Filters to search for a specific job, job type, or 
date range, then click Retrieve. See Job History – Filters for 
descriptions of the filters.   

o Click Retrieve for the full list of jobs then locate the job you’re 
looking for. 

3. With the proper permissions, you can click the link in the Status 
column to open a dialog where you can see the following list of 
information generated by the job: 

Column Definition 

Log Time The time that the log was generated. 

Severity The severity associated with the log.  

 INFO – Informational. For example, a resolution job might create 
a message with an attachment that tracks how the system 
debugged the job.   

 WARNING – Information about results that were allowed but 
generally unexpected. You need to determine whether the results 
are an issue for your situation. 

 ERROR – Information about a job failure. You need to either fix 
the error or report it to your Entomo Professional Services team.  

Module The type of data affected by the job. (Usually, this is the same module 
that is associated with the job.) 

User The user who ran the job. 

Job The current job. This column is blank when the page is viewed from 
the Job History page, but will be populated with the job ID if viewed 
from Site Map > Audit Trail > Module Logs. 

Event This field is not currently used. 

Company The company associated with the job. 

Message A message associated with the log. 

Attachment The physical log file with additional details. (Some jobs generate a 
message without an attachment.)  

Retrieve Click to refresh the list.  

If this page is accessed via the Site Map menu, filters are applied, and 
Retrieve must be clicked to view the logs.  

For more information, see Event History – Actions. 

Stop a Job 

With the proper permissions, you can stop a job that is currently running.  

Jobs that have been stopped cannot be restarted or resumed.  

To stop an active job, do the following: 

1. From the home page, go to Site Map > Audit Trail > Job Queue. 
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(You can also stop a job via the Job History or Job Template pages.) 

2. Do one of the following: 

o Use the fields in Filters to search for the job you want to stop, then 
click Retrieve. See Job History – Filters for descriptions of the 
filters. 

o Click Retrieve for the full list of jobs, then locate the job you want 
to stop. 

3. Select the checkbox of the job you want to stop.  

4. Click the Stop button.   

Sometime jobs can stop immediately, but other jobs might need extra 
time to finish a process before they can stop. Some jobs can’t be stopped.  

Job Queue 

Once you have initiated a job, you can view jobs that are running and 
queued through Site Map > Audit Trail > Job Queue. 

Job Queue – Filters 

 From/To – Enter or select dates for the data you would like to 
retrieve. Usually this filter will be left blank. 

 Type – Use the magnifying glass icon  to select the type of job that 
you would like to retrieve, such as Valuation or POS Resolution.  

 Run Status – By default, this filter is set to Ready/Running, which 
will show those jobs that are currently running or queued to run. 
Selecting Completed will retrieve jobs that have already finished but 
are still being managed via the Job Manager page. Completed jobs 
are best viewed in the Job History page. 

 Process State – Jobs that have already completed will have a process 
state of Shutdown. Jobs that are currently running will have a process 
state of Running. Jobs that are waiting in queue will have a process 
state of Ready. Additional options are available, but will rarely be 
used. This filter will typically be left blank. 

 Status – Retrieve results based on the current status of the job, such as 
In Progress, Success, or Initialized. This filter will typically be left 
blank. 

Job Queue – Actions 

 Retrieve – Click to return a list of jobs based on your filter selections. 

 Export – Click to export the retrieved data. 

 Save Report – Click to open the Create a New Report dialog. For 
more information, see Saving and Creating Reports. 
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 Start – Click to start a job that is on hold. Jobs are placed on hold if 
they are waiting to be run when the server is restarted. 

 Stop – Click to stop the selected job. 

 Clear Waiting – The Waiting for ID column shows a value when a 
job is waiting for another job to finish. If a job is waiting for another 
job that no longer exists or is not running, select the job and click 
Clear Waiting to clear the Waiting for ID and allow the job to start. 

Job History 

To view past jobs or currently running jobs, job history can be accessed 
through Site Map > Audit Trail > Job History. 

Job History – Filter Bar 

 From/To – Enter or select dates to specify the time period for which 
you would like to retrieve data. 

 Status - Retrieve results based on the current status of the job, such as 
In Progress or Success. 

 Type - Use the magnifying glass icon  to select the type of job that 
you would like to retrieve, such as Valuation or POS Resolution. 

 State - Jobs that have already completed will have a process state of 
Shutdown. Jobs that are currently running will have a process state of 
Running. Additional options are available, but will rarely be used. 
This filter will typically be left blank. 

 Description – This is a text field where you can search for jobs based 
on their description, which is set up when the job template is created. 

Job History – Actions 

 Retrieve – Click to return a list of jobs based on your filter selections. 

 Export – Click to export the retrieved data. 

 Save Report – Click to open the Create a New Report dialog. For 
more information, see Saving and Creating Reports. 

 Start – Click to start a job that is on hold. Jobs are placed on hold if 
they are waiting to be run when the server is restarted. 

 Stop – Click to stop the selected job. 

Events 

An event is a trigger that automatically sets off a process or report 
according to a schedule or interval. Your Entomo Professional Services 
team uses the Event Template page to schedule your jobs.  

Event Template – Filters 
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 Type – Search for a specific event type: 

 Delay – A process or report that is run at intervals from a specific 
start time. The interval can be in days, hours, minutes, or seconds.  

 File – A process or report that is run when a file is created on the 
SmartHub server. 

 Import – A process or report that is run whenever a file of a specified 
type (for example, POS) is imported. 

 Mail – This feature is not currently supported. 

 Timer – A process or report that is run at a specific time (month, day, 
day of the week, and/or time of the day [hour, minute, and second]). 
For example, you can set an event to trigger a resolution job every 
Friday at 5 p.m. If an event is set to run on a specific day of the week, 
it will be run at midnight unless otherwise specified. 

 Job Type – Search for events related to specific types of jobs.  

 Owner – Search for events owned by a specific user.  

 Sponsor Company – This field is not editable. 

Event Template – Actions 

 Retrieve – Click to return all events that meet the parameters you set 
in Filters.  

 New – Click to open a page where you can create a new event. See 
Create an Event. 

 Arm Event – Select the checkboxes of the events that you want to 
activate, then click this button. After you define an event, it won’t run 
until it is armed.  

 Disarm Event – Select the checkboxes of the events that you want to 
deactivate, then click this button. Disarmed events can be armed 
again by clicking Arm Event.   

 Fire Events – Select the checkboxes of the events that you want to run 
immediately, without regard for any other settings. Running a job by 
clicking this button is no different than just running the job, except 
that clicking this button will restart a delayed event/job. 

 Delete – Select the checkbox of an event you want to delete, then click 
this button.  

 Export – Click to export the list of retrieved events to a .csv, .xls or 
.pdf file. For more information, see Exporting Reports. 

 Timer Events – Click to open a list of timer events or create a new 
one. This view has slightly different columns than the view you get 
when you filter for timer events.   
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 Delay Events – Click to open a list of delay events or create a new 
one. This view has slightly different columns than the view you get 
when you filter for delay events.   

 File Events – Click to open a list of file events or create a new one. 
This view has slightly different columns than the view you get when 
you filter for file events.  

 Import Events – Click to open a list of import events or create a new 
one. This view has slightly different columns than the view you get 
when you filter for import events.  

 Save Report – Click to save your report as a .csv, .xls, or .pdf. For 
more information, see Saving and Creating Reports. 

Create an Event 

To create an event: 

1. From the home page, go to Site Map > Administration > Event 

Template. 

2. Click New.  

3. Make a selection in the Type field to begin defining the new event. 
 

Field Names Action 

Event Template  

ID Enter a unique identifier for the event. If you make no changes, the 
system will use the auto-generated ID. 

Description (Optional) Click the pencil icon and enter a description. When 
you’re finished, click OK to close the dialog box.  

Armed Select Yes to run the event as soon as it is created. If you select No, 
you can run the event any time by clicking the Arm Event button on 
the main Event Template page. 

Type Make a selection from the dropdown list. For a description of the 
types, see Event Template – Filters. 

Sync Type Select one of the following: 

 Always Run Event – The job is run regardless of other events or 
jobs.  

 Queue Event After Last Running – The job will begin after the 
last queued job. 

 Queue Event If Already Running – If a job of the same type is 
already running, this job will begin after that job. 

 Skip Event If Already Running – This job will not be run if a job of 
the same type is already queued or running. This option is 
especially helpful when you want run a job frequently but you 
don't want to break anything if the job runs longer than the 
event frequency. 
For example, suppose you have a job that unhides transactions 
every 5 minutes. You can select Skip Event in case an unhide job 
is currently running. This way, if the active job takes more than 5 
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Field Names Action 

minutes to run, you don't accidentally create an ever-
lengthening job queue of unhide jobs.  

Job Template Select a job to run. Your selection in the Owner User field 
determines the list in this field.  

Comments (Optional) Click the pencil icon to open a dialog where you can 
enter a freeform comment about the event. When you’re finished, 
click OK to close the dialog box.  

Alert Type Select the type of completion message that you want this event to 
generate: an email, pop-up message, or log file. 

Alert Enabled Select Yes to have an alert message sent when this event begins. 
(Completion alerts are enabled in the Job Template page.) 

Alert Message Click the file icon to open a dialog where you can enter a freeform 
message. Click OK when you’re finished.  

Alert Recipients Click the file icon to open a dialog where you can enter freeform 
email addresses. When you’re finished, click OK to close the dialog 
box.    

Last Occurrence This field displays the date that this event last occurred.  

Disable on 
Occurrence 

Set to Yes to have the event disarm itself after it runs. It will only 
run once unless you re-arm it.  

Owner User Select an owner from the list. The selection here determines the list 
of jobs available in the Job Template field.  

Delay Information The start time and at least one timer field is required 

Start Time Enter the date that you want the delay timer to begin. Format the 
date as month/day/two-digit year. 

Number of Days Enter a number from 1 to 365 to designate the number of days 
after the start time that you want the job to run.  

Number of Hours Enter a number from 1 to 23 to designate the number of hours after 
the start time that you want the job to run.  

Number of Minutes Enter a number from 1 to 60 to designate the number of minutes 
after the start time that you want the job to run.  

Number of Seconds Enter a number from 0 to 60 to designate the number of seconds 
after the start time that you want the job to run.  

File Information Both fields are required 

File Name Enter a name for the trigger file. 

Directory Enter the directory path where the system will look for the trigger 
file.  

Timer Information At least one timer field is required 

Month of Year Enter a number from 1 to 12 to designate the month when this 
event will occur, with 1 meaning January and 12 meaning 
December. 

Day of Month Enter a number from 1 to 31 to designate a specific day of the 
month when this event will occur.  
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Field Names Action 

Day of Week Enter a number from 1 to 7 to designate the day of the week when 
this event will occur, with 1 meaning Sunday and 7 meaning 
Saturday.  

Hour Enter a number from 0 to 23 to designate the hour this event will 
occur, with 0 meaning 12 a.m. (midnight) and 23 meaning 11 p.m. 

Minute Enter a number from 0 to 60 to designate the minute this event will 
occur.  

Second Enter a number from 1 to 60 to designate the second this event will 
occur.  

Import Information  

Model Type Select the type of imported record that will trigger this event.  

 

4. When you are finished, click Save.  

Event Queue 

A list of queued events is available at Site Map > Audit Trail > Event 

Queue.  

Event Queue – Filters 

 Type – Select an event type to narrow the search to events that match 
the specified type. 

 Owner – Select an owner to narrow the search to events owned by 
that user. 

 Job Type – Select a job type to narrow the search to jobs that match. 

 Sponsor Company – If your system is set up with multiple 
companies, you can narrow the search to a single company; 
otherwise, this field is not editable.  

Event Queue – Actions 

 Retrieve – Click to return a list of events based on your filter 
selections. 

 New – Click to create a new event. See Create an Event. 

 Events – The Timer, Delay, Files, and Import event buttons work the 
same as the filters.  

 Export – Click to export the retrieved data. 

 Arm Events – Select the checkboxes of the events that you want to 
activate, then click this button.  

 Disarm Events – Select the checkboxes of the events that you want to 
deactivate, then click this button. Disarmed events can be armed 
again by clicking Arm Event. 
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 Fire Events – Select the checkboxes of the events that you want to run 
immediately, then click this button.  

Event History 

A list of past events is available at Site Map > Audit Trail > Event 

History.  

Event History – Filters 

 From/To – Enter or select the dates of interest. 

 Type – Select from available choices to retrieve only events that match 
the specified type. 

Event History – Actions 

 Retrieve – Click to return a list of events based on your filter 
selections. 

 Export – Click to export the retrieved data. 

Chapter 11 | Data Interaction 

SmartHub receives and processes periodic (daily, weekly, monthly, etc.) 
transactional data from you and your partners worldwide. This reported 
data is usually in files in a variety of formats, containing numerous data 
types. Besides the transactional data that is integrated into SmartHub, 
complete analyzed data is also sent from SmartHub to your systems 
(ERP, CRM, etc.). 

All of your data, regardless of the source, can be transmitted periodically 
or on-demand via EDI, email, or FTP, and is accepted either as a flat file 
(.csv or .txt) or as an Excel spreadsheet.  

Data Types 

SmartHub collects two main types of data: data from you (master and 
transactional) and data from your reporting partners (usually only 
transactional). 

Master Data 

Master data is the non-transactional data that comes from your company. 
SmartHub uses master data to process and enrich your company’s 
transactional data and reporting processes. Master data is usually 
imported from your company systems, but it can also be provided by 
your partners.  

Master data includes (but is not required or limited to): 

 Customer Master – A complete list of all customers (distributors, 
contract manufacturers, resellers, dealers, original equipment 
manufacturers [OEMs], operators, end customers) and their 
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attributes, such as address, contact information, industry, and partner 
type/level. 

 Product (Item) Master – A complete list of your products and their 
hierarchy/attributes. 

 Distributor Price Books – A list price of all of your products, 
including relevant parameters, such as distributor, region, etc. 

 Incentive Authorizations – A list of pre-existing and externally 
managed incentive and commission programs, with the details and 
parameters required for validating and enforcing them. 

 Chart of Accounts – A list of the accounts in your general ledger. 

 Mapping Rules – A set of rules that match the data reported from 
your partners (such as items and customers) to the data in the master 
lists. For example, if a partner reports an item number that doesn’t 
directly match your item master, a mapping can be provided to link 
the reported value with the official record. 

Your Transactional Data  

SmartHub can use the following transactional data from your company: 

 Sponsor Sales – Your transactional invoice data, such as sales from 
you to your distribution partners (such as distributors and resellers).  

 Sell-In POS – Your transactional data from your direct sales (not 
through distributors) to end customers.  

 Backlogged Transactions – Sponsor sale (invoice) data for products 
not yet shipped. 

 Return Merchandise Authorizations (RMAs) – Data about returned 
products that result in refunds.  

When data needs to be corrected or updated, it is generally corrected or 
appended in your internal system, then resubmitted to SmartHub via 
your usual method. With the proper permissions, records that contain 
erroneous data can also be exported from SmartHub, then corrected and 
reimported. 

Partner Data 

Master data for partner data is rare, but possible when mapping rules are 
needed for partner-specific data. For more information, contact your 
Entomo Professional Sales team.  

Partner data usually involves the following transactional data: 

 Point of Sale (POS) – Data about sales made by distributors to end 
customers, including information about OEMs. 

 Inventory – Data about stock on hand for all distributors and OEMs. 
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 Shipment Receipts – Data about shipments from your company. 

 Forecasts – Data about projected sales by distributors to end 
customers. 

 Incentive Claims – Data about incentive programs, royalty 
agreements, and sales credit assignments.  

SmartHub tracks imported files, including the date, time, status, and 
statistics for each file. The Integration History page allows you to review 
the status of imported files and access the raw data. For more 
information, see Integration History. 

Correcting Partner Data 

When partner data contains errors, the correction process depends on 
whether your company uses SmartHub’s pullback capabilities, which 
automatically replace duplicate transactions with corrected transactions.  

To make corrections: 

 With Pullbacks  

o Omitted transactions: 

a. Submit the missing transactions using your usual method and 
format. 

b. Submit a complete, corrected file using your usual method and 
format.  

o Incorrect transactions: 

a. Submit the corrected erroneous transactions. 

b. Submit a new, complete and corrected report using your usual 
method and format. 

 Without Pullbacks 

o Omitted transactions: 

a. Submit the missing transactions using your usual method and 
format. 

b. Submit a new file with corrections, then notify your customer 
service team so the previously submitted (erroneous) file can be 
removed from the system.  

o Incorrect transactions: 

a. Export erroneous transactions from system, update/correct the 
appropriate fields without changing the Transaction ID, then re-
import the transactions to update the corrected fields. 

b. Submit a new file with corrections, then notify your customer 
service team so the previously submitted (erroneous) file can be 
removed from the system. 
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Data Flow 

The following diagram shows how SmartHub processes the data feeds 
from distributors and manufacturers.  

 

In general, distributor data is processed as follows: 

1. SmartHub performs the following automated processes on the files 
submitted by your partners: 

o Standardize date formats and field names. 

o Check for missing required fields. 

o Remove extraneous data and enrich data. 

o Flag duplicate file submissions. 

2. After the files have been error-checked and normalized to a standard 
format, the rule templates and resolution process are completed. This 
step is customized to codify your specific business rules, but usually 
we: 

o Resolve sponsor items and any item attributes or hierarchy using 
the item master and pattern maps. 

o Resolve country using the country master and pattern maps. 

o Resolve territory and region based on territory master and pattern 
maps. 

o Enrich any custom attributes after running all resolution rules. 

o Resolve customer information.  

Expected Data Configuration  

The Expected Data Config page provides an overview of the type, size, 
and date of all the imported data expected from your 
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partners/distributors. With the proper permissions, you can define the 
parameters of (or configure) a new import, clone a new configuration 
from an existing one, and edit an existing configuration.  

For each import that you expect from a partner/distributor, you can 
configure the following information: 

 The number and type of files expected from each partner 

 The recipients of email alerts about missing files, late arrivals, and 
files with errors  

 The timing of files considered missing or late, and when to send 
reminders 

SmartHub uses this import configuration to automatically generate 
emails/reminders about missing, late, and erroneous files, and generate 
statistics about partner submissions via the Integration Analysis page.   

Expected Data Config – Filters 

 Imported From/To – Enter or select dates to retrieve records within 
that range. 

 Company – Search for, or enter, the name of a company to narrow 
your search. 

 Model Type – Select from the search dialog to narrow your search to 
a specific type of information.  

Expected Data Config – Actions 

 Retrieve – Return a list of configurations based on your filter 
selections. 

 New – Create a new import configuration. See Create a New Import 
Configuration. 

 Delete – Delete selected records.  

 Export – Export the data in the results table to a .csv file, Excel 
spreadsheet, or PDF. 

Create a New Import Configuration 

To configure an imported file to generate emails: 

1. From the home page go to Site Map > Administration > Expected 

Data Config. 

2. Click New. 

3. Complete the following fields as needed.  

Field Name Action 

Company ID Make a selection in the Company Name field to automatically populate 
this field with the unique identifier for the partner/distributor you 
select.  
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Field Name Action 

Company Name Enter the name of the partner/distributor. 

Model Type ID Select the type of information that will be imported. 

Model Subtype ID If you need to refine the model type, enter a description.  

File Name Pattern Enter the naming convention for the imported file, such as “*.xlsx” 
(without quotation marks) for an Excel spreadsheet.  

Period Type ID Select the accounting period expected to be used in the imported file. 

File Data Count Enter the number of records expected in the imported file.  

Effective Date Select the date the first import is expected. This setting and the Period 
Type ID determine when import files are expected to be imported. The 
period starts at midnight.  

Enabled Select Yes to allow the import to begin immediately. If you select No, 
you can change it to Yes when you want imports to begin.  

Automatic Review Select Yes to automatically apply the conditions and restraints you set 
up on this page as soon as an imported file is received; otherwise, 
select No to manage the process manually.  

Alert Timely Error 
Imports 

Select Yes to send an email whenever an imported file is received on 
time for the accounting period, but with one or more errors.  

Alert Late Imports Select Yes to send an email whenever an imported file is received, but it 
is late for the accounting period.   

Remind to Submit 
Imports 

Select Yes to send an email whenever the number of imported files is 
less than expected for the accounting period, but the deadline for the 
import is still in the future.   

Alert Missing 
Imports 

Select Yes to send an email whenever the number of imported files is 
less than expected for the accounting period, and the deadline for the 
import has passed.   

…Recipients (4 
fields) 

Enter a comma-separated list of email addresses for the people who 
will receive the notifications about late, missing, and erroneous files.  

Min Cutoff Offset Enter the number of hours past midnight (of the accounting 
period start) when an arriving import file starts to be considered 
part of that period.  

Late Import Alert 
Offset 

Enter the number of hours past midnight (of the accounting period 
start) when an arriving import files starts to be considered as late.  

Submit Import 
Reminder Offset 

Enter a comma-separated list of numbers as the hours (past midnight) 
that reminders emails are sent if files are late. 

Missing Import 
Alert Offset 

Enter a comma-separated list of numbers as the hours (past midnight) 
that reminders emails are sent if files are missing. 

Use File Arrival 
Date 

Select Yes to use the date that the file was actually received, rather 
than the original date, which is when it should have been received.  

Original Import 
Date 

(Read-only) The date that the file should have been received, as 
recorded in the Expected Data Config page.  

Original Import 
File Name 

(Read-only) The name of the file after import, as recorded in the 
Expected Data Config page. 

Original Raw File 
Name 

(Read-only) The file name assigned by the submitter, as recorded in the 
Expected Data Config page. 

Original Import 
File ID 

(Read-only) The unique identifier assigned by the submitter, as 
recorded in the Expected Data Config page. 
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4. When you’re finished, click Save.  

For more information about reviewing the imports and emailed 
reminders, see Integration Analytics. The analyzer can be set up as a job 
and scheduled to run automatically, as needed. 

For information about stopping emails for a period of time, see About 
Notifications.  

Edit or Clone an Import Configuration 

To change/update an import configuration: 

1. From the home page go to Site Map > Administration > Expected 

Data Config. 

2. (Optional) Narrow your search by entering values in the Filters 
fields.  

3. Click Retrieve. 

4. Click the link in the ID or Description columns to open the detail 
page for an import configuration.    

5. Do one of the following: 

a. Click Edit to change the page to edit mode. Make changes as 
needed, then click Save. 

b. Click Clone to duplicate the page. Make changes as needed, then 
click Save.  

Chapter 12 | Audit Trail 

In SmartHub, you can audit imported data using the following pages: 

 Integration History 

 Integration Analytics 

 Analyzed Imports 

 Module Log 

 User Sessions 

 User Session Analytics 

 About Notifications 

Integration History 

The Integ. History page allows you view all of the files imported into 
SmartHub, including master data and raw files submitted by your 
partners/distributors. You can use the page to review those files for 
errors/warnings that might have occurred during import.  

The following filters and action buttons are standard, but you might see 
other options customized for your company.   
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For instructions about how to fix import errors, see Review Import 
Activity.  

Integ. History – Filters 

 From/To – Search for records based on start date of the import.  

 Record Dates – Search for imports that contain records with 
transaction dates within a specified date range. The dates of some 
retrieved records might fall outside this range, but the transaction 
dates you request will be there as well. 

 File Arrival Time – Search for records based on the time they were 
submitted to SmartHub.  

 Model – Search for a specific type of record. 

 Company – Search by name for a specific company or set of 
companies. 

 Company ID – Search by ID for one or more companies. 

 Attention – Search for records based on whether they have been 
marked during import as containing errors/warnings or have been 
manually flagged as needing attention (by a person with the 
appropriate permissions).  

 Yes – Retrieve records that contain errors or warnings. 

 No – Retrieve only records that are not flagged (as needing attention). 

 Blank – Retrieve records regardless of the flag status. 

 Reviewed – Search for records based on their review status:  

o None – Records start without a review status.  

o Manual – Records can be marked a manually reviewed by a 
person with the appropriate permissions.  

o Cleared – Status can be cleared by a person with the appropriate 
permissions.  

o Automatic – Records can be marked as automatically reviewed by 
the import analysis if they are recognized as an expected import 
and the Expected Data Config is set up to automatically mark 
imports. 

 Display – Show retrieved records as a chart, table, or both.  

Integ. History – Actions 

 Retrieve – Return a list of files based on the parameters you set in 
Filters. 

 Save – Save the changes you make to retrieved records, such as 
updated comments. 
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 Delete Data and History – With proper permissions, delete selected 
records from the import history, including all associated data. 

 Export – Export the retrieved data. 

 Analyze – Run the import analysis and optionally sends email alerts 
about the status of the retrieved files. For more information, see 
About Notifications.  

 Job Status – Open the Job History page as a dialog so you refer to the 
list of jobs while staying in the Integ. History page.   

 Clear Analysis – Clear the analysis for selected items.  

 Close for Notify – Specify a date or accounting period as the starting 
point for sending email notifications.  

 Set Reviewed – Mark selected records as reviewed. 

 Clear Reviewed – Mark selected records as cleared after a review.  

 Import – Open the Import Wizard page, where you can perform a 
manual import. 

 Save Report – Open the Create a New Report dialog. For more 
information, see Saving and Creating Reports. 

 Draw – Redraw a table or chart without retrieving new data. 

Import Data Manually 

Although most imports jobs are automated for you by your Entomo 
Professional Services team, with the proper permissions you can 
manually import files if needed.  

To import a file: 

1. Do one of the following: 

o From the home page, go to Site Map > Audit Trail > Integ. 
History, then click Import. (This option returns you to the Integ. 

History page when the import is complete.) 

o From the home page, go to Site Map > Administration > Import.  

(This option returns you to the home page when the import is 
complete. You’ll have to navigate to the Integ. History page to 
follow-up on the import. ) 

2. The Model Type field will be auto-populated, if possible, after you 
select a file.  

3. In the Data Format field, select the type of file you will be importing.  

4. In the Delimiter field, select the character that will separate each data 
item in the import.  
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5. In the Quote Character field, select the character that surrounds a 
data value if that value contains the delimiter character that you set in 
the Delimiter field.  

For example, if you select commas as your delimiter, any time a 
comma is used in an imported data field, that data field must be 
enclosed by the character specified here as the quote character.   

6. Click Browse, then navigate to the file you want to import.  

7. Click Upload.  

The Stage field will change automatically with the current status of 
the import operation.  

8. When the status turns to Upload Complete, three buttons appear in 
the Import Action line. Click one of the following: 

o Click Single-Stage Import to parse, validate, and commit 
individual records one-by-one. Validated records are 
automatically committed, while records that do not pass 
validation are rejected. This option requires you to stay on the 
page until the import finished.  

o Click Multi-Stage Import to parse the entire file (click Parse), then 
validate the entire file (click Validate), the commit the entire file 
(click Commit). Data is broken into columns based on the 
delimiter you select.  

This option is useful if you want to ensure that the entire file 
passes validation before committing anything. This option 
requires you to stay on the page until the import is finished.  

o Click Background Import Job to import the file as you continue to 
work in SmartHub.  

The Import Stage Status Summary section of the page opens when 
the import is complete, showing the errors (rejected lines and 
warnings) that might have occurred during import. 

9. Click Done to return to the Integ. History page, where you can see 
the data about the import.  

o The Status column provides the overall status of the imported file.  

o Click the status to view a list of errors with line numbers, which 
are sometimes listed as a range of lines for a single error.  

o If any part of the import failed, you can click in the Reject File 
column to open a file that contains the failed lines so you can 
correct and reimport them.    

Review Import Activity 

In SmartHub, the import process is referred to as integration. The 
Integration History page allows you to check import files for errors and 
ensure that data from your distributors/partners was imported 
successfully.  
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To review recent import activity: 

1. From the home page, go to Site Map > Audit Trail > Integ. History. 

2. In the From and To fields, select a date or define a date range. For 
example, enter “–30 days” in the From field to retrieve imports that 
occurred during the last thirty days. 

3. Click Retrieve. 

4. In the results, you can do any of the following: 
 

Goal Action Comments 

View details about a 
file with warnings or 
errors 

Click the Status link to see a list of errors 
with line numbers. 

You can use this information to 
further investigate exact lines the 
import file or raw file. 

View details about 
an aborted import 

Click the Abort link in the Status column 
to open a dialog that provides a reason 
for the import failure. 

 

Add comments 
about your 
review/investigation 

For the line you reviewed, click the pencil 
icon in the Comments column (on the far 
right of the Integ. History page) to open a 
dialog where you can add freeform 
comments. When you are finished, click 
Save. 

 

Mark files as 
reviewed 

Select the checkbox for the file, then click 
Set Reviewed.  

By tagging files as reviewed, you 
can search for files that haven’t 
been reviewed using the Reviewed 
filter.  

Set System-Wide Import Analysis Notifications 

From the Integ. History page, you can set a system-wide begin date or 
period for email notifications to be sent by SmartHub in response to 
imported data. 

The following types of emails can be sent: 

 Submit import reminder 

 Missing import alert 

 Timely error import alert  

 Late import alert 

To set a date or period for import notifications: 

1. From the home page, go to Site Map > Audit Trail > Integ. History. 

2. Click Close for Notify. 

3. In the Close for Notification dialog, use the fields to define the 
beginning date or period to send emails. No emails will be sent prior 
to this begin date, despite the dates set for individual imports.  

4. Click OK.  
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Run a Manual Import Analysis 

Usually, integration (import) analysis jobs are set up by your Entomo 
Professional Services team to be run automatically based on the timing of 
the imports from your partners/distributors. However, you can also run 
a manual analysis any time, as needed. When you run a manual analysis, 
you can choose whether to also send out emails in response to missing 
and late files. 

The results of a manual analysis can be retrieved in the Integ. Analytics 

page.  

To run a manual import analysis: 

1. From the home page, go to Site Map > Audit Trail > Integ. History. 

2. Use the filters to locate one or more imports that you want to 
analyze, then click Retrieve.  

3. Click Analyze.  

4. In the Set Analyze Options dialog, select one or more of the 
following options depending on whether, and how, you want to 
send email notifications based on this analysis:  

o Run as Job – Run the analysis as a background job on all import 
records that match the filters, regardless of which records are 
selected in the retrieved results. When this option is not set, the 
analysis is only run on the records that are retrieved and selected. 
This option is independent of the email options above it. 

o Submit Import Reminder – Send reminders to 
distributors/partners to submit their files.  

o Missing Import Alert – Send emails if expected files have not 
been received. 

o Timely Error Import Alert – Send emails if files are submitted on 
time, but imported with errors or warnings. 

o Late Import Alert – Send emails for expected files received after 
the specified date. 

5. Click OK. 

Delete an Imported File 

If a file contains errors, it’s possible to delete the file so it can be fixed and 
resubmitted, but the dependencies need to be deleted first. Deleting a 
problematic file can help you avoid having to do a pullback.  

To delete an imported file: 

1. From the home page, go to Site Map > Audit Trail > Analyzed 
Imports. 

2. Use the filters (usually by date or file ID) to locate the analyzed 
import record that corresponds with the import file you want to 
delete, then click Retrieve. 
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3. Select the checkbox for the record that needs to be deleted, then click 
Delete.  

4. Go to Site Map > Audit Trail > Integ. History. 

5. Use the filters (usually by date or file ID) to locate the import 
imported file you’d like to delete, then click Retrieve. 

6. Select the checkbox of the item you want to delete.  

7. Click Delete Data and History. 

As long as all dependencies (for example, an analyzed import file) have 
been removed, the system will confirm the deletion; otherwise an alert 
will let you know that there’s a problem. In this case, contact your 
Entomo Professional Services team.   

Integration Analytics 

The Integ. Analytics page allows you to determine whether 
partner/distributor files have been received as expected based on the 
frequencies specified on the Expected Data Config page. The analyzer 
can be setup as a job template to run according to your company’s 
reporting needs.  

The results table on the Integ. Analytics page can be configured to show 
the number of received files versus the number of expected files, and the 
difference (or variance) between them.  

When you retrieve records in the Integ. Analytics page, the data you see 
is either from the most recent analytics job (run automatically) or the 
most recent manual analysis done in the Integ. History page (clicking the 
Analyze button). For more information, see Integration History. 

The following filters and action buttons are standard, but you might see 
other options customized for your company.   

For instructions for fixing import errors, see Review Import Activity.  

For instructions about how analytic pages work, see Analytic Page 
Navigation and Configuring an Analytic Page.  

Integ. Analytics – Filters 

 From/To – Search for records based on the accounting period 
assigned to the import in the Expected Data Config page. 

 Imported From/To – Enter or select dates to retrieve records with 
import dates within that range. 

 Display – Select from the dropdown list to determine whether 
retrieved data will be displayed in a table, chart, or both.  

 Limit Results – Limit the number of records retrieved. For more 
information, see Sort with the Limit Results Filter. 
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 Company – Enter or select the name of a company (or set of 
companies) to retrieve records that belong to that specific company. 

 Model Type – Click the magnifying glass icon to specify the type of 
information you want to retrieve. Move your selections from the 
Choice List pane to the Selections pane, then click OK. 

 Show Period Details – Select this option to display accounting 
periods in the results table as separate columns. If the option is not 
selected, the results table will have a single Total column on the right 
that shows the combined total for all periods, instead of one column 
per period. For more information, see Configuring an Analytic Page. 

 Drill Down Report – The report you select in this field will be 
displayed when you click the View Details button, allowing you to 
see the records you retrieved in the format of the selected report. If no 
report is selected, the Analyzed Imports page is displayed when you 
click View Details.  

 Variance – Narrow your search to expected imports that are missing a 
specific number of files. Enter a value greater than zero (>0).  

Integ. Analytics – Actions 

 Retrieve – Return a list of records based on the parameters you set in 
Filters. 

 Delete – With proper permissions, delete selected records. 

 View Details – For selected records, open to the report specified in 
the Drill Down Report filter. If no report is specified in the Drill 

Down Report filter, the Analyzed Imports page opens. 

 Export – Export the retrieved data. 

 Draw – If you have selected Chart or Table & Chart in the Display 
filter, click Draw to see the retrieved data formatted as a chart.    

 Save Report – Open the Create a New Report dialog. For more 
information, see Saving and Creating Reports. 

View Import Analytics 

To review the submission analytics and send reminders, the Integration 
Analyzer must be run. The analyzer can be scheduled to run periodically 
(and automatically) as a job template, or it can be run manually. For more 
information, see Run a Manual Import Analysis.   

For instructions about how analytic pages work, see Analytic Page 
Navigation and Configuring an Analytic Page.  

To view partner submission analytics: 

1. From the home page, go to Site Map > Audit Trail > Integration 

Analytics. 
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2. In the From and To filters, set a date range for the records you want 
to view.  

3. Click Retrieve. 

Analyzed Imports 

The Analyzed Imports page is similar to the Integ. History page, except 
that it provides additional details about each imported file. The Analyzed 

Imports page is the source page for the Integ. Analytics page, and 
provides some information about file expectations. After an imported file 
has been analyzed, the analyzed record must be deleted from the 
Analyzed Imports page before you can delete if from Integ. History. 

For instructions about deleting an import file, see Delete an Imported 
File. 

Analyzed Imports – Filters 

 From/To – Search for records based on the accounting period 
assigned to the import in the Expected Data Config page. 

 Trans From/To – Search for records with transaction dates within a 
specified range, or enter a value such as “–30 days” in the Trans. 
From field to retrieve records with transaction dates in the last 30 
days. 

 Imported From/To – Search for records imported within a specified 
date range, or enter a value such as “–30 days” in the From field to 
retrieve records for the last 30 days. 

 Company – Enter or select the name of a company (or set of 
companies) to retrieve records that belong to that specific company. 

 Model Type – Click the magnifying glass icon to specify the type of 
information you want to retrieve. Move your selections from the 
Choice List pane to the Selections pane, then click OK. 

 Drill Down Report – The report you select in this field will be 
displayed when you click the View Details button, allowing you to 
see the records you retrieved in the format of the selected report. If no 
report is selected, the Analyzed Imports page is displayed when you 
click View Details. 

Analyzed Imports – Actions 

 Retrieve – Return a list of files based on the parameters you set in 
Filters. 

 Delete – With proper permissions, delete selected records. 

 View Details – For selected records, navigates to the report specified 
in the Drill Down Report filter, or to the Integ. History page if no 
report is specified. 



SmartHub 11.0 User Guide   

Entomo Confidential and Proprietary Information  137 

 Export – Export the retrieved data. 

 Save Report – Open the Create a New Report dialog. For more 
information, see Saving and Creating Reports. 

Module Log 

The Module Log page provides a running list of logs that reflect the 
resolutions, jobs, and warnings that occur in SmartHub. With the proper 
permissions, the log attachments can be opened. The page can also be 
accessed by a person with administrative permissions from the Job 

History page by clicking in the Status column. Your Entomo 
Professionals Services team uses these logs to investigate and resolve 
processing issues.  

Module Log – Filters 

 From/To – Search for records based on the accounting period 
assigned to the import in the Expected Data Config page.  

 From Date/To Date – Search for records within a specified date range, 
or enter a value such as “–30 days” in the From field to retrieve 
records for the last 30 days. 

 Module – Search for records related to a specific SmartHub module, 
such as CIM or POS.  

 Severity – Narrow the search to a specific severity level.  

 User – Narrow the search to a specific user.  

 Sponsor Company – Narrow the search to a specific company.  

Module Log – Actions 

 Retrieve – Return a list of records based on the parameters you set in 
Filters. 

 Delete – With proper permissions, delete selected records. 

User Sessions 

With the proper permissions, the User Sessions page allows you to 
monitor the log-in activity of SmartHub users, including their proxy user 
name, the length of time in the system, their current status, and more. 

User Sessions – Filters 

 From/To – Search for log-in activity on a specific date or within a 
range of dates. 

 Status – Search based on a specific activity status; otherwise, leave 
blank to retrieve all records, regardless of status. 

 Session Type – Narrow your search to a type of user session, for 
example, a browser, proxy, Salesforce, or web services session. Click 
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the magnifying glass icon to see a list of available session types. Move 
your selections from the Choice List pane to the Selections pane, then 
click OK. 

 Sponsor Company – This field is not editable. 

 User Company – To narrow your search by company name, enter 
company names separated by a comma or click the magnifying glass 
icon to open a dialog where you can select one or more companies.  

User Sessions – Actions 

 Retrieve – Return a list of users based on the parameters you set in 
Filters. 

 Delete – (Admin only) Delete specific records after you selected the 
checkboxes of the line items that you want to remove. 

 Logout Session – (Admin only) Log off the user associated with the 
session. 

 Export – Export the data in the results table to a .csv file, Excel 
spreadsheet, or PDF.  

 Save Report – Click to open the Create a New Report dialog. For 
more information, see Saving and Creating Reports. 

View User Activity 

With the proper permissions, you can use the User Sessions page to view 
user activity, including the proxy user name, data about the length of 
time in the system, the current status, and more.  

To view user activity: 

1. From the home page, go to Site Map > Audit Trail > User Sessions. 

2. In the Filters section, create one or more filters to locate the user or 
group of users you are interested in viewing.  

3. Click Retrieve. 

Log Off a User  

With the administrative permissions, you can end a user session in 
SmartHub. 

1. From the home page, go to Site Map > Audit Trail > User Sessions. 

2. In the Filters section, create one or more filters to locate the user or 
group of users you are interested in.  

3. Click Retrieve. 

4. Select the checkboxes of the users whose sessions you need to end. 

5. Click Logout Session.   
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User Sessions Analytics 

The User Sessions Analytics page provides overviews and totals of user 
access in SmartHub over time.  

For instructions about how analytic pages work, see Analytic Page 
Navigation and Configuring an Analytic Page.  

User Sessions Analytics – Filters 

 Login From/To – Search for log-in activity on a specific date or within 
a range of dates. 

 Status – Search based on a specific activity status; otherwise, leave 
blank to retrieve all records, regardless of status. 

 Session Type – Narrow your search to a type of user session, for 
example, a browser, proxy, Salesforce, or web services session. Click 
the magnifying glass icon to see a list of available session types. Move 
your selections from the Choice List pane to the Selections pane, then 
click OK. 

 User Company – To narrow your search by company name, enter 
company names separated by a comma or click the magnifying glass 
icon to open a dialog where you can select one or more companies.  

 Portal Type – Narrow your search based on Desktop or Mobile, or 
leave blank. 

 Show Period Details – Select this option to format the results table 
according to accounting period. 

 Show Totals – Select this option to include a set of total columns in 
the results table. 

 Drill Down Report – The report you select in this field will be 
displayed when you click the View Details button, allowing you to 
see the records you retrieved in the format of the selected report. If no 
report is selected, the User Sessions page is displayed when you click 
View Details. 

User Sessions Analytics – Actions 

 Retrieve – Return data based on the parameters you set in Filters. 

 Export – Export the retrieved data. 

 Save Report – Open the Create a New Report dialog. For more 
information, see Saving and Creating Reports. 

 View Details – For selected records, open to the report specified in 
the Drill Down Report filter. If no report is specified in the Drill 

Down Report filter, the Analyzed Imports page opens. 
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About Notifications 

The Notifications page provides a record of all email alerts and 
notifications sent from SmartHub. These notifications can include 
reminders about workflow approvals, job completion alerts, and file 
import alerts. With the proper permissions, you can delete the record of a 
notification.  

Caution: If you select a line item in the results table, then click Delete, the 
record of the notification will be permanently deleted from the system.  

Notifications – Filters 

 From/To – Search for records based on the date of the notification. 

 Type – Narrow your search to Alert or Reminder emails, or leave 
blank to retrieve both types. 

Notifications – Actions 

 Retrieve – Return a list of users based on the parameters you set in 
Filters. 

 Delete – With proper permissions, delete selected records. 

 Export – Export the retrieved data. 

Chapter 13 | Accounting Periods  

About Accounting Periods 

In SmartHub, the default is that calendar weeks start on Sunday, and that 
a calendar month starts on the first full week of each month. You can, 
however, define SmartHub accounting periods to match those used in 
your company. Accounting periods are used throughout the system, for 
example, to group data for data retrieval and to ensure that transactions 
are assigned to the correct period. You can also set up your accounting 
periods to reflect a 52-53 (or 4-4-5) fiscal year.  

SmartHub uses the following terms, each with very specific meanings: 

 Accounting Period – In SmartHub, an accounting period is a unit of 
time defined by 4-5 calendar weeks, at the end of which the books are 
balanced and financial statements prepared. Multiple accounting 
periods comprise a fiscal year. Accounting periods can be opened and 
closed.  

 Accounting Week/Month/Quarter/Semi-Annual/Year – In 
SmartHub, accounting weeks/months/etc. are periods of time not based 
on calendar weeks. For example, an accounting month might begin on 
the 1st and end on the last calendar day of that month. These periods 
cannot be opened or closed; rather, they are for reporting only, to 
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allow you to report on fractions or multiples of your accounting 
periods in a way that isn’t based on calendar weeks.  

The following rules apply to accounting periods in SmartHub: 

 Every transaction date must belong to exactly one accounting period.  

 Accounting periods can be imported from comma-separated (.csv) 
files.  

Period List – Filters 

The following filters are available: 

 Period Type – If your system is set up with different types of 
accounting periods, narrow your search to a specific type of period 
(daily, weekly, monthly, etc.).  

 State – Narrow your search to closed periods by selecting the Closed 
option, to open periods by selecting the No Snapshot option. 

Period List – Actions 

 Retrieve – Return records based on the parameters you set in Filters. 

 Delete – With proper permissions, delete selected records.  

 Close – Close the oldest open period. Click again to close the next 
oldest period, and so on.   

 Reopen – Reopen the closed period with the most recent date. Click 
again to reopen the next previous period. 

 Export – Export the retrieved data. 

View Accounting Period Status 

Use this procedure to view the beginning, end, and cutoff dates for each 
period, including the time of closure if applicable. 

1. Go to Site Map > Administration > Accounting Period to open the 
Period List page. 

2. In the Period Type field, select the type of period you want to find.  

3. In the State field, select the type of period you want to find: Open, 

Frozen, Closed, or blank (to return all period types). 

4. Click Retrieve.  

Close an Accounting Period Leaving a Module Open 

It’s possible (with the proper permissions) to close an accounting period 
while keeping the Claims Incentive Module (CIM) open so you can 
continue to post outstanding claims. Currently, this functionality is only 
available with the CIM module. 

1. Go to Site Map > Accounting Period to open the Period List page.  
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2. In Filters, set the Period Type and State fields to retrieve the period 
you want to close. 

3. Click Retrieve.  

4. In the results, click the link in the ID column for the period you want 
to close.  

 

5. In the Period List > Accounting Page, click Edit.  

6. If CIM isn’t already listed in the Modules section, click Add 

Module. (Because the CIM is currently the only module that can be 
left open when the period is closed, it alone appears in the list.) 

7. In the State dropdown, select Closed. 

 

8. Click Save to return to the Period List page. 
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9. You can now close the accounting period while the CIM remains 
open. Select the checkbox of the period you want to close, then click 
the Close button. 

Note: Sometimes, an Effective State column is available. If so, the 
period will now be listed as Closed (Open) as long as the CIM 
remains open while the period is closed. 

 

While CIM remains open, you can do the following:  

 Import/resolve explicit claims 

 Import payments 

 Run certain jobs 

 Make adjustments 

 Make payments and miscellaneous deletions/modifications (such as 
comments)  

 Make payments 

Closing a Module and Accounting Period 

This procedure assumes that the Channel Incentive Module (CIM) was 
left open while the accounting period was closed, as described in Close an 
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Accounting Period Leaving CIM Open. When you finish posting all 
incentives for the period, use the following procedure to close CIM and 
finish closing the accounting period. 

To close CIM after all the claims have been received: 

1. Go to Site Map > Administration > Accounting Period to open the 
Period List page (or use the report created by your Entomo 
Professional Services team).   

2. Set filters as needed to locate the period that contains the CIM you 
want to close, then click Retrieve.  

3. In the results, click the link for the period you want to close.  

 

4. In the Period List > Accounting page, click Edit.  

5. In the Modules section, select CIM. 

6. In the State dropdown, select Closed. 

 

7. In the Close Time field, enter/select a date for the closure.  

8. Click Save. 

Chapter 14 | POS  

In SmartHub, the Point of Sales (POS) module provides access to 
information (such as point-of-sale transactions and forecast data) 
submitted to SmartHub by your partners/distributors. Typically, 
incoming data is processed automatically, either upon receipt or at 
scheduled intervals. Portions of the data, such as reported item and 
reported customers, can then be resolved to master values in SmartHub. 
Data can also be enhanced per your specifications. For more information, 
see Resolve POS Transactions.  

The POS module also provides analytic capabilities. While the POS page 
provides a view of large amounts of data, the POS Analytics page allows 
you to focus on more specific dimensions of the data and to create 
informative charts and graphs based on those dimensions. For more 
information, see About the POS Analytics Page. 
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For a tour of an analytic page, see Analytic Page Navigation. For an 
example, see About Analytic Pages.  

In general, your Entomo Professional Services team will configure and 
schedule POS jobs that automatically resolve and analyze your data for 
you. POS data can be viewed and managed in the following pages: 

 About the POS Page 

 About the POS Analytics Page 

About the POS Page 

It’s likely that your Entomo Professional Services team created a version 
of the POS page as a POS report, with filters configured specifically for 
your company, accessible from your favorites pane. For a description of 
the filters in your company-specific reports, consult your implementation 
guide. The following fields are a sample of the more frequently used 
filters on the POS page. 

POS Page – Filters 

 Acctng. Prd. From/To – Retrieve transactions based on a range of 
accounting periods. A transaction belongs to an accounting period 
based on its accounting date. 

 Acctng. Date From/To – Retrieve transactions based on a range of 
accounting dates.  

 Trans. Prd. From/To – Retrieve transactions based on a range of 
transaction periods. The period a transaction belongs in is determined 
by its transaction date.  

 Trans. Date From/To – Retrieve transactions based on a range of 
transaction dates.  

 Imported From/To – Retrieve transactions based on the date they 
were imported into SmartHub.   

 Trans. Type – Retrieve data based on the transaction types defined 
for your company. Leave the field blank to retrieve all. 

 Trans. Status – Retrieve transactions based on whether they are open 
or closed. Leave the filter blank to retrieve all transactions regardless 
of status. 

 Unmapped Trans. – Click the magnifying glass icon to select one or 
more rule templates to retrieve transactions that are not yet resolved 
for the selected rule templates. 

 Mapped Trans. – Click the magnifying glass icon to select one or 
more rule templates to retrieve transactions that were resolved using 
those rule templates. 
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 Trans. Number – Retrieve transactions by entering one or more 
transaction numbers, separated by commas. 

 Partner – Retrieve transactions according to partner or distributor 
name. 

 Partner Channel Type – Retrieve transactions based on channel type 
(such as distributor or reseller), or leave the field blank to retrieve all 
channel types. 

 Sponsor Item (Rpt./Res.) – Select an item number from the item 
master or enter an item number to retrieve only the transactions that 
contain the selected item number as either reported or resolved. 

 Eff. Mod. Time – Retrieve transactions based on a range of dates 
when the transactions were last modified. 

POS Page – Actions 

Typically, many of these functions are built into automated jobs by your 
Entomo Professional Services team; however, they are available to those 
with the proper permissions when manual processing is needed.   

 Retrieve – Return records based on the parameters you set in Filters. 

 Delete – Delete any selected transaction (checkbox is selected). 

 Open – Open a transaction so it can be updated, either manually or 
through analysis. 

 Close – Close a transaction so no further updates can be made to it. 

 Adjust Commission – Open the Adjust Commissions page so you 
can modify any selected transaction (checkbox is selected).  

 Hide – Temporarily hide selected transactions so you can retrieve 
data without them. For more information, see About Hidden Records. 

 Unhide – Make hidden transactions available again for retrieval. For 
more information, see About Hidden Records. 

 Sales Credit Assignment – Open a dialog so you can assign/remove 
a sales credits and run a new analysis for the transactions you selected 
in the POS page. 

 Resolve – Run the resolution process. For more information, see 
Resolve POS Transactions.  

 Create Map – Open the Pattern Map page, so you can create a new 
pattern map.  

 Make Adjustments – Open the POS Adjustment page where you can 
modify status, dates, quantities, etc. for any transactions selected in 
the POS page. Only open transactions can be adjusted. For 
instructions, see Adjusting POS Transactions. 
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 Job Status – Open the Job History page so you can see the current 
status of any POS-related jobs. 

 Export – Export the currently retrieved data. 

 Save Report - Open the Create a New Report dialog, where you can 
save your filter settings and page configuration to your favorites pane 
and/or associate a favorite group to the report. 

 Bulk Edit – Open the Bulk Edit dialog so you can modify multiple 
transactions at the same time.   

About Resolutions 

During a POS or inventory resolution job, one or more predefined rules 
(sometimes referred to as rule templates, pattern maps, and enrichment 
scripts) are applied to your transactional data to enrich and resolve it.  

 Data resolution involves converting the data reported by your 
partners (such as customer names, item numbers, and countries) into 
values that conform to your customer, item, and country master files 
in SmartHub.  

For example, a partner might report an outdated part number as 
"12345ABCD". Because the outdated part number is not in the item 
master, a pattern map can be created that maps “12345ABCD” to the 
current part number “XYZ12345” to ensure that SmartHub records 
the correct item number with the proper transaction.    

 Data enrichment depends on the needs of your company. For 
example, if your company uses week-ending dates, an enrichment 
script can be created to automatically populate them.    

The resolution and enrichment rules that are applied during a resolution 
job are created by your Entomo Professional Services team to specifically 
meet the needs of your company. Resolution jobs can be scheduled to run 
automatically or they can be run on-demand.  

With the proper permission, you can also use the Resolve button on the 
POS page to select and run specific rule templates on specific 
transactions. For more information, see Resolve POS Transactions.  

About Valuations 

A POS resolution job is usually followed by a POS valuation job that 
associates predefined costs and prices to individual transactions. Usually, 
your Entomo Professional Services team will include a valuation job as 
part of a string of jobs that begin with a resolution process, but a 
valuation job can also be run automatically (as an event) or on-demand.  

With the proper permissions, a valuation can be run when you click the 
Analyze button on a POS page or report based on that page, or on a POS 
Analytics page or report based on that page. You can set the source of 
these costs/prices to be transaction unit price (the price reported by your 



SmartHub 11.0 User Guide   

Entomo Confidential and Proprietary Information  148 

partners/distributors), price book, or sponsor sales using the first-in, 
first-out (FIFO) methodology.  

The Analyze button won’t work on closed transactions. The valuation 
process can be repeated as many times as needed, which allows for 
updates to sponsor sales or the price book.  

Run a Valuation Manually 

To run a valuation manually: 

1. Go to Site Map > Sales > POS or open the POS report configured for 
you by your Entomo Professional Sales team in your favorites pane.  

You can also run a valuation from the POS Analytics page or a 
configured analytics report.  

2. Use the Filters section to specify item numbers, partners, or time 
periods that will retrieve the transactions you want to value. (Skip to 
the next step if you are using report with pre-defined filters.) 

3. Click Retrieve.  

4. Click Analyze. 

5. In the Values to Update dialog, select an option to update costs, 
prices, or both. 

6. In the Valuation Source section, select the option that you want to 
use as the source:   

o Sponsor Sale FIFO – This option matches sponsor sale records to 
POS transactions using the resolved item numbers and transaction 
dates to determine matches. POS transactions can then be valued 
using the price provided on the sponsor sale transaction.  

o Price Book – This option assigns prices by matching resolved item 
numbers to price book records. If validity dates are specified in 
the price book, they will be used to match POS transaction dates.  

7. In the Job Options section, select one of the following options based 
on when you want the job to run: 

o Run (Always run job) – The valuation job will start immediately 
after you click OK.  

o Next (Queue job after last currently running instance) – The 
valuation job will run after any currently queued jobs of the same 
job type. 

o Last (Queue job after last currently running job) – The valuation 
job will run after all other currently queued and running jobs are 
complete, including import jobs. 

o Skip (Skip job if already running) – If a currently running job is 
the same job type as the one you are attempting to set up, this new 
job will be canceled. 

8. Click OK. 
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About Resolve vs. Analyze 

In SmartHub, three processes are important to understand: resolve, 
analyze, and unmap. Even though the resolve and analyze actions are 
sometimes used interchangeably, they have specific meanings: 

 Resolve refers to the application of rules to your reported data to make 
your data more uniform for all partners. The goal is to ensure that the 
data conforms to your master files. For more information, see About 
Resolutions. 

 Analysis refers to the algorithms that a specific module runs based on 
“analyzing” multiple transactions and types of transactions 
simultaneously. The output of an analysis is usually meta-data that 
can be found in an analytic page. For example, the IRM uses POS, 
Inventory, Sponsor Sales, In-transits, RMAs, etc. in its analysis. The 
results of the analysis are inventory reconciliation records, which can 
be viewed in summary form via a configured report. For more 
information, see Configuring an Analytic Page.  

 Unmap refers to the process of undoing the results of a resolution or 
analysis action. 

Typically, your Professional Services team will create several resolver 
reports configured specifically for your company, such as: 

 POS Resolver Report 

 Inventory Resolver Report 

About Quick Audits  

Typically, your Entomo Professional Services team creates for your 
company a set of quick audit reports for POS and inventory that will 
allow you to do a sanity check to ensure that all records are correctly 
imported into SmartHub. Quick audits are particularly useful for 
validating files submitted by partners who occasionally modify formats 
and content in unexpected ways that result in omissions and 
misinterpretations.  

The audit numbers in the quick audit reports are identified according to 
distributor and import file name with the number of transactions, 
quantities, and the reported net extended cost, if applicable. To confirm 
the accuracy of this data, validate these numbers against the numbers in 
the raw files. 

To run a quick audit, open the report designated by your Entomo 
Professional Service team in your favorites pane, then click Retrieve.  

To check for errors in the import history, see Integration History.  

Find a Transaction  

To view POS (transactional/sales) data: 
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1. Go to Site Map > Sales > POS or open the POS report configured for 
you by your Entomo Professional Sales team in your favorites pane.  

2. Use the Filters section to specify item numbers, partners, or time 
periods that will retrieve the transactions you want. (Skip to the next 
step if you are using report with pre-defined filters.) 

3. Click Retrieve.  

For instructions about creating and modifying reports, see Creating and 
Saving Reports. 

About Hidden Records 

POS, inventory, and sponsor sales transactions can be imported as hidden 
records. The files that contain these transactions appear in the import 
history, but the transactions remain hidden until specifically unhidden. 
Your Entomo Professional Services team can create and schedule an 
unhide job for you. Records can also be manually unhidden, outside of 
normally scheduled events.  

You can set up an unhide job to run for any or all distributors, based on 
what your company needs. A job that unhides records is usually run 
before a resolution job.  

If it makes sense for your company, your Entomo Professional Services 
team can also configure a variety of sell-through and inventory 
management reports that allow you to view hidden records.  

Include Hidden Records in a Report 

The POS and Inventory pages usually provide a filter (labeled something 
like Hidden?) that allows you to see hidden records and include them in 
a report.  

To include hidden records in a POS report: 

1. Go to Site Map > Sales > POS or open the POS report configured for 
you by your Entomo Professional Sales team in your favorites pane.  

2. In the Filters section, set the Hidden? field to one of the following 
options: 

o Yes – The results will show only hidden data. 

o No – The results will show only data that is not hidden.  

o Blank – The results will show both hidden and unhidden data.  

3. Click Retrieve.  

Resolve POS Transactions 

In general, your Entomo Professional Services team will configure POS 
jobs that automatically resolve your data for you on a schedule (for 
example, once a day, or once a month); however, with the proper 
permissions, you can also run a resolution process manually.  
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For example, if a file is received shortly after a scheduled resolution job, 
you might not want to wait 23 hours until the next automated resolution 
job is run, so you do a manual resolution. For more information, see 
About Resolutions. Note that you can also run an off-schedule resolution 
job from the Job Templates page.  

To manually resolve POS transactions: 

1. Go to Site Map > Sales > POS or open the POS resolver report (in 
your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. Use the Filters section to locate the transactions that you want to 
manually resolve.  

3. Click Retrieve.  

4. If you don’t want to resolve all of the transactions in the results, 
select the checkboxes of the lines you want to resolve.  

5. Click Resolve to open the Rule Templates dialog. 

6. In the dialog, move the rules that you want to apply during the 
resolution process by double-clicking them (or highlighting them, 
then clicking Add To) to move them to the Selections pane.  

7. In the Resolve Options section, ensure that Resolve is selected.  

8. In the Job Options section, set the timing of the resolution by 
selecting one of the following options. These options are the same as 
the options used in the Job Templates page. For more information, 
see Run a Job.  

o Run (Always run job) – The resolution job will start immediately 
after you click OK.  
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o Next (Queue job after last currently running instance) – This 
resolution job will run after any currently queued jobs of the same 
job type. 

o Last (Queue job after last currently running job) – This 
resolution job will run after all other currently queued and 
running jobs are complete, including import jobs. 

o Skip (Skip job if already running) – If a currently running job is 
the same job type as the one you are attempting to set up, this new 
job will be canceled. 

9. When you finish making your selections, click OK to close the Job 

Templates dialog and resolve the transactions. The resolver runs as a 
background job.  

To check the status, click the Job Status button or go to the Job History 
page. For more information, see About Job History. 

If the results show unmatched transactions, see Resolve Unmatched POS 
Transactions. 

Resolve Unmatched POS Transactions 

Unmatched transactions are the result of a resolution process, and they 
can occur for a variety of reasons, such as receiving additional data after a 
resolution job, receiving data that doesn’t match the master files, or 
receiving data that is invalid (for example, icons were used instead of 
numbers). It is advised that you work with your Entomo Professional 
Services team to determine how to best handle these transactions.    

The best practice for updating the item and company master data in 
SmartHub is to use periodic, automatic feeds. This allows your company 
to control the data and ensure the accuracy of the data in SmartHub 
without human intervention. However, with the proper permissions, you 
can add and modify data in the SmartHub item master and company 
master.  

To manually resolve an unmatched POS transaction: 

1. Go to Site Map > Sales > POS or open the POS resolver report (in 
your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. In the Filters section, click the magnifying glass icon on the 
Unmapped Trans field. (Skip to the next step if you are using report 
with pre-defined filters.)  

This opens the Select Unmapped Fields dialog.  

NOTE: The use here of the term “unmapped” actually means 
“unmatched.” Don’t get it confused with the term “unmap,” which is 
the reversal of a resolution or analysis action. For more information, 
see About Resolve vs. Analyze. 
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3. In the Select Unmapped Fields dialog, double-click the types of 
unmatched transactions you want to retrieve.  

Double-clicking is the same as highlighting an item, then clicking Add 

To to move it to the Selections pane. (Mapping types are configured 
specifically for your company, so your list might be different than 
shown below.)  

 

4. When you are finished selecting unmapped types, click OK to return 
to the POS page.  

5. Review the results to determine how to proceed. You might need to 
switch to a different procedure instead of continuing with this 
procedure. For example, you might need to create a new pattern map 
to link a reported value to the value in the master files, or you might 
need to update the master files. A variety of solutions are possible. 

6. Click Resolve to open the Rule Templates dialog.  

7. In the Rule Templates dialog, move the rules that you want to apply 
during the resolution process by double-clicking them (or 
highlighting them, then clicking Add To) to move them to the 
Selections pane.  
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8. In the Resolve Options section, ensure that Resolve is selected.  

9. In the Job Options section, set the timing of the resolution by 
selecting one of the following options. These options are the same as 
the options used in the Job Templates page. For more information, 
see Run a Job.  

o Run (Always run job) – The resolution job will start immediately 
after you click OK.  

o Next (Queue job after last currently running instance) – This 
resolution job will run after any currently queued jobs of the same 
job type. 

o Last (Queue job after last currently running job) – This 
resolution job will run after all other currently queued and 
running jobs are complete, including import jobs. 

o Skip (Skip job if already running) – If a currently running job is 
the same job type as the one you are attempting to set up, this new 
job will be canceled. 

10. When you finish making your selections, click OK to close the Job 

Templates dialog. The resolver will run at the time you selected and 
the newly resolved transactions will be posted to the Job History 

page. For more information, see About Job History. 

Note that the POS page will not be automatically updated. To check the 
status of the transactions that you hoped to resolve, reset the filters on the 
POS page to find those specific transactions (and clear the Unmapped 

Trans filter), the click Retrieve again.  

Reverse a Resolution Job 

It’s possible to undo a POS resolution job using the Unmap option from 
the POS page. In this context, unmap refers to the process of reversing 
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the results of a resolution action, which disassociates reported values 
from the master files. 

To reverse a resolution process: 

1. Go to Site Map > Sales > POS or open the POS resolver report (in 
your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. Use the Filters section to locate the transactions that you want to 
manually unmap.  

3. Click Retrieve.  

4. In the results, select the checkboxes of the lines you want to unmap or 
select the checkbox for all lines.  

5. Click Resolve to open the Rule Templates dialog. 

6. In the dialog, move the rules that you want to reverse by moving 
them to the Selections pane (double-click or highlighting them, then 
click Add To).  

7. In the Resolve Options section, select Unmap.  

 

8. In the Job Options section, set the timing of the resolution by 
selecting one of the following options.  

o Run (Always run job) – The unmap job will start immediately 
after you click OK.  

o Next (Queue job after last currently running instance) – The 
unmap job will run after any currently queued jobs of the same 
job type. 

o Last (Queue job after last currently running job) – The unmap 
job will run after all other currently queued and running jobs are 
complete, including import jobs. 
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o Skip (Skip job if already running) – If a currently running job is 
the same job type as the one you are attempting to set up, this new 
job will be canceled. 

9. When you finish making your selections, click OK to close the Job 

Templates dialog and reverse the transactions. The reversed 
transactions will now appear in the Job History page.  

Delete POS Transactions 

With the proper permissions, it’s possible to delete transactions, but 
caution is advised because it’s easy to delete transactions that you don’t 
recognize, only to realize later that they shouldn’t have been deleted. The 
best practice is to contact your Entomo Professional Services team to 
delete transactions so they can properly research the need for deletion.  

Transactions cannot be deleted if they are in a closed period or if they are 
referenced by other SmartHub modules.  

To delete POS transactions: 

1. Go to Site Map > Sales > POS or open the POS report (in your 
favorites pane) that was configured by your Entomo Professional 
Sales team.  

2. Use the Filters section to locate the transactions that you want to 
delete.  

3. Only transactions in an open accounting period can be deleted.  

4. If your company uses split records, be sure to set the Split Records 
field to No. 

5. Click Retrieve.  

6. In the results, select the checkboxes of the lines you want to remove, 
then click Delete. 

The transactions are removed from SmartHub.  

Adjust Commissions 

If your company uses SmartHub to track commissions, you can use the 
POS page to add, delete, or modify commissions for transactions in any 
open accounting period.  

To adjust commissions: 

1. Go to Site Map > Sales > POS or open the POS report (in your 
favorites pane) that was configured by your Entomo Professional 
Sales team.  

2. Use the Filters section to locate the transactions that contain the 
commissions that you want to adjust. (Using this procedure on 
transactions without commissions will result in an error.) 

3. Click Retrieve. 
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4. Select the checkbox of the transaction you want to adjust, then click 
Adjust Commissions to open the POS > Adjustments page.  

5. Click Adjust? Yes to make the transaction editable.  

6. Do one of the following to make adjustments: 

o Delete – Select the line that you want to delete, then click Remove 

Slot. 

o Add – Click Add Slot to add a new commission level, then fill in 
the fields to define the new level.  

o Modify – Select the line you want to modify, then click Edit and 
make the necessary changes. 

7. When you’re finished, click Save.  

Adjusting POS Transactions 

Adjustments are often needed to compensate for things like loss, 
breakage, and getting products unexpectedly from another partner. 
Generally, such adjustments are handled by a reconciliation, but it’s also 
possible to make adjustments in the POS page.  

To manually adjust POS transactions: 

1. Go to Site Map > Sales > POS or open the POS report (in your 
favorites pane) that was configured by your Entomo Professional 
Sales team.  

2. Use the Filters section to locate the transactions you want to adjust.  

3. Click Retrieve. 

4. Click Make Adjustments to open the POS Adjustment page.  

5. In the Convert To field, select the proper adjustment type, then click 
Save.  

6. Perform a reconciliation to apply the adjusted transactions. 

For instructions about how to do a resolution, see About Resolutions.  

For information about how to transfer inventory records, see About 
Transfers.  

Edit Transactions in Bulk 

The ability to edit in bulk is possible in SmartHub, but it is individually 
configured per company, and only upon request. Bulk editing is 
configured for specific data points, and it requires proper permissions. 

If large-scale changes are needed for incoming data, your Entomo 
Professional Services team will usually either create a script to match 
reported values to master values upon resolution, or they will request a 
fresh, corrected file from you instead of making manual changes in 
SmartHub. However, bulk editing might be the preferred solution when 
changes are needed infrequently for a specific data point that might 
involve just a handful of distributors.  
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Work with your Entomo Professional Services team to provide specific 
instructions for your company. The following instructions are very 
general.  

To edit in bulk: 

1. Go to Site Map > Sales > POS or open the POS report (in your 
favorites pane) that was configured by your Entomo Professional 
Sales team.  

2. Use the Filters section to locate the transactions you want to edit. 

3. Click Retrieve. 

4. In the results, select the checkboxes of the transactions that need to be 
edited, then click Bulk Edit. 

5. Enter the value that will be added to, or modified in, the selected 
transactions.   

6. Add a comment.  

7. Click Apply (to save but keep making changes) or Apply and Save 
(to save and exit).  

8. The updates will need to be resolved. Select the updated transactions 
by clicking Select All Bulk Edit Rows, then click Resolve. 

9. In the Rules Templates dialog, select the necessary rules.  

Unless you know exactly what rules need to be run for the bulk edits, 
it’s best to run all the rules.    

10. Click Add To.  

11. Ensure that the Resolve option is selected.  

12. Click OK.  

Opening and Closing Transactions 

With the proper permissions, individual transactions can be opened and 
closed using the Open and Close buttons on the POS page or in any 
report created from the POS page. Closing a transaction locks it and 
prevents the transaction from being updated, for example, by resolution 
rules or by commission updates in an open accounting period.  

Closing an individual transaction assures that the transaction will not be 
changed if its accounting period is reopened.  

A closed transaction can be reopened for additional updates by clicking 
the Open button as long as its associated accounting period is open.  

For more information about opening and closing transactions, contact 
your Entomo Professional Services team.  

About Forecasting 

The forecasting feature in SmartHub allows you to consolidate and 
analyze future sales and inventory projections from your 
partners/distributors. When forecast data is imported into SmartHub 
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(usually weekly), older forecast data is hidden so you analyze only the 
newest data.  

Your Entomo Professional Services team will work with you to configure 
forecasting reports specific to your company’s needs. Working with 
forecast data is the same as working with POS data except that To/From 

filters are set to a future date and the POS Subtype filter is set to 
Forecast. You can perform both resolutions and valuations on forecast 
data.  

 

If your company is using the forecast feature, some or all of the following 
filters and reports might be used: 

 Unhide Report – When forecast files are imported, the transactions 
are hidden. Your Entomo Professional Services team can configure a 
job called something like “Run Unhide” to set the most recent forecast 
import to be unhidden and all others to hidden.  

 POS Hidden Filter has the following options: 

o Current – Retrieves the most recent forecast data received.  

o Previous – Retrieves all but the most recent forecast data. 

o Both – Retrieve all forecast data.  

 Forecast Filter has the following options. Selecting None or All can 
improve processing performance: 

o Non-Overlapping – Compares POS to forecast transactions and 
removes any transaction that might have been reported as a 
forecast transaction but actually happened, leaving only forecast 
data.  

o None – Retrieves no forecast data. 

o All – Retrieves all data, including overlapping forecast data.  

 Forecast Report ID – Each set of forecast records imported from a 
partner is called a forecast report. This filter retrieves a set of forecast 
records according to the ID number assigned the set. (Individual 
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forecast records are retrieved using a regular transaction ID number, 
the same as non-forecast records.) 

About the POS Analytics Page 

The following filters and actions are available on the POS Analytics page 
and reports based on this page. For information about setting up an 
analytic page, see Configuring an Analytic Page. 

POS Analytics – Filters 

 Acctng. Prd. From/To – Retrieve transactions according to an 
accounting period. A transaction belongs to an accounting period 
based on its accounting date. 

 Acctng. Date From/To – Retrieve transactions based on a range of 
accounting dates. 

 Trans. Prd. From/To – Retrieve transactions according to transaction 
period. The period a transaction belongs in is determined by its 
transaction date.  

 Trans. Date From/To – Retrieve transactions based on a range of 
transaction dates. 

 Imported From/To – Retrieve transactions based on the date they 
were imported into SmartHub. 

 Trans. Subtype – Retrieve data based on the transaction subtypes 
defined for your company. Leave the field blank to retrieve all. 

 Convert To – Select the currency you want to see. 

 Trans. Status – Retrieve transactions based on whether they are open 
or closed. Leave the filter blank to retrieve all transactions regardless 
of status.  

 Unmapped Trans. – Click the magnifying glass icon to select one or 
more rule templates to retrieve transactions that are not yet resolved 
for the selected rule templates. 

 Mapped Trans. – Click the magnifying glass icon to select one or 
more rule templates to retrieve transactions that were resolved using 
those rule templates. 

 Trans. Number – Retrieve transactions by entering one or more 
transaction numbers, separated by commas. 

 Partner – Retrieve transactions according to partner or distributor 
name. 

 Partner Channel Type – Retrieve transactions based on channel type 
(such as distributor or reseller), or leave the field blank to retrieve all 
channel types. 
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 Sponsor Item (Rpt./Res.) – Select an item number from the item 
master or enter an item number to retrieve only the transactions that 
contain the selected item number as either reported or resolved. 

 Show Period Details – Display retrieved data by period, at a 
specified interval (such as weekly, quarterly, etc.). Leave the option 
blank to see a total only. 

 Display – Change the format of the retrieved data between a results 
table only, a chart only, or both.  

 Drill Down Report – Select a report from the dropdown list to 
designate that report as the target report when the View Details 

button is selected. 

POS Analytics – Actions 

 Retrieve – Return records based on the parameters you set in Filters. 

 Reset Sort – Clear the current sort logic and resets it to the default 
ascending sort order on the first column set as the basis for the 
aggregation. For more information about sorting, see Sorting in 
Analytic Pages. 

 Analyze – Open the Values to Update dialog, where you can define a 
valuation job. For more information, see About Valuations.  

 Report Job – Open the Create a New Report dialog to save a new 
report. For more information, see Saving and Creating  Reports.  

 Job Status – Open the Job History page as a dialog so you can refer to 
the list of jobs while staying in the POS Analytics page. 

 View Details – For selected rows (or retrieved rows, if no rows are 
selected), show the underlying transactions that use the report 
designated in the Drill Down Report field in the Filters section. 

 Export – Export the data in the active results table.  

 Draw – Update all displayed charts without having to retrieve data 
again. 

 Save Report – Open the Create a New Report dialog, where you can 
save your filter settings and page configuration to your favorites pane 
and/or associate a favorite group to the report. For more information, 
see Saving and Creating Reports. 

Chapter 15 | Inventory  

The Inventory, Inventory Analytics, Inventory Reconciler, and 
Inventory Reconciliation Summary pages work together to allow you to 
manage and create reports based on the inventory data that is submitted 
to SmartHub by your company and your partners/distributors. 
SmartHub calculates your period end inventory by gathering data about 



SmartHub 11.0 User Guide   

Entomo Confidential and Proprietary Information  162 

partner beginning inventory, sponsor sales/returns, partner 
sales/returns, and last reported inventory.  

Like POS data, inventory data is processed automatically, either upon 
receipt or at scheduled intervals. For inventory, the value most often 
resolved is the reported item number, which is matched to products in 
the item master or to values indicated through pattern maps. Data can 
also be enhanced per your specifications. For more information, see 
Resolve Inventory Records.  

In general, your Entomo Professional Services team will configure and 
schedule inventory jobs that automatically resolve and analyze your data 
for you.  

Inventory data can be viewed and managed in the following pages: 

 About the Inventory Page 

 About the Inventory Reconciler Page 

 About the Inventory Reconciliation Summary 

About the Inventory Page 

It’s likely that your Entomo Professional Services team created a version 
of the Inventory page as a report, with filters configured specifically for 
your company, accessible from your favorites pane. For a description of 
the filters in your company-specific reports, consult your implementation 
guide. The following fields are a sample of the more frequently used 
filters. 

Inventory Page – Filters 

 From/To – Retrieve inventory records by accounting period. A 
transaction belongs to an accounting period based on its inventory 
date. 

 Trans. From/To – Retrieve inventory records based on a range of 
dates.  

 Imported From/To – Retrieve inventory records based on a range of 
dates that they were imported into the system. 

 Convert To – Select the currency you want to see. 

 Trans. Status – Retrieve inventory records based on whether the 
associated transaction is open or closed. Leave the filter blank to 
retrieve all transactions regardless of status. 

 Unmapped Trans. – Click the magnifying glass icon to select one or 
more rule templates to retrieve transactions that are not yet resolved 
for those rule templates. 
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 Mapped Trans. – Click the magnifying glass icon to select one or 
more rule templates to retrieve inventory records that were resolved 
using those rule templates. 

 Trans. Number – Retrieve inventory records by entering one or more 
transaction numbers, separated by commas. 

 Partner – Retrieve inventory records according to partner or 
distributor name. 

 Sponsor Item (Rpt./Res.) – Select an item number from the item 
master or enter an item number to retrieve only the transactions that 
contain the selected item number as either reported or resolved. 

 Eff. Mod. Time – Retrieve inventory records based on a range of 
dates when the transactions were last modified. 

 Inv. Report – Retrieve inventory records based on whether they were 
received first or last, and based on the arrival time or report date. 
Select all to retrieve all inventory records without considering their 
arrival time or report dates.  

Inventory Page – Actions 

Typically, many of these functions are built into automated jobs by your 
Entomo Professional Services team; however, they are available to those 
with the proper permissions when manual processing is needed. 

 Retrieve –Return inventory records based on the parameters you set 
in Filters. 

 Delete – Delete any selected inventory record (checkbox is selected). 

 Open – Open an inventory record so it can be updated, either 
manually or through analysis. 

 Close – Close a record so no further updates can be made to it. 

 Hide – Temporarily hide selected records so you can retrieve data 
without them. For more information, see About Hidden Records. 

 Unhide – Make hidden transactions available again for retrieval. For 
more information, see About Hidden Records. 

 Resolve – Run the resolution process. For more information, see 
Resolve POS Transactions.  

 Create Map – Open the Pattern Map page, so you can create a new 
pattern map.  

 Make Adjustments – Open the POS Adjustment page where you can 
modify status, dates, quantities, etc. for any transactions selected in 
the POS page. Only open transactions can be adjusted. 

 Analyze – Open the Values to Update dialog, where you can define a 
valuation job. For more information, see About Valuations.  
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 Job Status – Open the Job History page so you can see the current 
status of any inventory-related jobs. 

 View FIFO – Open the FIFO Logs (Inventory) dialog, where you can 
view the invoices used for valuation.  

 Export – Export the currently retrieved data. 

 Save Report - Open the Create a New Report dialog, where you can 
save your filter settings and page configuration to your favorites pane 
and/or associate a favorite group to the report. 

About Inventory Resolution 

The resolution process for inventory data is the same as for POS data. For 
more information, see About Resolutions. For instructions about 
resolving inventory manually, see Resolve Inventory Records. 

About Inventory Valuation 

The valuation process for inventory data is the same as for POS data. For 
more information, see About Valuations. For instructions about running a 
manual valuation, see Run a Valuation Manually. 

Find an Inventory Record 

To view inventory data: 

1. Go to Site Map > Inventory > Inventory or open the inventory 
report configured for you by your Entomo Professional Sales team in 
your favorites pane.  

2. Use the Filters section to specify item numbers, partners, or time 
periods that will retrieve the record you want. (Skip to the next step 
if you are using report with pre-defined filters.) 

3. Click Retrieve.  

For instructions about creating and modifying reports, see Saving and 
Creating Reports. 

Resolve Inventory Records 

In general, your Entomo Professional Services team will configure 
inventory resolution jobs that automatically resolve your data on a 
schedule (for example, once a day, or once a month); however, with the 
proper permissions, you can also run a resolution process manually. Note 
that you can also run a manual resolution job from the Job Templates 
page. 

To manually resolve inventory records: 

1. Go to Site Map > Inventory > Inventory or open the inventory 
resolver report (in your favorites pane) that was configured by your 
Entomo Professional Sales team.  
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2. Use the Filters section to locate the inventory records that you want 
to manually resolve.  

3. Click Retrieve.  

4. In the results, select the checkboxes of the lines you want to resolve 
or select the checkbox for all lines.  

5. Click Resolve to open the Rule Templates dialog. 

6. In the dialog, move the rules that you want to apply during the 
resolution process by double-clicking them (or highlighting them, 
then clicking Add To) to move them to the Selections pane.  

 

7. In the Resolve Options section, ensure that Resolve is selected.  

8. In the Job Options section, set the timing of the resolution by 
selecting one of the following options. These options are the same as 
the options used in the Job Templates page. For more information, 
see Run a Job.  

o Run (Always run job) – The resolution job will start immediately 
after you click OK.  

o Next (Queue job after last currently running instance) – This 
resolution job will run after any currently queued jobs of the same 
job type. 

o Last (Queue job after last currently running job) – This 
resolution job will run after all other currently queued and 
running jobs are complete, including import jobs. 

o Skip (Skip job if already running) – If a currently running job is 
the same job type as the one you are attempting to set up, this new 
job will be canceled. 
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9. When you finish making your selections, click OK to close the Job 

Templates dialog and resolve the transactions. The resolver will run 
on the selected transactions and the job can be viewed via the Job 

History page. For more information, see About Job History. 

If the results show unmatched transactions, see Resolve Unmatched POS 
Transactions. 

Resolve Unmatched Inventory Records 

Unmatched inventory records can occur for a variety of reasons, such as 
receiving additional since the last resolution job, receiving data not 
currently in the master files, or receiving data that is invalid (for example, 
icons instead of numbers). It is advised that you work with your Entomo 
Professional Services team to determine how to best handle these 
transactions. 

The best practice for updating the item and company master data in 
SmartHub is to use periodic, automatic feeds. This allows your company 
to control the data and ensure the accuracy of the data in SmartHub 
without human intervention. However, with the proper permissions, you 
can add and modify data in the SmartHub item master and company 
master.  

To manually resolve unmatched inventory records: 

1. Go to Site Map > Inventory > Inventory or open the inventory 
resolver report (in your favorites pane) that was configured by your 
Entomo Professional Sales team.  

2. In the Filters section, click the magnifying glass icon on the 
Unmapped Trans field. (Skip to the next step if you are using report 
with pre-defined filters.)  

This opens the Select Unmapped Fields dialog.  

NOTE: The use here of the term “unmapped” actually means 
“unmatched.” Don’t get it confused with the term “unmap,” which is 
the reversal of a resolution or analysis action. For more information, 
see About Resolve vs. Analyze. 

3. In the Select Unmapped Fields dialog, double-click the types of 
unmatched transactions you want to retrieve. Double-clicking is the 
same as highlighting an item, then clicking Add To to move it to the 
Selections pane. (Mapping types are configured specifically for your 
company, so your list might be different than shown below.)  
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4. When you are finished selecting unmapped types, click OK to return 
to the POS page.  

5. Review the results to determine how to proceed. You might need to 
switch to a different procedure instead of continuing with this 
procedure. For example, you might need to create a new pattern map 
to convert a reported value into the format used in the master files, 
or you might need to update the master files. A variety of solutions 
are possible. 

6. To continue resolving transactions, in the Filters section, select the 
accounting period or date range that contains the unmatched 
transactions, then click Retrieve.  

7. In the results, select the checkboxes of the unmatched transactions 
that you want to resolve, then click Resolve to open the Rule 
Templates dialog.  
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8. In the Rule Templates dialog, move the rules that you want to apply 
during the resolution process by double-clicking them (or 
highlighting them, then clicking Add To) to move them to the 

Selections pane.  

 

9. In the Resolve Options section, ensure that Resolve is selected.  

10. In the Job Options section, set the timing of the resolution by 
selecting one of the following options. These options are the same as 
the options used in the Job Templates page. For more information, 
see Run a Job.  

o Run (Always run job) – The resolution job will start immediately 
after you click OK.  

o Next (Queue job after last currently running instance) – This 
resolution job will run after any currently queued jobs of the same 
job type. 

o Last (Queue job after last currently running job) – This 
resolution job will run after all other currently queued and 
running jobs are complete, including import jobs. 

o Skip (Skip job if already running) – If a currently running job is 
the same job type as the one you are attempting to set up, this new 
job will be canceled. 

11. When you finish making your selections, click OK to close the Job 

Templates dialog. The resolver will run at the time you selected and 
the job can be viewed via the Job History page. For more 
information, see About Job History. 

Note that the Inventory page will not be automatically updated. To 
check the status of the transactions that you hoped to resolve, reset 
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the filters on the Inventory page to find those specific transactions 
(and clear the Unmapped Trans filter), then click Retrieve again.  

Reverse an Inventory Resolution Job 

Reversing an inventory resolution job is the same as reversing a POS 
resolution. For instructions, see Reverse a Resolution Job, but use the 
Inventory page rather than the POS page. 

Delete Inventory Records 

With the proper permissions, it’s possible to delete inventory records, but 
caution is advised because it’s easy to delete records that you don’t 
recognize, only to realize later that they shouldn’t have been deleted. The 
best practice is to contact your Entomo Professional Services team to 
delete anything so they can properly research the need for deletion.  

Inventory records cannot be deleted if they are in a closed period or if 
they are referenced by other SmartHub modules.  

To delete inventory records: 

1. Go to Site Map > Inventory > Inventory or open the inventory 
report (in your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. Use the Filters section to locate the records that you want to delete.  

3. Records can be deleted only if they are in an open accounting period.  

4. If your company uses split records, be sure to set the Split Records 

filter to No. 

5. Click Retrieve.  

6. In the results, select the checkboxes of the lines you want to remove, 
then click Delete. 

The records are removed.  

About Inventory Analytics 

The Inventory Analytics page allows you to focus on more specific 
dimensions of the data and create informative charts and graphs based on 
those dimensions. The analysis process also associates the costs/prices 
from your price book with each inventory item.  

For a tour of an analytic page, see Analytic Page Navigation. For an 
example, see About Analytic Pages.  

It’s likely that your Entomo Professional Services team created a version 
of the Inventory Analytics page as a report, with filters configured 
specifically for your company, accessible from your favorites pane. For a 
description of the filters in your company-specific reports, consult your 
implementation guide. The following fields are a sample of the more 
frequently used filters. 
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For information about setting up an analytic page, see Configuring an 
Analytic Page. 

Inventory Analytics – Filters 

 From/To – Retrieve inventory records according by accounting 
period. A transaction belongs to an accounting period based on its 
inventory date. 

 Trans. From/To – Retrieve inventory based on a range of dates. 

 Imported From/To – Retrieve inventory data based on the date it was 
imported into SmartHub. 

 Convert To – Select the currency you want to see. 

 Trans. Status – Retrieve transactions based on whether they are open 
or closed. Leave the filter blank to retrieve all transactions regardless 
of status.  

 Unmapped Trans. – Click the magnifying glass icon to select one or 
more rule templates to retrieve unresolved transactions that use those 
rule templates. 

 Mapped Trans. – Click the magnifying glass icon to select one or 
more rule templates to retrieve transactions that were resolved using 
those rule templates. 

 Trans. Number – Retrieve transactions by entering one or more 
transaction numbers, separated by commas. 

 Partner – Retrieve transactions according to partner or distributor 
name. 

 Partner Channel Type – Retrieve transactions based on channel type 
(such as distributor or reseller), or leave the field blank to retrieve all 
channel types. 

 Sponsor Item (Rpt./Res.) – Select an item number from the item 
master or enter an item number to retrieve only the transactions that 
contain the selected item number as either reported or resolved. 

 Show Period Details – Display retrieved data by period, at a 
specified interval (such as weekly, quarterly, etc.). Leave the option 
blank to see a total only. 

 Display – Change the format of the retrieved data between a results 
table only, a chart only, or both.  

 Drill Down Report – Select a report from the dropdown list to 
designate that report as the target report when the View Details 

button is selected. 

Inventory Analytics – Actions 
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 Retrieve – Return records based on the parameters you set in Filters. 

 Reset Sort – Clear the current sort logic and resets it to ascending sort 
order on the first column that is the basis for the aggregation. For 
more information about sorting, see Sorting in Analytic Pages. 

 Analyze – Open the Values to Update dialog, where you can define a 
valuation job. For more information, see About Valuations.  

 Report Job – Open the Create a New Report dialog to save a new 
report. For more information, see Saving and Creating Reports.  

 Job Status – Open the Job History page as a dialog so you can refer to 
the list of jobs while staying in the Inventory Analytics page. 

 View Details – For selected rows (or retrieved rows, if no rows are 
selected), show the underlying transactions that use the report 
designated in the Drill Down Report field in the Filters section. 

 Export – Export the data in the active results table.  

 Draw – Update all displayed charts without having to retrieve data 
again. 

 Save Report – Open the Create a New Report dialog, where you can 
save your filter settings and page configuration to your favorites pane 
and/or associate a favorite group to the report. For more information, 
see Saving and Creating Reports. 

About the Inventory Reconciler Page 

The Inventory Reconciler page (and any report based on that page) 
allows you to view and analyze (or reconcile) all of your most recently 
resolved POS, inventory, sponsor sales, and RMA data in one place. The 
results table will show one record for each partner-item combination for 
every item carried by any distributors for the period you select in the 
Filters section. For the reconciler to be up-to-date, you must first resolve 
and analyze your POS and inventory data. For more information, see 
Resolve POS Transactions and Resolve Inventory Records. For 
instructions about how to run a reconciliation, see Reconcile the 
Inventory. 

After you run the reconciler (via the Analysis button or scheduled job), 
you can use the Inventory Reconciler Summary page (and any report 
based on that page) to find discrepancies (or variances) between physical 
inventory and reported inventory. For more information, see About the 
Inventory Reconciliation Summary. 

It’s likely that your Entomo Professional Services team created a version 
of the Inventory Reconciliation page as a report, with filters configured 
specifically for your company, accessible from your favorites pane. For a 
description of the filters in your company-specific reports, consult your 
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implementation guide. The following fields are a sample of the more 
frequently used filters. 

Inv. Reconciler – Filters 

 From/To – Retrieve inventory records according to accounting period.  

 Audit – Click the magnifying glass icon to open a dialog where you 
can select one or more audit types (such as Adjusted, No Adjusted 

Variance, or Unreconciled) to retrieve inventory records according to 
status. 

 Partner – Retrieve inventory records for one or more partners 
according to name.  

 Partner ID – Retrieve inventory records for one or more partners 
according to ID number. 

 Partner Type – Retrieve inventory records according to type, such as 
Sell-In or All Indirect. 

 Item ID – Retrieve inventory records according to item number. 

 Item Type – Retrieve inventory records for one or more items by 
type. 

 Display – Select an option to display results as a table, a chart, or 
both. 

 POS Report – Select the POS report that has the format you’d like to 
see when you click the View POS button. The dropdown will list all 
of the reports configured from the default POS page. 

 Inventory Report – Select the inventory report that has the format 
you’d like to see when you click the View Inventory button. The 
dropdown will list all of the reports configured from the default 
Inventory page. 

 Log Report – Select the FIFO log report that has the format you’d like 
to see when you click the View FIFO button. The dropdown will list 
all of the reports configured from the default FIFO Log page. 

 Sponsor Sale Report – Select the sponsor sales report that has the 
format you’d like to see when you click the View Sponsor Sale 

button. The dropdown will list all of the reports configured from the 
default Sponsor Sales page. 

Inv. Reconciler – Actions 

 Retrieve – Return records based on the parameters you set in Filters. 

 Save – Save your changes without leaving the page.   

 Delete – Delete all lines with selected checkboxes.  

 Mark – Flag selected lines as having been reviewed: 
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o Records marked as Reconciled are locked for users and the 
system, and no further changes can occur in this state.  

o Records marked as Reviewed have been reviewed, and variances 
are acceptable. The Reviewed flag is cleared if the calculated 
ending inventory or calculated reported ending inventory change. 

 Set Adjusted – Open the Set Adjusted Ending Inventory dialog, 
where you can configure the effects of changing set adjusted ending 
inventory to calculated reported ending inventory. For more 
information, see Adjust Ending Inventory.  

 Transfer – Select the records from which you want to remove 
inventory, then click Transfer to open the Inv. Recon. Transfer 

(Sources) dialog, where you can select the records that you want to 
receive the transferred inventory. For more information, see About 
Transfers. 

 Select Open Rows – Select the checkboxes of all lines that are in the 
open accounting period.  

 Analyze – Open the Values to Update dialog, where you can define a 
valuation job. For more information, see About Valuations.  

 Job Status – Open the Job History page as a dialog so you can refer to 
the list of jobs while staying in the page. 

 View Sponsor Sale – Open the report you set in the Sponsor Sale 
Reports filter (or the Inv. Reconciler > Sponsor Sale page if that filter 
is blank), to see all the sponsor sales used for the reconciliation. To 
view the details of a specific line, first select the checkbox for that line. 
If the line you select has no sponsor sales, the report or Inv. 

Reconciler > Sponsor Sale page will list nothing.   

 View POS – Open the report you set in the POS Reports filter (or the 
Inv. Reconciler > POS page if that filter is blank), where you can see 
the sales transactions used for the reconciliation. To view the details 
of a specific line, first select the checkbox for that line. If the line you 
select has no POS, the Inv. Reconciler > POS page will list nothing.   

 View Inventory – Open the report you set in the Inventory Reports 
filter (or the Inv. Reconciler > Inventory page if that filter is blank), 
where you can see the inventory records used for the reconciliation. 
To view the details of a specific line, first select the checkbox for that 
line.  

 View FIFO – Open the report you set in the FIFO Reports filter (or 
the Inv. Reconciler > FIFO Log page if that filter is blank) so you can 
see how inventory was calculated for the reconciliation. For more 
information, see Find Invoices Used in a Reconciliation.  

 Export – Export the data in the active results table.  
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 Draw – Update all displayed charts without having to retrieve data 
again. 

 Save Report – Open the Create a New Report dialog, where you can 
save your filter settings and page configuration to your favorites pane 
and/or associate a favorite group to the report. For more information, 
see Saving and Creating Reports. 

Reconcile the Inventory 

It’s important to reconcile the discrepancies between your calculated 
inventory and your reported inventory for a variety of reasons. It’s the 
best way to track down discrepancies in POS reporting (due to loss and 
damage, RMAs, inaccurate reporting, or from the fact that inventory 
might be in transit between you and your distributors/partners). 
Inventory is required if your company is doing FIFO or sell-through 
recognition so inventory numbers are accurate when posting G/L entries. 
Inventory reconciliation is required if you use SmartHub to calculate 
inventory-based incentive programs so inventory can be priced on 
specific dates.  

The inventory reconciler calculates ending inventory as follows: 

 Beg. Inv. The ending inventory from the previous period 

+ Sponsor Sales Your company’s direct sales 

– Sponsor Returns Your company’s returns 

– POS Sales by your partners for the current period 

+ POS Returns Returns to your partners 

= Calc. End. Inv. The calculated ending inventory for the current period 

It’s best to reconcile inventory using the automated job that your Entomo 
Professional Services configures specifically for your company, but these 
step-by-step instructions can help you understand the process.  

To reconcile inventory: 

1. Go to Site Map > Inventory > Inv. Reconciler or open the reconciler 
report (in your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. Use the Filters section to retrieve all the records in the open period. 

3. Click Retrieve.  

4. Click Analyze.  

The results of the reconciliation will be available in the Inv. Recon. 

Summary (or the report configured for you based on that page), where 
you can set variance thresholds, drill down into invoice details, and make 
adjustments to the ending inventory. For instructions, see Adjust Ending 
Inventory. 
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Adjust Ending Inventory 

After POS and inventory records are resolved, analyzed, and reconciled, 
use the Inventory Reconciliation Summary to review for inventory 
discrepancies and the Inventory Reconciler page to adjust inventory. 
Ending inventory can be adjusted one record at a time or in bulk.  

To adjust variances in ending inventory: 

1. Go to Site Map > Inventory > Inv. Reconciler or open the reconciler 
report (in your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. Use the Filters section to find the records that you want to adjust, 
then click Retrieve.  

3. In the results, select the checkbox of the items that you want to 
adjust, then do one of the following: 

o Adjust Individual Records – For the selected records, edit the 
Adj. End. Inv. column, enter a comment in the Comments 
column, then click Save.   

o Adjust Multiple Records – After selecting the records that you 
want to change, click Set Adjusted to open the Set Adjusted 

Ending Inventory dialog. 

a) In the Set Adj. End Inv. to field, select an option based on the 
values you want to use instead of the adjusted ending 
inventory.   

b) In the When No Last Rept. Inv. field, select an option based 
on how you want the system to handle the adjustment for 
records with no last reported inventory value. 

c) In the Overwrite Existing Adjustment field, select Yes if you 
want your adjustment to overwrite all other adjustments.  

d) In the Comment field, select an option about the formatting of 
the comments that you enter in the unnamed field under the 
Comments field:  

- Append – Add your comment to any existing comments.  

- No Change – Select this option if you have no comments.  

- Overwrite – Your new comments will replace any existing 
comments. (Click Reset Comment to return to the most 
recently saved comment.) 
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e) In the Update Records As section, select an option based on 
how you want to mark the adjusted records.  

f) When you are finished, click OK to update the status of the 
selected records. 

About the Inventory Reconciliation Summary 

The Inventory Reconciliation Summary page (and any report based on 
that page) allows you to review your inventory by monitoring variances 
(discrepancies) between physical and reported inventory, monitoring 
exceptions, and performing trend analysis.  

It’s likely that your Entomo Professional Services team created a version 
of the Inv. Recon. Summary page as a report, with filters configured 
specifically for your company, accessible from your favorites pane. For a 
description of the filters in your company-specific reports, consult your 
implementation guide. 

Inv. Recon. Summary – Filters 

 From/To – Retrieve inventory records according to accounting period.  

 Limit Results – Control the number of records that are displayed after 
a data retrieval. For more information, see Sorting in Analytic Pages.  

 Partner – Retrieve inventory records for one or more partners 
according to name.  

 Partner ID – Retrieve inventory records for one or more partners 
according to ID number. 

 Partner Type – Retrieve inventory records according to type, such as 
Sell-In or All Indirect. 

 Item Type – Retrieve inventory records for one or more partners by 
name. 

 Qty. Variance – Set a threshold for tolerating discrepancies in 
quantity. For more information, see About Inventory Variances. 

 Convert To – Select the currency you want to see. 

 Val. Variance – Set a threshold for tolerating discrepancies in 
inventory values (dollar amounts). For more information, see About 
Inventory Variances. 

 Show Period Details – Display the results by period.  

 Show Period Totals – Display the results by total across all selected 
periods. 

 Is Last Rptd Inv Stale – Retrieve records based on whether they are 
flagged as stale, meaning that they have been adjusted, but an 
analysis job has not yet been run. 
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Inv. Recon. Summary – Actions 

 Retrieve – Return records based on the parameters you set in Filters. 

 Reset Sort – Clear the current sort logic and resets it to ascending sort 
order on the first column that is the basis for the aggregation. For 
more information about sorting, see Sorting in Analytic Pages. 

 Analyze – Open the Values to Update dialog, where you can define a 
valuation job. For more information, see About Valuation.  

 Job Status – Open the Job History page as a dialog so you can refer to 
the list of jobs while staying in the Inv. Recon. Summary page. 

 View Details – For selected rows (or retrieved rows, if no rows are 
selected), show the underlying transactions that use the report 
designated in the Drill Down Report field in the Filters section. 

 Export – Export the data in the active results table.  

 Draw – Update all displayed charts without having to retrieve data 
again. 

 Save Report – Open the Create a New Report dialog, where you can 
save your filter settings and page configuration to your favorites pane 
and/or associate a favorite group to the report. For more information, 
see Saving and Creating Reports. 

About Inventory Variances 

You can use the Inv. Recon. Summary page (and any reports based on it) 
to perform  threshold analysis and review valuation details for a period 
based on sponsor sales, returns, POS sales, and reported ending 
inventory. The page has two valuable filters for exception and variance 
analysis: 

 

Use one or both of these filters to establish a tolerance level for inventory 
reconciliation. If a part falls out of the tolerance based the setting in these 
filters, the out-of-tolerance parts will be identified as being above or 
below the set tolerance. In the following example, the distributor has 7 
parts above the threshold and 1,045 parts within.  

For instructions about adjusting variances, see Using the Reconciliation 
Summary. 

Company ABC 

Company ABC 
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Using the Reconciliation Summary 

After POS and inventory records are resolved, analyzed, and reconciled, 
use the Inventory Reconciliation Summary to adjust inventory 
discrepancies, monitor inventory exceptions, and perform trend analysis. 
For more information about setting up analytic pages, see Configuring an 
Analytic Page. 

To adjust variances in ending inventory: 

1. Go to Site Map > Inventory > Inv. Recon. Summary or open the 
reconciler summary report (in your favorites pane) that was 
configured by your Entomo Professional Sales team.  

2. In the Filters section, select the report that you want to use from the 
Drill Down Report field, then click Retrieve. (If your report is set to 
automatically retrieve when opened, you can skip this step.) 

3. In the results, select the checkbox of the record you want to review, 
then click View Details to open the Inv. Reconciler page (or the 
inventory reconciliation report that is selected in the Drill Down 

Report filter), where you can make adjustments as needed. Review 
the records to see whether inventory has been applied to the correct 
end customer and whether the quantities are correct. 

TIP: You can sort on the Variance or Adj. End. Inv. columns by 
holding the shift key and clicking on the column. This sorts 
quantities by absolute value, which might make it easier to see 
misplaced quantities as positive and negative values side by side. 

4. (Optional) Select the checkboxes of items you want to review, then 
click the View POS, View Sponsor Sale, View Inventory, and View 

FIFO buttons to see the details of the reconciliation. For more 
information about the FIFO page, see About the FIFO Logs (IRM) 
Page. 

About the FIFO Logs (IRM) Page 

The FIFO Logs page lists the invoices that were used for a specific 
reconciliation process. 

FIFO Logs (IRM) – Filters 

 From/To – Retrieve records according to accounting period.  

 Trans. From/To – Retrieve records based on a date range.  

 Qty ID – Retrieve records according to invoice type, such as Avg. 
Weekly Sales, Adj. Net Partner Sales, etc.  

 IRM Transfer # – Retrieve records using a transfer ID number.   

 Trans# – Retrieve records according to invoice number. 

FIFO Logs (IRM) – Action Bar 
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 Retrieve – Returns records based on the parameters you set in Filters. 

 Delete – Deletes all lines with selected checkboxes.  

 Export – Exports the data in the active results table.  

 Save Report – Opens the Create a New Report dialog, where you can 
save your filter settings and page configuration to your favorites pane 
and/or associate a favorite group to the report. For more information, 
see Saving and Creating Reports. 

Find Invoices Used in a Reconciliation 

Use the FIFO Logs page to see the invoices used in the most recent 
reconciliation.  

To see the invoices used in a reconciliation: 

1. Go to Site Map > Inventory > Inventory Reconciler. 

2. Use the Filters section find the records that you want to adjust, then 
click Retrieve.  

3. In the results, select the checkbox of the item for which you want to 
see invoices, the click View FIFO.  

4. In the FIFO Logs page, you can see all the invoices used in the 
reconciliation of the item you selected. 

Typically, the FIFO Logs page is used to adjust ending inventory. For 
instructions, see Adjust Ending Inventory. 

About Transfers 

For some companies, it’s possible (although infrequent) for 
distributors/partners to sell (or transfer) inventory to another distributor. 
In this case, a transfer must be done to adjust the ending inventory in the 
inventory reconciliation records, reducing the inventory associated with 
one record (a negative sale, or return, for the transferor) and adding it to 
the other record (a positive sale for the purchasing partner). The transfer 
date must be used as the transaction date for both the sale and return.  

Transfers can be done automatically or manually. When the following 
criteria are met, the system is able to complete a transfer automatically: 

 The total adjusted ending inventory variance for the product is zero. 

 The net adjusted ending inventory for the product is not zero. 

 One or more products have a negative adjusted ending inventory. 

 The records involved in the transfer are open and in an open 
accounting period. 

In order to perform a transfer, the records must first be resolved, valued, 
and reconciled.  
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If your company uses transfers, your Entomo Professional Services team 
will configure a filter field called something like “Auto-Transferable?” to 
flag records that satisfy the above conditions. 

For instructions, see: 

 Transferring Inventory Automatically 

 Transferring Inventory Manually 

 Transferring by Import 

Transferring Inventory Automatically 

Before transferring inventory, be sure that POS transactions and 
inventory have been resolved, valued, and reconciled. The records 
involved in a transfer must be open and in an open accounting period. 
For additional criteria, see About Transfers. 

To transfer inventory automatically: 

1. Go to Site Map > Inventory > Inv. Reconciler or open the reconciler 
report (in your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. Use the Filters section find the accounting period that contains the 
records you want to transfer.  

3. Set the Audit filter to Auto Transferable.  

4. Click Retrieve.  

A column called “Auto-Transferable” can be configured to help you 
locate fields that can be transferred automatically. If the column isn’t 

visible on your page, click the Configure Columns icon  and move 
Auto-Transferable to the Selections pane, then click OK to return to 
the Inv. Reconciler page. 

5. In the results, select the checkboxes of the lines that you want to 
adjust.  

6. Click Transfer.   

The adjustment will be made automatically, if possible. If not, the Inv. 

Recon. Transfer (Sources) dialog opens so you can make a manual 
adjustment. Skip to Transfer Inventory Manually.  

7. In the Transfer Type dialog, select one of the following options:  

o Automatic (Stop on Error) means that if an issue is encountered, 
the automatic transfer process will not complete.  
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o Automatic (Ignore on Error) means that if an issue is 
encountered, the transfer process will skip the issue and finish 
what it can. You will then be given the option to view errors when 
the analysis is complete.  

 

8. Click OK.  

The system automatically determines the sources, targets, and 
quantities involved, and the transfer is completed. 

Transferring Inventory Manually 

For instances where automatic transfers cannot be completed, a manual 
transfer can be done. Manual transfers allow you to transfer to IRM 
records with non-negative adjusted ending inventory, which is not 
possible with the automatic transfers.  

As with automatic transfers, before transferring inventory be sure that 
POS transactions and inventory have been resolved, valued, and 
reconciled. The records involved in a transfer must be open and in an 
open accounting period. For additional criteria, see About Transfers. 

To transfer inventory manually: 

1. Go to Site Map > Inventory > Inv. Reconciler or open the reconciler 
report (in your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. Use the Filters section find the accounting period that contains the 
records you want to transfer.  

3. Click Retrieve.  

4. In the results, select the checkboxes of the lines that you want to 
adjust, then click Transfer. 

5. If the Transfer Type dialog opens, select Manual, then press OK; 
otherwise, click OK in the confirmation dialog.  
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The Inv. Recon. Transfer (Sources) dialog opens, displaying the 
records that can be used as the source of the transfer. 

6. Select the checkbox of the record you want to use as the source. 

7. In the Transfer Qty field, enter the number of items you need to 
transfer. 

8. (Optional) In the Comments field, enter an explanation for the 
transfer.  

9. When you are finished, click Next.  

10. In the Inv. Recon. Transfer (Target) dialog, select the checkbox of one 
or more records that will receive the transferred inventory, then click 
Next to return to the Inv. Recon. Transfer (Sources) dialog.  

11. The Inv. Recon. Transfer (Sources) dialog now lists all of the 
applicable invoices with the quantities that are available for transfer. 
Select enough invoices to match the quantities that need to be 
transferred.  

12. When you are finished, click Finish.  

All valid transfers will be completed. 

Transferring by Import 

Some transfers can only be completed via file import. With this method, 
you must manually update the reversal and correction sponsor sale 
entries in a DDF file, update any required part and customer information, 
then re-import the file into SmartHub.  

To transfer inventory by importing an updated file: 

1. Go to Site Map > Inventory > Inv. Reconciler or open the reconciler 
report (in your favorites pane) that was configured by your Entomo 
Professional Sales team.  

2. In the Filters section, select the transfer report that you want to use 
from the Log Report field, then click Retrieve.  

 

3. Click View FIFO.  
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4. In the SponsorSale Transfer Form page, narrow the results using the 

Qty ID field. Enter “adj. ending inventory” (or asterisks work too, as 
in “adj*end*inv*”), then press Enter.  

Now only the invoices used for the adjusted ending inventory are 
displayed.   

5. Select the checkboxes of the invoices that you want to update, then 
click Export. 

6. In the Export dialog, select the CSV option, select where you want to 
send the file, name the file, then click OK. 

7. In the .cvs export file, create the transfer with reversals and correction 
entries:  

o Reversal entries must have negative quantities.  

o The exported source invoices must be copied to the transfer file 
twice, first as reversal entries with quantities and extended price 
negated, then as correction entries with distributor ID, end 
customer, and positive quantities updated, leaving the part 
number from the source invoices intact. 

8. To re-import the transfer (.cvs) file, go to Site Map > Administration 

> Import to open the Import Wizard.  

9. Click Browse and navigate to the appropriate file, then click Upload. 
 

10.  Select Background Import Job, then Done to finish the import. 

To help you confirm that a transfer is complete, your Entomo 
Professional Services team can configure a column (named something 
like Stale?) in your inventory reconciliation report that gets set to Yes 

when an adjustment is made. After the appropriate analysis jobs have 
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been run, the flag in the Stale? column will return to No. Transfers 
cannot be performed on records marked as stale because information 
from the analyses is required for transfers.  

11. To complete the transfer, run the master reconciliation job configured 
for your company by your Entomo Professional Services team. 
Typically, the master job would include the following jobs/processes: 

o A resolution of POS and inventory for the records involved in the 
transfer 

o An RMA valuation 

o An inventory reconciliation 

12. When the master job is complete, open your inventory reconciliation 
report to review the transferred transactions. When a record is 
reviewed and/or reconciled, select the record and click Mark to open 
the Update Records As dialog.  

13. Mark the selected records:  

o Select Reconciled to lock the record for users and the system.  

o Select Reviewed to indicate that the records has been reviewed 
and that remaining variances are acceptable. The Reviewed flag is 
cleared if the calculated ending inventory or calculated reported 
ending inventory change. 

14. Click OK. 

About Exception Reports 

Exception reports help you review unmatched or unresolved data in the 
system. Your Entomo Professional Services team will usually set up 
exception reports for you. The following reports are examples: 

 POS Unmatched Items – Lists POS transactions with unresolved 
parts reported. 

 POS Unmatched Sold-To – Lists POS transactions that have 
unknown sold-to customers reported. 

 POS Unmatched Ship-To – Lists POS transactions that have 
unknown ship-to customers reported. 

 POS Unmatched UC – Lists POS transactions that have unknown end 
customers (or ultimate customers). 

 POS Unmatched Ship-To Country – Lists POS transactions that have 
no resolved ship-to country. 
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For information about how to use the reports configured for your 
company, consult your Entomo Professional Services team. 

About Return Merchandise Authorizations (RMAs) 

RMAs that are in transit (because they did not sell out or because a POS 
return exists for the items) are included in the calculated ending 
inventory and should be part of the inventory reserves. RMAs that are 
not in transit are not included in inventory reserves and should be 
calculated to be part of RMA reserves for journal entries.  
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Appendix A – Parameter Definitions 

The parameters on the Job Template > New page change based on your 
selection in the Type field. The following table defines the use of each 
parameter. For a definition of each job type, see Job Template - Filters. 

CIM Analysis | Reserves Analysis 

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or on a master worker 
job template. 

If this field is blank, the filters in 
the report will determine the 
accounting periods for the job. 

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

The partner IDs here will be 
overwritten if you specify 
different partners when you run 
the job or in a master worker job 
template.  

If this field is blank, the filters in 
the saved report determine the 
partners for the job. 

Report Name Select a report to invoke it when the job is 
run.  

The list might be limited based 
on your selection in the Type 
field.  

Claim Resolution | Inventory Resolution | POS Resolution 

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

If this field is blank, the filters in 
the report will determine the 
accounting periods for the job. 

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

Partner IDs in this field will be 
overwritten if you specify 
different partners when you run 
the job or in a master template 
that runs this job.  

If this field is blank, the filters in 
the report determine the partners 
for the job. 

Report Name Select a report to run.  The list might be limited based on 
your selection in the Type field.  
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Field Name Action Comment 

Model Type Select the data that will be affected by 
this job, for example: 

 ClaimCIMLine 

 Inventory 

 OpportunityElement 

 POS 

Your selection in this field 
determines the rules that are 
available in the Rule Templates 
field.  

Operation Select the process you want to use for 
this job: 

 Map – Resolves the data 

 Unmap – Reverses the previous 
resolution 

 Audit – Shows the results of a 
resolution operation without affecting 
the data 

Records will be mapped or 
unmapped according to the rules 
selected in the Rule Templates 
field.  

Rule Templates 
Click the magnifying glass icon to 
open a dialog that allows you to select 
rules for the job. Move the rules you 
want from the Choice List to the 
Selections pane, then click OK.  

The rules available are based on 
your selection in the Model Type 
field. 

Export 

Field Name Action Comment 

Report Name Select a report to run.  

Format  Select a format for the data export.  For a definition of the file 
formats, see Exporting Reports. 

Quote Character Select the character that you want to 
surround a data item if the item contains 
the delimiter character that you set in the 
Delimiter field. For example, if you select 
commas as your delimiter, any time a 
comma is used in the imported data, the 
comma will be surrounded by the 
character you enter in this field.   

 

Delimiter Select the character that you want to use 
to separate each data item in the export. 

 

Target Select a destination for the exported data: 

Save Report, Email, FTP, Salesforce 

 

File Name Enter a name for the export file.  

Date Position Select Prefix to add the date to the 
beginning of the file name.  

Select Suffix to append the date to the 
end of the file name.  

 

Date Format Enter the following terms (without 
quotes) in the order that you want for the 
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Field Name Action Comment 

date in the file name, for example 
“yyyyMMdd”: 

 “yyyy” for the year 

 “MM” for the month 

 “dd” for the day 

 “HH” for the hour (optional) 

 “mm” for the minute (optional) 

 “ss” for the second (optional) 

To, Cc, and Bcc Click the file icon to open a dialog where 
you can select the recipients of the export 
file. When you are finished, click OK.  

You can narrow the list in the 
dialog with the Company and 
Security Group filters.  

Email Subject Click the pencil icon to enter a freeform 
title for the email. When you are finished, 
click OK. 

 

Email Message Click the pencil icon to enter a freeform 
email message. When you are finished, 
click OK. 

 

Export Chart Select Yes to include a chart of the data 
with the export file.  

 

Bypass if No Record Found Select Yes to avoid sending an email if the 
export job results in an empty file. 

 

Export Script If applicable, select an export script that 
will be executed just prior to the export.  

If your Entomo Professional 
Services team has written scripts 
for you, they will appear in this 
field. For example, you might 
have a script that truncates 
address fields to 50 characters, 
leaving them at full value in the 
database.  

Forecast 

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

If this field is blank, the filters in 
the report determine the 
accounting periods for the job.  

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

Partner IDs in this field will be 
overwritten if you specify 
different partners when you run 
the job or in a master template 
that runs this job.  
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Field Name Action Comment 

If this field is blank, the filters in 
the report determine the 
partners for the job. 

Report Name Select a report to run.  The list might be limited based 
on your selection in the Type 
field.  

Model Type Select the data that will be affected by this 
job, for example: 

 Sponsor Sales 

 POS 

 

Hide Previous Forecast Select this option to set all forecast 
transactions to a hidden status, except for 
the most recently received. 

Hiding outdated forecast 
transactions prevents them from 
being used unnecessarily in the 
analysis.  

Remove From Inv. Recon. Select this option to remove forecast data 
from IRM records in the selected period.  

 

Move to Next Open Period Select this option to retrieve applicable 
transactions and set their accounting date 
to the begin date of the first open 
accounting period.  

 

G/L Analysis 

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

Integration Analysis 

Field Name Action Comment 

Report  Select a report to run.   

Emails Select the type of alerts you’d like to send 
when the analysis is complete: 

 Late Import Alert – Send an alert if an 
expected file is received after the 
specified cutoff. 

 Missing Import Alert – Send an alert if 
an expected file is not received. 

 Submit Import Reminder – Send a 
reminder to distributors/partners to 
submit their files. 

 Timely Error import Alert – Send an 
alert if files are submitted on time, but 
imported with errors or warnings.  
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Inventory Reconciliation 

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

If this field is blank, the filters in 
the report will determine the 
accounting periods for the job. 

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

The partner ID will be 
overwritten if you specify 
different partners when you run 
the job or in a master worker job 
template.  

If this field is blank, the filters in 
the report determine the 
partners for the job. 

Report Name Select a report to run.   

POS Evaluation Type Select an option to specify the source of 
the values that will used for the POS 
reconciliation: 

 None 

 Price Book 

 Price Book (Closest Date) 

 Sponsor Sale FIFO 

 

INV Evaluation Type Select an option to specify the source of 
the values that will be used for the 
inventory reconciliation: 

 None 

 Price Book 

 Price Book (Closest Date) 

 Sponsor Sale FIFO 

 

Delete Existing Records Select an option to determine the 
behavior of the job toward existing IRM 
records before it runs the analysis: 

 None – Existing IRM records are 
unchanged when the analysis is run. 

 Delete All Records – Existing IRM 
records in the selected begin/end 
periods are removed.  

 Delete Open Records – Removes 
existing IRM analysis for all open periods 
in the selected period range. 

 Delete Unadjusted Open Records – 
Removes existing IRM analysis for open 
periods in the selected period range 
that have not been adjusted. This option 
preserves changes made by users so you 

Caution: The None option can 
leave records from a previous 
analysis that are no longer 
relevant and that are not be 
created by a fresh analysis.  

For example, if a POS record has 
the wrong item and is corrected, 
the IRM might have a record for 
that item that is incorrect and 
should not exist.  
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Field Name Action Comment 

don’t have to keep making adjustments 
over and over.  

Set Adj. End. Inv. To Select a value for the adjusted ending 
inventory field: 

 Calc. End. Inv. 

 Last Rptd. Inv. 

 Calc. Rptd. End. Inv. 

 Zero 

 

Create FIFO Logs Select this option to generate records with 
details about the analysis.  

 

Master Worker Jobs 

A master job is a template that can be set up to run multiple other 
“worker” jobs, either sequentially or at the same time. Setting up a master 
job allows you to easily schedule a lot of jobs with a single event 
template. For more information, see Event Template.  

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

If this field is blank, the filters in 
the report will determine the 
accounting periods for the job. 

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

The values specified here apply to 
all worker jobs. The exception is 
for G/L Analysis jobs, which will 
include all partners/distributors, 
not just the ones you select here.  

If this field is blank, the 
parameters in the worker jobs or 
the filters in their reports will 
determine the partners for the 
job.  

Type Select whether you want the jobs in this 
template to run one after the other 
(Sequential) or at the same time 
(Concurrent). 

 

Create Audit Logs Select Yes to create audit logs for the 
associated worker jobs, if applicable.   

If this field is blank, the 
parameters in the worker jobs will 
determine whether audit logs are 
created. 

WorkerJob 1-20 Select the jobs that you want to run 
through this master job.  

If you select Sequential in the 
Type field, the order of the jobs is 
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Field Name Action Comment 

determined by the order of these 
fields.  

Sales Credit Assignment 

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

If this field is blank, the filters in 
the report will determine the 
accounting periods for the job. 

Report Name Select a report to run.   

Operation Select Assign to process sales 
credits/commissions to the 
distributor/partner that earned them.  

Select Unassign to reverse the most 
recent sales credit assignments.  

 

Script 

Sometimes, scripts (special code) might be necessary to run a customized 
process that is outside of SmartHub’s usual processes. This template 
allows you to set up and run those scripts. Scripts are usually run only by 
your Entomo Professional Services team.  

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

The partner ID will be 
overwritten if you specify 
different partners when you run 
the job or in a master worker job 
template.  

If this field is blank, the filters in 
the report determine the 
partners for the job. 

Script Select the script you want from the list, if 
applicable.  

If your Entomo Professional 
Services team has written scripts 
for you, they will appear in this 
field.  

Create Audit Logs Select this option to auto-generate audit 
logs when this job is run.  
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Shipment 

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

The partner ID will be 
overwritten if you specify 
different partners when you run 
the job or in a master worker job 
template.  

 

Operation Select Map shipment receipts to sponsor 
sales to match shipment receipt records 
to sponsor sale records. 

Select Unmap shipment receipts from 
sponsor sales to clear the association 
between the shipment receipt records and 
sponsor sale records.  

 

Report Name Select a report to run, if applicable.   

Unhide 

Field Name Action Comment 

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

The partner ID will be 
overwritten if you specify 
different partners when you run 
the job or in a master worker job 
template.  

 

Model Type Select the data that will be affected by this 
job, for example: 

 Inventory 

 POS  

 Sponsor Sale 

 

Valuation 

Field Name Action Comment 

Begin Period/ End Period Specify the accounting periods you want 
for the job. 

This accounting period will be 
overwritten if you specify 
different periods when you run 
the job or in a master worker job 
template. 

Partner Company ID/Name Add one or more partner/distributors to 
the job by entering their name or ID, or 
select a name from a list using the 

magnifying glass icon .  

The partner ID will be 
overwritten if you specify 
different partners when you run 
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Field Name Action Comment 

the job or in a master worker job 
template.  

If this field is blank, the filters in 
the report determine the 
partners for the job. 

Model Select the data that will be affected by this 
job, for example: 

 Inventory 

 POS  

 RMA 

 

Report  Select a report to run, if applicable.   

Values Select Cost to use cost values for the 
valuation.  

Select Price to use price values for the 
valuation.  

 

Value Source Select the reference that you want to use 
as the source of the values for this job.  
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